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About this guide

Overview of this guide

The User Guide introduces the study design environment in the Central Designer application and
describes how to work as a study design team in that environment, including how to:

e Work collaboratively.
e Maximize study design efficiency by reusing study objects.

e Manage collections of study objects.

Prerequisites

Users

viii

You should have experience in one or more of the following clinical areas:

e Data management

e Data analysis

e Study design

e Library management
e  Project management

Additionally, rule developers must have the following levels of programming expertise, depending on
the types of rules they will be creating.

Type of rule Required programming expertise

Simple edit checks using rule None.

templates.

Comparisons, calculations. e Understanding of C# or similar (for example, Java, C, or

C++) expression syntax.

e Ability to incorporate functions in expressions.

User-defined functions. e Ability to program in a NET language (for example, C#)
and create NET assemblies.

This guide is for users of the Central Designer application, including:

User Description
Clinical data manager A user who is involved in the study design process.
Library administrator A user with library administration privileges for one or more

clinical areas.

Central Designer administrator  An IT representative who supports and maintains the application
from a technology and infrastructure perspective.
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User Description

Study design team Users who implement a study. This team includes several roles
such as form designer, rule designer, and study workflow
designer.

Medical project manager A user who works with the CRF designer to create an annotated

study protocol, usually based on existing CRFs for the therapeutic
area. This user is concerned with the overall set of study
questions and logic, not the individual details of form design.

Statistician A user who interacts with study designers with respect to data
collection needs for analysis.

Translator A user who is responsible for translating text in clinical studies,
forms, items, and rule queries to a specified language.

Oracle® Health Sciences Central Designer 2.1.2 ix
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Documentation

The product documentation is available from the following locations:

e My Oracle Support (https://suppott.oracle.com)—Release Notes and Known Issues.

e Oracle Technology Network (http://www.oracle.com/technetwork/documentation/hsgbu-
154445 html)—The most current documentation set, excluding the Release Notes and Known Issues.

If the software is available for download, the complete documentation set is available from the
Oracle Softwate Delivery Cloud (https://edelivery.oracle.com).

All documents may not be updated for every Central Designer release. Therefore, the version
numbers for the documents in a release may differ.

Item Description

Release Notes The Release Notes document provides detailed information about the requirements,
enhancements, and fixed issues in the current release.

Known Issues The Known Issues document provides detailed information about the known issues
in this release, along with workarounds, if available.

Installation Guide 'The Installation Guide provides system requirements and instructions for installing
and upgrading the Oracle® Health Sciences Central Designer software and the
Oracle® Health Sciences Central Designer Administrator software.

Administrator The Administrator Guide describes how to use the Oracle® Health Sciences Central
Guide Designer Administrator software to set up users, permissions, system
configuration parameters, and catalog defaults.

User Guide The User Guide introduces the study design environment in the Oracle® Health
Sciences Central Designer application and describes how to work as a study
design team in that environment, including how to:

e  Work collaboratively.
e Maximize study design efficiency by reusing study objects.

e  Manage collections of study objects.

InForm Design - The InForm Design Guide describes how to design a study for deployment to the
Guide InForm application.

Rules Reference  The Rules Reference Guide is a reference to the tools that are available for creating
Guide rule expressions, including:

e Study object properties.
e Functions.

e Constants.

e Data mappings.

e  Methods, operators, and literals.
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Item Description

Secure The Secure Configuration Guide provides an overview of the security features
Confignration provided with the Oracle® Health Sciences Central Designer application, including
Guide details about the general principles of application security, and how to install,

configure, and use the Central Designer application securely.

Third Party The Third Party Licenses and Notices document includes licenses and notices for
Licenses and third party technology that may be included with the Central Designer software.
Notices

Secure The Secure Development Guide provides an overview of common security risks for
Development developers using Application Programming Interfaces (APIs) with the Oracle®
Guide Health Sciences Central Designer application, and information on how to address

those risks.

Documentation accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program
website at http://www.oracle.com/pls/topic/lookuprctx=acc&id=docacc.

Oracle® Health Sciences Central Designer 2.1.2 xi
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If you need assistance

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle
Support. For information, visit http:/ /www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Finding Central Designher information and patches on My Oracle Support

The latest information about the Central Designer application is on the Oracle Support self-service
website, My Oracle Support. Before you install and use the Central Designer application, check My
Oracle Support for the latest information, including Release Notes and Known Issues, alerts, white
papers, bulletins, and patches.

Creating a My Oracle Support account

You must register at My Oracle Support to obtain a user name and password before you can enter
the site.

1 Open a browser to https://support.oracle.com.
2 Click the Register link.

3 Follow the instructions on the registration page.

Finding information and articles

1 Sign in to My Oracle Support at https://suppotrt.oracle.com.

2 If you know the ID number of the article you need, enter the number in the text box at the top
right of any page, and then click the magnifying glass icon or press Enter.

3 To search the knowledge base, click the Knowledge tab, and then use the options on the page to
search by:

e Product name or family.

e Keywords or exact terms.

Finding patches
You can search for patches by patch ID or number, product, or family.
1  Signin to My Oracle Supportt at https://support.oracle.com.
2 Click the Patches & Updates tab.
3 Enter your search criteria and click Search.
4 Click the patch ID number.

The system displays details about the patch. You can view the Read Me file before downloading
the patch.

5  Click Download, and then follow the instructions on the screen to download, save, and install the
patch files.
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Finding Oracle documentation

The Oracle website contains links to Oracle user and reference documentation. You can view or
download a single document or an entire product library.

Finding Oracle Health Sciences documentation

For Oracle Health Sciences applications, go to the Oracle Health Sciences Documentation page at
http://www.oracle.com/technetwork/documentation/hsgbu-clinical-407519.html.

Note: Always check the Oracle Health Sciences Documentation page to ensure you have the most
up-to-date documentation.

Finding other Oracle documentation
1 Do one of the following:
e Go to http://www.oracle.com/technology/documentation/index.html.

e  Go to http://www.oracle.com, point to the Support tab, and then click Product
Documentation.

2 Scroll to the product you need, and click the link.

Finding prerequisite software for Oracle Health Sciences applications

Prerequisite software for Oracle Health Sciences applications is available from the following
locations:

e Download the latest major or minor release from the Oracle Software Delivery Cloud
(https://edelivery.oracle.com/).

For information on the credentials that are required for authorized downloads, click FAQ on the
main page of the Oracle Software Delivery Cloud portal.

e Download subsequent patch sets and patches from My Oracle Support
(https:/ /suppott.oracle.com).

To find patch sets or patches, select the Patches & Updates tab.

If a previous version of prerequisite software is no longer available on the Oracle Software Delivery
Cloud, log a software media request Service Request (SR). Previous versions of prerequisite software
are archived and can usually be downloaded. After you open an SR, you can check its status:

e  US customers: Call 1-800-223-1711.

e Outside the US: Check www.oracle.com/us/support/contact/index.html for your local Oracle
Support phone number.

For more information on logging a media request SR, go to My Oracle Support for Document
1071023.1: Requesting Physical Shipment or Download URL for Software Media
(https:/ /support.oracle.com/epmos/faces/DocumentDisplay?id=1071023.1).
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Chapter 1 Product tour

About the Central Designer application

The Central Designer application provides a collaborative environment for developing clinical studies
and addresses the need to significantly increase productivity in the study design process by:

e Providing one central environment for study design.
e Improving efficiency.
e Facilitating reuse.

e Supporting internal and external standards.

Applications

The Central Designer application provides a collaborative design environment that supports multiple
users and roles from any location.

There are two client applications:

¢ Central Designer—Used for collaborative study development.

e Central Designer Administrator—Used to set up users, permissions, system configuration
parameters, and catalog defaults.

An administrator must set up administration information before you can perform some tasks.

Deployment target applications

You can design a study in the Central Designer application and deploy the study to the InForm
application.

Users, rights, and roles

An administrator sets up users and roles in the Central Designer Administrator application. When an
administrator creates a role, the administrator chooses:

e The scope of the role. A role can have a library, study, or application scope.
e The rights to associate with the role.

The scope of a role, rights assigned to the role, and teams determine whether users can perform
certain activities and view different application areas.

e Library scope—Roles created with the library scope become library teams in the Central
Designer application.

To perform activities in a library, you must be assigned to:
e A role with a library scope in the Central Designer Administrator application.

e The corresponding library team in the Central Designer application.

4 Oracle® Health Sciences Central Designer 2.1.2
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e Study scope—Roles created with the study scope become study teams in the Central Designer
application.

To perform activities in a study, you must be assigned to:
e A role with a study scope in the Central Designer Administrator application.
e The corresponding study team in the Central Designer application.

e Application scope—Activities associated with the application scope are always available to all
users, whether or not the users are assigned to teams. Roles created with the application scope
do not become teams in the Central Designer application.

Oracle® Health Sciences Central Designer 2.1.2 5
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First steps

Logging on and off

If your logon session is inactive for the amount of time set by the administrator, you are prompted to
re-enter your password the next time you perform an activity.

To log on:

1 Navigate to the following address:
http:/ / <server name>/ CentralDesignerInstall
where <server name> is the name of the application server computer.
2 Click the Start Central Designer Client link.
A dialog box appears, indicating that the application is starting.
The logon window appears.

3 Type your User Name and Password.

Note: You might be prompted to change your password if your password has expired.

4 Optionally, if the web browser connects to the network through a proxy server that requires
authentication, click Proxy Settings to enter the user name, the password, and the domain used to
authenticate the connection to the proxy server.

5  Click Log On.

You are logged on to the application, and the application opens. By default, the Home Page
appears, but you can choose what you see after logon.

For more information, see Choosing what appears on startup (on page 21).
To log off and log on as a different user:
1  Select File > Log on As Different User.

If your project has unsaved changes, you are prompted to save.

The logon window appears.
2 Type your User name and Password, and click Log On.

To log off:

e  Sclect File > Exit.

If you have unsaved changes, you are prompted to save them.

6 Oracle® Health Sciences Central Designer 2.1.2
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Changing your password

You can change your password at any time. You are prompted to change your password when you
start the application if:

e The administrator has indicated that that you must change your password.
e Your password has expired.
To change your password after logging on:
1  Select File > Change Password.

The Change Password dialog box appears.
2 Type your old and new passwords. You must type your new password twice for confirmation.
3 Click OK.
To change your password because it is required:
1 Navigate to the following address:

http:// <server name>/ CentralDesignerInstall

where <server name> is the name of the application server computer.
2 Click the Start Central Designer Client link.

A dialog box appears, indicating that the application is starting.

The logon window appears.

3 Type your User name and Password, and click Log On.

The Change Password dialog box appears.
4 Type your old and new passwords. You must type your new password twice for confirmation.
5 Click OK.

Oracle® Health Sciences Central Designer 2.1.2 7
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Home Page

The Home Page displays deployment requests that you can approve, tasks that are assigned to you,
and recently viewed projects.

e On the Pending Approvals tab, you can approve deployment requests and view a history of
automated deployments.

e On the Recent Tasks tab, you can open a task, do the requested work, close the task, and go on
to the next task.

The Home Page closes after you open a library project or study project. By default, the Home Page

appears after you log on. For more information, see Choosing what appears on startup (on page
21).

For more information, see:

Home Page - Section desctiptions (on page 157).

Pending Approvals tab - Option descriptions in the InForm Design Guide.
Task areas - Field descriptions (on page 153).

Opening the Home Page
Your startup options determine whether the Home Page appears by default after you log on.

You can view the Home Page at any time.

e On the toolbar, click the Home Page button (@).

Opening a project from the Home Page

From the Home Page, you can:

e Open a study or library project by double-clicking the project or a task that is assigned to you.

e Open the application without opening a study or library project.

What to open ‘ Procedure

Recently accessed library project or study e In the Recent Projects List section, double-click a
project. project.

Library project or study project, by selecting e  In the My Tasks section or the Recent Tasks tab,
a task. double-click a task in the list.

Central Designer application, without e On the toolbar, click the Workspace button (I?l)
selecting a task or project.

Note: You can also open study and library projects by selecting File > Open.

8 Oracle® Health Sciences Central Designer 2.1.2
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Getting Help

Using online Help

e Press F1, and then click the area of the application for which you want more information. A
Help window appears with the relevant page displayed.

e To open a help document such as the User Guide, select Help and select the document.

If you need the version of the application, you can view it in the About Central Designer dialog box.
The dialog box also contains copyright information.

The following help is also available:

e Hover Help—Point to a button, tab, or icon, and a tool-tip appears.

e  Oracle Help Desk—Help is available from the Oracle Help Desk if you encounter system-
related issues. For more information, see If you need assistance (on page xii).

Troubleshooting issues with Help

If any of the tabs do not appear when you open the Help from the Help menu, add the name of the
application server to the list of trusted sites.

1 In Internet Explorer, select Tools > Internet Options.
2 Select the Security tab.

3 Select Trusted Sites, and click Sites.

4

In Add this Web site to the zone, type the address that the client application uses to connect to the
application server.

5 Click OK until you return to Internet Explorer.

Setting your machine for different locales

Viewing Japanese characters
Perform these steps if you are unable to view Japanese characters.

1  Select Start > Control Panel > Regional and Language Options.
2 Select the Languages tab.

3 Select Install files for East Asian languages.
4 Click OK.
5

Restart your computer.

Setting up a keyboard to use different locales

When the Windows operating system starts in a specific locale, it updates the keyboard settings for
that locale. If you will develop a study in a language other than the locale in which you are located,
use this procedure to switch your keyboard settings and shortcuts between locales.
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In each locale, set up the Windows operating system to support multiple text input languages—the
local language and the language in which the study is developed:

1  Select Control Panel > Regional and Language Options > Languages tab > Details.

2 In the Settings tab of the Text Services and Input Languages dialog box, make sure that both the
local language and the study development language are included in the list of supported text
input languages.

3 Activate the Language Bar.

4 Use the Language Bar to switch between the local language and the study development language.
Always log on to the Central Designer application in the study development language.

Additional locale settings
You set the default locale for a study in the Central Designer application.

The Microsoft Windows operating system also provides the following language-related options.

Option location Purpose

Control Panel > Controls the formatting conventions for numeric data,
Regional and Language Options >  including dates, times, numbers, and currencies.
Regional Options tab >

te: If he default locale f in th
Standards and formats section Note: If you do not set the default locale for a study in the

Central Designer application, this setting is used as the default
locale for a study. If you modify the regional setting, you must
close and reopen the Central Designer application to use the

new locale.
Control Panel > Controls the language of text in menus and dialog boxes. The
Regional and Language Options >  option appears only if you have one or more Multiple User
Languages tab > Interface (MUI) packs installed.
L.angu age used in menus and The Central Designer user interface supports only English.
dialogs
Control Panel > Controls the language that you use to type information on the

Regional and Language Options > computer.
Languages tab >
Details button >
Default input language

For example, if the default locale for a study is set to French
(France), all study metadata is saved as French metadata.
Even if the input language is English (United States) and you
type information in the English language, the information is
saved as information entered for the French locale.
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Project Explorer

The Project Explorer is the primary navigation tool in the Central Designer application. Located by
default on the left side of the Central Designer application window, the Project Explorer consists of
a set of hierarchical lists of the study objects in the design environment.

Lists of study objects appear in Explorer bars. When selected, each Explorer bar displays a list of
study objects in a tree format. For example, when you select the Elements and Events Explorer bar,
a tree listing of the study elements and study events in the open study or library appears in the
Project Explorer. You can expand the tree listing to view the child study objects of each study object
in the tree.

e When you select the icon for a group of study objects (for example, Forms) in the Project
Explorer, the editor for that type of study object appears in the application workspace and lists
the study objects of that type that have been defined for the open study or library.

e When you select a specific study object, the editor for that study object appears in the application
workspace.

The Central Designer application has numerous options for finding, sorting, filtering, and displaying
study objects in the Project Explorer.

Adjusting the view of the Explorer bars in the Project Explorer

You can choose between two Explorer bar groupings:

¢ Bottom Grouping—LExplorer bars are grouped at the bottom of the Project Explorer. You can
slide a splitter bar to control how many bars are visible in the Project Explorer. When an
Explorer bar is not visible, an icon representing the Explorer bar appears at the bottom of the
Project Explorer.

e Zipper Grouping—All Explorer bars appeat in the Project Explorer. The Explorer bats before
the selected Explorer bar appear at the top of the Project Explorer. The Explorer bars after the
selected Explorer bar appear at the bottom of the Project Explorer.

To select an Explorer bar grouping:
1 At the top of the Project Explorer, select Options > Explorer View.
2 Select a grouping option.
To view a subset of Explorer bars in the Project Explorer:
e In the Project Explorer, do one of the following:
e (lick and drag the splitter bar up or down.

e In the bottom right corner of the Project Explorer, click the arrow, and select Show More
Buttons or Show Fewer Buttons.
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Finding a study object in the Project Explorer

1

[ N B T N \ S

At the top of the Project Explorer, click Find.

The Find dialog box appears.

In the Find what field, type the text to seatch for.

In the Fields to search options, select the fields in which to search for the specified text.
To match the case used in the search, select Match case.

To search for the whole word, select Match whole word.

Click Find Next.

Starting with the selected study object, a search is performed. The first study object whose
RefName or title matches the text that you type is selected.

Study objects filtered from view are ignored.

Sorting study objects

12

The Project Explorer for library projects and study projects has containers that hold study objects.
For example, the Forms container holds all forms in the study or library. You can sort the study
objects that appear in each container.

By default, study objects appear in the following order in the Project Explorer:

Study objects added to a Study Design, Study Element, or Study Event appear in workflow
order.

Study objects added to a form appear in the order in which they are added.

Study objects without children appear in alphabetical order.

In the Project Explorer, select Options > Container Sorting.

A menu appears.

Select one of the following options:

e Ascending—Sort the study objects in each study object container in alphabetical ordet.

e Descending—Sort the study objects in each study object container in reverse alphabetical
order.

Note: If the order of the study objects is important, for example, the order of items on a form,
these study objects cannot be sorted.
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Filtering container objects

1 In the Project Explorer, select the Explorer bar for the study objects to view.

2 At the top of the Project Explorer, select Filters.

Note: The Filters drop-down list is not enabled for the containers in the Study Information
Explorer bar or the Visit Schedule Explorer bar.

3 Select one of the following:
®  All Objects.
e  Modified Objects—Study objects modified since the project was last saved.
®  Local Locks—Study objects you locked.
e Remote Locks—Study objects locked by other users.

The workspace contains only the study objects specified by the filter. In addition, the header in
the Project Explorer indicates that the workspace is filtered.

Viewing study object titles or RefNames in the Project Explorer

You can view cither the RefNames or the titles of all study objects in the Project Explorer. When
developing naming conventions, consider that all study objects (except study projects, library
projects, libraries, and studies) have RefNames and titles, which can be different.

e RefNames are referenced in rules and are deployed to the target application. Therefore, they
must:

e Follow C# variable standards.
e  Start with a letter or an underscore.
e Contain only letters, numbers, and underscores.

e Be unique within a study or library. For example, you cannot have a form and an item with
RefNames of DOV in the same study or library.

e Titles are the more readable display names for study objects. They can contain spaces and special
characters, but are not referenced in rules and are not deployed to the target application.

To view titles or RefNames:

e At the top of the Project Explorer, select Options > Display Names, and select a display option.

The option you select remains selected when you open a new session.

Oracle® Health Sciences Central Designer 2.1.2 13



Chapter 1 Product tour

Editors

An editor allows you to work with study or library objects. The Central Designer application includes
editors for each type of study object and for individual study objects. When you select a type of study
object or a specific study object in the Project Explorer, the editor for that study object type or study
object appears in the workspace.

e The editors for types of study objects (container editors) are organized as grids in which each
study object of the type in the study or library appears in one row of the grid. Commands that
allow you to perform actions on a selected study object appear at the top of the grid. You can
arrange the columns of the grid in the order you prefer, and you can include or exclude columns
as needed.

For more information, see Customizing the workspace (on page 20).

e The information in editors for individual study objects is organized into tabs that give access to
subsets of the functionality available for each type of study object. For example, when you create
a form, item, or codelist, the Design tab in the Form, Item, or Codelist editor allows you to
define the characteristics of the new study object.
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Browsers

About browsers

Browsers enable you to perform specific study and library design, management, validation, and
deployment activities. The following browsers are available in the Central Designer application:

e Project Explorer—View and navigate to study objects in the current study or library.
e Properties Browser—View and modify properties for a study object.

e Libraries Browser—View library objects, and drag them into a workspace.

e Users Browser—View users, and drag them into a workspace.

e Collaboration Notes Browser—View, create, and edit collaboration notes.

e  Tasks Browser—View, create, edit, and manage tasks that you have created or that are assigned
to you.

e Baselines Browser—View, edit, and delete validation baselines.
e Jobs Browser—View, edit, and delete jobs, including validation, deployment, and import jobs.

¢ Add To browser—View and add study objects that are available to be added to a workspace.

Opening and closing a browser

You can close the browsers that you do not need to work in. Your changes are saved for the next
time you log on.

Note: If a browser name has a checkbox beside it in the View menu, it is open. If no checkbox
appears, it is closed.

To open a browser:
e  Sclect View, and then select a browser from the list.

To close a browser:

e  Click the X button, located in the upper-right corner of the browser.
or
Select View, and deselect a browser from the list.

You can reset the layout of the application window (on page 20) to the default view.
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Rearranging a browser in the application window

16

1

Click the title of the browser (located to the left of the Auto-Hide button (E} and the X button),
and drag it away from its location. Do not release the mouse button.
The mouse cursor changes to a plus sign with arrows (‘%)

Arrow buttons appear at the top, bottom, left, and right of the application window (for example:
L,

Drag the browser (without releasing the mouse button) to the desired location in the application
window.

Arrow buttons appear in the application area. For example:

Point your mouse to an arrow button. The application area where the browser will appear is
highlighted. After you find the desired location for the browser, release the mouse button.
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Showing and hiding a browser

If a space holds multiple browsers and you can see only one at a time, hiding or showing one affects
all of them.

Browser controls

2
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1—When a browser is hidden, it does not appear automatically. You must point your cursor to the
named tab for the browser to show it.

2—The Auto-Hide button is sideways, indicating that the browser is hidden.

To hide a browser:

e (lick the Auto-Hide button (ﬂ), located in the upper-right corner of the browser.

To view a hidden browset:

e Point your mouse to the name of the hidden browser. (The name of the browser appears along
the outer edge—either the sides or the bottom—of the application window.)

The browser appears and remains visible as long as the cursor is somewhere within the browser
window. If you move the cursor away while the browser is temporarily shown, the browser
becomes hidden again.

To show a browser:

1  Point your mouse to the name of the hidden browser. (The name of the browser appears along
the outer edge—either the sides or the bottom—of the application window.)

The browser appears.

2 Click the Auto-Hide button (™), located in the upper-right corner of the browser. (The icon is
sideways when the browser is hidden.)
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Editing study object properties in the Properties Browser

1 Select the study object.

2 Select the Properties Browser.

Note: If the Properties Browser is not visible, select View > Properties.

3 Edit the properties of the study object. After changing each property, press Enter, or tab to the
next property.

Note: The values of editable properties appear in bold, black text, and the values of non-
editable properties appear in gray text.

For descriptions of the properties for study and library objects, see the Appendix.
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Navigating to a specific Explorer bar, editor, or browser

1 From the application toolbar, select Tools > Go to Window.
The Go to Window dialog box appears.
2 Select an Explorer bar, editor, or browser.

3 Click Go To.
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Customizing the workspace

Arranging fields, tabs, and browsers

You can arrange the order of:

Fields in most grids.
Tabs in editors.

Browsers that are grouped.

To arrange the order of fields, tabs, or browsers:

Drag a field, tab, or browser to a new position.

Resetting window layout and message boxes

You can reset the following information for yourself only:

Window layout

e Reset location and visibility of all browsers.

e Reset the size of the application window (for example, minimized or maximized).
Message boxes

Deselect the Do not show again setting for all information messages. Messages that you chose not
to see now appear.

To reset window layout or message boxes:

1

Select Tools > Options.
The Central Designer Options dialog box appears.
Click Reset Window Layout or Reset Message Boxes.

Click OK.

Showing and hiding the status bar

The Status bar and toolbar are at the bottom of the application window.

20

1

2
3

Select Tools > Options.
The Central Designer Options dialog box appears.
Select or deselect Show Status Bar.

Click OK.

For more information, see Status toolbar - Option descriptions (on page 157).
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Changing the number of projects that appear in the Recent Projects list
By default, the six most recently viewed study and library projects appear on the Home Page.
1 Select Tools > Options.
The Central Designer Options dialog box appears.

2 In the [number] part of the Display [number] projects in Recent Projects list option, type the number
of projects to appear.

3 Click OK.

Choosing what appears on startup
1  Select Tools > Options.
The Central Designer Options dialog box appears.
2 From the At Startup drop-down list, select one of the following options:
e Show HomePage—The Home Page appears after you log on.
e Show Workspace—A blank workspace with no project appears after you log on.

e  Load Most Recent Project—The project you opened last appears in the workspace after you log
on.

3 Click OK.

Filtering your view of system-specific study objects

The main toolbar contains a View Targets drop-down list that allows you to view objects for one
target application or all target applications. Only the target applications that are enabled in the
Targets workspace in the Central Designer Administrator application and selected in the Targets field
in the General tab for a study appear in the list.

To filter your view of system-specific study objects:
e From the View Targets drop-down list on the main toolbar, select an option:
e All—(Default selection in every project) All study objects appear.

e  <target application name>—Only study objects for the selected target application appear.
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Viewing more than one tab in the workspace

1

In the Project Explorer, select a study object.

The editor for the study object appears in the workspace.

Click one of the tabs, and drag it within the workspace, without releasing the mouse button.
The mouse cursor changes to a plus sign with arrows.

Arrow buttons appear in the workspace. For example:

Point your mouse to an arrow button, and the application area where the tab will appear is
highlighted, as shown in the following example. After you find the desired location for the tab,
release the mouse button.

Filtering data in a grid

You can filter data in most grids, such as the grid in the Collaboration Notes Browser.

22

For example, if you created multiple collaboration notes based on several collaboration note types,

you can filter to view only the collaboration notes of a certain type.

To filter the data that appears in a grid:

1

4

In any grid, right-click a field, and select Filter Row.

Filtering fields appear at the top of every column in the grid.

To use a filtering operator, click the filter operators button (il), and select an operator. If you
do not select an operator, Starts with is used by default.

In the filter field, type the text to use for the filter.
As you type, an incremental filter of the column is performed.

To remove the filter, click the Clear Filter Criteria button, located at the end of the field.

To remove the filter row:

In any grid, right-click any field, and deselect Filter Row.
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Grouping data in a grid
To view the grouping panel and group data in a grid:
1 Inagrid, right-click any field, and select Group.
The grouping panel appears above the grid.

2 Drag a field to the grouping panel to group the grid by that field. You can group by one or more
tields.

To remove the grouping panel:

e Ina grid, right-click a field, and deselect Group.

Showing and hiding a field

To change the fields that appear in a grid:

1 Inany grid, right-click any column, and select Columns.
The Columns dialog box appears.

2 Select fields that appear in the Available Columns or Displayed Columns lists, and use the Add,
Remove, Add All, or Remove All buttons to move them to the correct list.

3 Optionally, to arrange the order of fields in the Displayed Columns list, select a field and click
either Move Up or Move Down.

4 Click OK.
To hide a field:

e Inany grid, right-click the field you want to remove, and select Hide Column.

Sorting data in a grid
1 Inany grid, select a field one time.
The data from the field is sorted in ascending (if letters, alphabetical) order.

2 To sort the data in descending order (if letters, reverse alphabetical), select the field a second
time.
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Planning
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Planning teams and collaboration

In the Central Designer application, you can develop multiple studies simultaneously, and multiple
users can work on the same study simultaneously.

Questions to consider ‘ \[o] (=X

How will work be divided and ~ For example:

assigned? ) . .
e Who will work on each study? Do study designers in your
organization specialize in particular therapeutic areas?
e Do you want different users to manage study objects in
libraries and study objects in studies?
e Will different users create study objects and rules?
e Do you want to assign supervisors to review the work of
other users?
e If your studies will be localized, is translation performed as a
separate activity or by the user who creates study objects?
How will people work Which activities must be performed sequentially, and which can
collaboratively when tasks are  be performed concurrently? For example, the following activities
divided? depend on the existence of a study object but can be performed in
any order after the study object has been created:
e Defining study object properties.
e Defining form layout.
e Translating text.
e  Creating rules.
In how much detail do you e What types of tasks do you want to define?

want to break down tasks? . .
e Which teams should perform particular task types?

How do you want to use For example, you could use collaboration notes to communicate:
collaboration notes? What types

of collaboration notes do you Design specifications for study objects.

want to define? e  Other information about study objects.
e Instructions to other users.

e Status information about study objects that are in the process
of development.

How will the order in which The Central Designer application supports building studies from

you develop study objects the top down, from the bottom up, or a combination of

affect your team assignments?  approaches. In what order do you prefer to develop study
objects? For example, you could have one team member build or
copy all of the required codelists while another creates the study
workflows.
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Questions to consider

How will reuse affect your
validation and formal testing

plans?

‘ [\ [o] (=X

After a study object has been validated, it should not be necessary
to retest it in every study where it is used.

Example of collaboration

Note: The following table provides sample roles only. You can set up roles in a manner that is
appropriate for your organization.

Role

Clinical project
manager

Responsibilities ‘ Collaboration actions

e Collects requirements. Sets up study teams.

e  Writes or co-writes the
protocol document.

e  Decides the users who will
work on each study.

Study architect

Compiles a study by: e Designs the workflow of the study.

e  Collecting pre-approved .
form resources.

Creates tasks for study objects
requiring more work, such as forms
e Defining study workflow. ':llat tnl))ustrbetdzmgned or rules that
ust be created.
Specifyi h
*  opcalying where new e  Assigns the tasks to the study

forms are needed.
development team.

Study development
team

Builds new forms specified by e
the study architect.

Attaches collaboration notes to study
objects to share information during
study development.

e As each form is completed, creates a
task to translate the form into the
required languages and assigns it to the
study translation team.

Study translation
team

Translates form resources for
use in multiple language
environments.

Completes the translation tasks.

Study development
project manager

Checks the statuses of tasks to ensure that
the project is on schedule.

Manages the progress of the
project.

Oracle® Health Sciences Central Designer 2.1.2 27



Chapter 2 Planning

Example—Using a standard task

A study architect is creating a study event and has added several standard forms from the library. She
needs a form for capturing test results but is unable to create it. She uses a standard task to assign the
work.

a  The study architect creates and names a blank form.

b On the form, the study architect creates a standard task that contains instructions to design
the form, including the information that the form must capture. If the instructions are
already written, she can attach the document to the task. The study architect assigns the task
to the form design team.

¢ A member of the form design team sees the task in the Home Page. The form designer
double-clicks the task, and the specified project and form open.

d The form designer accepts the task.

e The form designer uses the instructions in the task to build the form. If he needs help from
rule designers, translators, or other specialists, he creates new tasks for the form and assigns
them to the other teams.

f  The form designer completes the form and changes the status of the task to Complete.

g After reviewing the work and verifying that it is complete, the study architect changes the
status of the task to Closed.

Example—Using a translation task

A form designer is creating a form in English. He needs to translate the form into French (France)
and Portuguese (Brazil), but he does not speak either language.

a  The form designer creates the form in English and saves it.

b The form designer creates two translation tasks for the form. In each task, he chooses one
language into which the form must be translated. The first task requests translation into
French (France), and the second task requests translation into Portuguese (Brazil). He
assigns both tasks to the translation team.

¢ A member of the translation team sees the task in the Home Page. The translator double-
clicks the task and the specified project and form open.

d The translator accepts the task.
e 'The translator uses the instructions in the task to translate the form.
f  After completing the translations, the translator changes the status of the task to Complete.

g After reviewing the work and verifying that it is complete, the form designer changes the
status of the task to Closed.

Note: In general, create a translation task for each locale that requires translation. For example, if
you create three tasks, for translation into French, Spanish, and Japanese, a different person can
accept each task. If a single person performs all translations for all locales, you can create a
single translation task for all locales.
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Planning libraries

Guidelines for library development

Creating study objects

e  Create study objects with reuse in mind, and reuse study objects as much as possible. Creating
study objects takes some time, but you will save time in the long run when you reuse the study
objects.

e Build study objects in a library using a top-down or bottom-up approach, just as you can for
study objects in a study.

e Ty to design study objects completely before adding them to a library. For example, add rules to
study objects before adding the study objects to a library, so you do not need to recreate the
rules every time you reuse the study objects.

Organizing libraries

Consider creating a different library for therapeutic areas, specific components, and the product that
is being tested. For example:

®  You can create an oncology library, a pediatrics library, and an infectious diseases library.

®  You can create separate production libraries for approved user-defined functions and approved
codelists.

Types to cteate

A library that has been built and maintained appropriately is a powerful tool that helps to decrease
the time and effort needed for building a study. You can set up libraries as needed. Oracle
recommends creating two different types of libraries, staging libraties (on page 29) and production
libraties (on page 30).

Staging libraries

About staging libraries

Use Use a staging library to hold study objects before you add them to a
production library.

You can add categories and keywords and change the values of custom
properties in the staging library.

When you plan the study objects that will be reused, consider forms as
well as other study objects that will help you build a study more quickly.

Users Oracle recommends allowing only librarians to work in the library.
Number to create One or many.
Adding study objects A librarian can copy study objects as needed from production studies

and test studies to a staging library.
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About staging libraries

Modifications to study

A librarian can add appropriate information needed for storing the study

objects objects in a production environment.
Oracle recommends allowing only the librarian to modify the study
object.

Searches Oracle recommends that you do not give users the rights to search

staging libraries.

Production libraries

About production
libraries

Use Use production libraries for study objects that have been tested in the
target application and that will be reused in other studies.
Users Oracle recommends allowing only librarians to work in the library.

Number to create

You can create one or many. Oracle recommends creating multiple
production libraries to maximize scalability.

When planning library development, encourage the use of standards. As
the number of libraries grows, you can restrict searches to specific libraries
so that you are searching only for study objects that are related to the study
that you are developing,.

Adding study objects

Oracle recommends that you develop an approval process for adding study
objects to a production library. The approval process, which happens
outside of the Central Designer application, might be conducted by a
standards committee.

After a study object has been tested, approved, and added to a production
library, you can add the study object to additional production libraries
without retesting it. Therefore, you can use the principles of reuse for
building libraries as well as studies.

If you use the Copy > Link option, the new study object retains a link to
the original study object.

Modifications to study
objects

To maintain the integrity of a production library, do not modify study
objects that are in the library, except in unusual circumstances in which the
change must be propagated to all studies that use the study object, or if the
change:

e Is trivial, such as a spelling mistake.
e Does not affect testing.
e Is necessary for all users.

Oracle recommends modifying a study object outside the production
library, and then adding the modified study object to the production library
as a new study object.
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About production

libraries

Searches Oracle recommends that you allow users to search production libraries and
view all published objects in them.

Questions to consider o  How will you use categories and keywords to organize your study
while planning objects?

A good categorization strategy will help you find study objects more
efficiently. You can use categories for higher-level categorization and
keywords for lower-level categorization.

e What naming convention will you use for study objects, mappings, and
functions?

A naming convention will help you identify different types of study
objects in your search results and will prevent you from giving the
same name to two study objects in different libraries.
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lllustrations of library workflow

32

lllustration: Example of a production library

Example of a production library

AE/CM (study event)
Form 1: AE (repeating form)
Form 2: CM (repeating form)

Study element
Contains the cycle of study
events for an oncology study.

The illustration provides examples of content that you can include in a production library,
including:

e  Study clements.
e  Study events.

e Forms (in or not in study events).

Codelists.

e Mappings.
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lllustration: Building libraries using study objects from production studies

Building libraries using study objects from production studies

/

Libraries

\

-

Production
library

Staging
library

Production

library

Production

library

/

Studies

N

Production study
(fully tested)

J

[9%]

/

-

Test study

/

The illustration shows how you can add study objects from a production study to a production
library. The production study has been validated in the Central Designer application and fully tested

in the target application.

The numbers indicate the order in which study objects move among studies and libraries.

Oracle recommends implementing a process that requires study objects to be approved before they
can be added to a production library. This task might be performed by a standards group.
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lllustration: Building libraries from scratch

Building libraries from scratch

/ Libraries \ / Studies \

Production
library

Production
library

Production
library

Test study

o AN /

The illustration shows how you can create study objects in a test study and then add them to a

production library.

Oracle recommends implementing a process that requires study objects to be approved before they
can be added to a production library. This task might be performed by a standards group.
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lllustration: Building a study using libraries

Building a study using libraries

/ Libraries \ / Studies

Production study

(fully tested)

o DN /

The illustration shows how you can add study objects from a production library directly to a
production study. The production study has been validated in the Central Designer application and

fully tested in the target application.

Oracle® Health Sciences Central Designer 2.1.2

35



Chapter 2 Planning

36

lllustration: Modifying study objects in production libraries

Modifying study objects in production libraries

/ Libraries \

Production
library

Production
library

Production
library

Staging

/ Studies \

s

library

- /

Test study

N /

The illustration shows how you can modify study objects that are in a production library.

Oracle recommends updating the version number of the study object in the staging library to track

changes.

The processes determined by your company determine whether trivial changes, such as a typo
correction, need to be retested in the target application.

Oracle recommends implementing a process that requires study objects to be approved before they
can be added to a production library, even if they have only been modified and have already been in
a production library. This task might be performed by a standards group.
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lllustration: Multiple instances of study objects in production libraries

Multiple instances of study objects in production libraries

Vital Signs
Item 1: itm_wgt
Item 2: itm_hgt
Item 3: itm_bmi

Vital Signs_2 Vital Signs_2
Item 1: itm_wgt Item 1: ?tm_wgtz
Item 2: itm_bps W9 Item 2: itm_hgt2

Item 3: itm_bmi2 Item 3: itm_bmi2

Adverse Events
Iltem 1: itm_AE
Item 2: itm_date onset

DEM
Iltem 1: itm_dob
Item 2: itm_scr date
Item 3: gender

Study objects, including forms and items, can appear multiple times in a single library and can also
appear in other libraries. For example, in the illustration:

e The following forms were copied with the Copy > Link option:
= Vital Signs—Appears in both the Arthritis and Migraine libraries.
=  DEM-—Appears in both the Migraine and Cholesterol libraries.
= Adverse Events—Appears in all three libraries.
e Anitem may be in a library in multiple places. For example, the itm_wgt is:
* In the Migraine library as part of the Vital Signs_2 form.
= In both the Migraine and Arthritis libratries as part of the Vital Signs form.

= Inboth the Migraine and Arthritis libraries as a standalone item.
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Planning how to manage study objects
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Central Designer libraries make it possible to store and reuse the study objects that make up a study.
When planning the development of a study, consider how you want to manage study objects.

Questions to consider Notes

Do you prefer to develop The Central Designer application supports both approaches:
studies based on your data
analysis and reporting needs or

based on the forms used to e Form-based—You can start by developing forms, items, and

collect data? other study objects, or by creating a study workflow.

Data-based—You can start by developing mappings.

You can also work on both approaches simultaneously.

What types of libraries do you  For example, libraries for:

want to maintain? ]
e Therapeutic areas.

e TFunctions.

e Codelists and codelist items.

e Customers (CRO).

e Mappings for SDTM or ODM.

Do you have an existing library  You can import libraries in CSML or ODM format.
that you want to use?

How do you want to be able to  For example:
search for study objects? (How
will you categorize study

objects?) e By customer (CRO)

e By therapeutic area

e By study

What types of study objects For example:
will be reused in multiple

studies? e Standard forms.

e Study objects with rules.

Who will be responsible for Study object management tasks can include:
setting up libraries and for
determining the content of
libraries?

e Naming (for example, enforcing adherence to a naming
convention).

e (Categorizing.
e Making changes.
e  Publishing (making study objects available for reuse).
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Questions to consider Notes

Any part of study object definition can be stored in a template,
including a whole study, and you can create templates from all
types of study objects and from mappings. For example, a study
template can include:

How do you want to use study
templates?

Standard study objects, including child study objects such as
codelists.

Default settings of study object properties.
Team members.

Full or partial workflows.

Rules.

Mappings

How will study object reuse
affect your testing of study
designs?

If you perform formal testing on study objects before saving them
in a library, it should not be necessary to retest them each time
they are reused.

Will you develop naming
conventions for study objects?
How will your reporting needs
affect naming conventions?

Consider that study objects have RefNames and titles:

A RefName is the formal name of a study object. RefNames
are:

e Referenced in rules.
e Deployed to the InForm software.

A title is an additional name that you can make more readable
than a RefName (for example, titles can contain spaces and
special characters). Titles are:

e Not referenced in rules.

e Not deployed to the InForm application.

Additionally, a data set and data series in a mapping can have an
alias, which, if present, is used as the column heading in a
customer-defined database (CDD).

How do you prefer to test
study objects?

You could:

Create study objects in a study, validate and deploy the study,
and move tested study objects to a library.

Create study objects in a test library, use them in a study to
test them, and move tested study objects into a library for
general use.
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Planning rules and edit checks

Rule definition accommodates different levels of technical expertise.

Questions to consider ‘ Notes

What types of rules and edit What types of rules can you create on standard study objects that
checks does the study requite?  can be reused?

What standard edit checks can
be defined in a rule template?

What types of functions do you
require, in addition to the
functions included with the
Central Designer application?

What types of additional The functionality encapsulated in functions and rule templates
functions would make the does not need to be tested in every study object where it is used.
development of rules simpler or

would make rules easier to

reuse?

How do you want to assign the Consider:
development of rules to the

members of your team? e Will one user create rule specifications and another user

implement the rules?

e Which rules can be created with templates or functions by
users with no programming experience?

e Which rules require users with programming experience?

How do you plan to test new  You can use the Rule Test Cases dialog box to test data-entry
data-entry rules? rules, global conditions, and workflow rules.

How do you plan to test new
functions that you develop?
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Planning the study workflow

Questions to consider Notes

What is the structure of your study? Does the study include:

e Multiple treatment arms?

e Unscheduled visits?

e Repeating forms or visits?

e Dynamic visits, forms or controls?

e Common forms?

Do you prefer to develop a study  You can use the workflow tools to:
from the top down or from the

. .
bottom up? Summarize the flow of a study as a reference for the users

who then develop the detailed definitions of study
objects. This is a particularly useful communication
device in complex studies.

e Connect previously defined study objects.

When data is collected at multiple ~ Repeating study objects (study events and forms) enable you
points in a study, do you want to to see all instances of the collected data in one location, or to
reuse those study objects or make  navigate easily between instances.

them repeating?
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Planning mappings and data extracts

You can group study data by using mappings. A mapping is a data grouping that provides an
alternate data view of a study.

Questions to consider ‘ \[o] (=X

What types of reports do you
need to generate while the
study is in process? What types
study data will you need after
the study is complete?

How do you want to map data  The Central Designer application supports:

from an InForm study?
e  Customer-Defined Database (CDD) mappings.

e  CIS mappings to the Clintrial application.

Do you want to use a mapping A mapping for rules allows you to:

for rules? . . .
e  Write rules that are outside the scope of a study object.

e  Write rules that use arrays of data values.

Do you want to create data
extracts that conform to a
particular standard such as
SDTM or ODM?
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Collaborating

In this chapter
Implementing collaboration.....................

Working in a collaborative environment
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Implementing collaboration

Creating and modifying tasks

46

Tasks

About tasks

A task is a request that you attach to a study object (a study, study element, study event, form, or
item). A task is similar to a collaboration note except that you assign a task to an individual or to a
whole study team. In a task, you can include detailed information and specify a due date and priority.
You can format the text of a task and attach a file to it.

Example of using tasks

For example, a study workflow designer builds the framework for a study and includes information
about the rules that will be required. A study architect can create rules to use as placeholders, without
defining their expressions, and then create tasks for rule creation and assign them to the rule
development team.

Level at which to create tasks

You can create a task on the study object, such as the form to be designed, or the parent study
object, if the study object has not been created.

If the study object does not exist, consider creating a placeholder study object and then creating the
task on the study object. For example, when the task assignee double-clicks the task in the Home
Page, the Project Explorer opens, and the user is brought directly to the study object.

In general, create one task for each activity to be completed so that completed and remaining work
can be assessed accurately.

Copying study objects with tasks
Tasks are not copied when a study object is copied from a library or published in a library.
Task types

When you create a task, you must choose a type on which to base it.
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Task types

Administrators create task types in the Central Designer Administrator application. Task types are
used to identify the type of the task and the way the task is used. Task types can be classified as
Standard or Translation. Administrators select a default team to which tasks of each type are
assigned. Selecting a default team is optional for standard tasks.

When you create a task, you choose a task type on which to base the task.

You can create multiple task types for each task classification. Task classifications are predefined and
you cannot modify them.

Task Description Example

classification

Standard Used for all non-translation tasks assigned to
an individual or team.

Task name: Create form

e  Default teams: Study
When you create a standard task, you can designers, Form designers

override the default assignment.

Translation Used for tasks that request translation of a e Task name: Translate form

study object into one or more languages. .
Default team: Translation

When you create a translation task, you team.
choose the language into which the study
object must be translated.

Note: Oracle recommends selecting only one
language for each translation task, unless you
expect that the same person will translate into
all of the selected languages.
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Task statuses

Tasks appear in the Home Page and the Tasks Browser.

e Tasks that are assigned to you appear in the Home Page.
e  All tasks appear in the Tasks Browser.

Note: If a task is overdue, the status displayed in the status field is Overdue—[Current status|, such
as Overdue—Accepted.

Procedure Task status Description

Creating a task (on  Open When you create a task, you assign it to one or more
page 49). individuals or teams.

Accepting a task (on Accepted When you accept a task, you take responsibility for
page 59). completing the task. Only one person can accept a task,

and you can only accept tasks that are assigned to you.
After you accept a task, you can:

e  Mark it as Complete after you finish all required work.

e Unaccept it if you will no longer work on the task.

Unaccepting a task  Open You can unaccept a task that you have accepted but will

(on page 59). no longer work on. An unaccepted task is assigned to the
team to whom it was originally assigned. If no default
team was selected, you are prompted to assign the task to
a team ot individual.

Completing a task  Completed You can mark as Complete only those tasks that you have
(on page 59). accepted. A completed task is assigned to the task creator.

The task creator can do the following to a completed task:
e (lose it if work is complete.

e Reopen it if work is not complete.

Closing a task (on  Closed You can close completed tasks that you created. You close
page 59). a task after you verify that all work has been completed. A
closed task is assigned to the task creator.

Reopening a task Open Two people can reopen a task, the person who created it

(on page 59). and the person who completed it. A reopened task is
assigned to the individual or team to whom it was assigned
by default. If no default team was selected, you are
prompted to assign the task to a team or individual.
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Task workflow

In the following illustration, activities appear in boxes with task statuses below them.

Creator Creator or assignee Assignee
Create
r
Open Reopen » Accept |e» Unaccept
Open y Accepted Open
Complete
Clons p Completed
Closed

Creating a task

Note: You must save a study object before you can attach a collaboration note or task.

1 In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

2 In the Tasks Browser, click New Task.
The Task Editor dialog box appears.

3 From the Task Type drop-down list, select the type of task to create. (Task types are defined in the
Central Designer Administrator application.)

From the Priority drop-down list, choose a priority for the task.
From the Due drop-down list, choose the date that the task is due.

On the Instructions tab, type the instructions for the task.

g4 o un A~

To edit the appearance of the text, use the buttons on the toolbar.
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8 To add an attachment, complete the following steps:
Note: The maximum size of the attachment is determined by a variety of factors, including
information defined in the configuration file, available hard disk space, and available
memory. To determine the approximate maximum attachment size, check the
maxRequestLength attribute in the machine.config file.
a  Click the Attachments button ( B ).
The Attachments dialog box appears.
b  Click Add.
The Open dialog box appears.
¢ Navigate to a file, and click Open.
Click OK.
9 If you are creating a Standard task, select the Assignment tab and choose the team (or teams) or
user (or users) to assign the task to.
or
If you are creating a Translation task, select the Languages tab and choose the languages to which
the task must be translated. (Only the languages configured as supported locales in the Central
Designer Administrator application appear.)
Note: You must assign every task to at least one individual or team. For translation tasks,
the default assignment for the task type is used.
10 Click OK.

For more information, see Task Editor dialog box - Option descriptions (on page 155).

Changing the assignees for a standard task

When the status of a task is open, you can change the assignees for a standard task, but you cannot
remove all assignees from the task.

Note: You cannot change the assignees for translation tasks.

6

In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

In the Tasks Browser, select a task.
On the toolbar, click Edit.

The Task Editor dialog box appears.
Click the Assignment tab.

Modify the users ot teams to which the task is assigned. You must assign the task to at least one
person or team.

Click OK.

For more information, see Task Editor dialog box - Option descriptions (on page 155).
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Deleting a collaboration note or task

Only the creator of a task or a user with the necessary rights can delete a task. Consider deleting tasks

that were created in error or that are no longer relevant. Tasks provide an audit trail for assigned
activities, so you should not delete tasks if you want to maintain an audit trail of assigned activities.

If too many tasks appear on the Home Page, use filters to view, for example, only Open or Accepted

tasks.

1 In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

2 For tasks—In the Tasks Browser, select a task.

For collaboration notes—In the Collaboration Notes Browser, seclect a collaboration note.
3 Click Delete.

A message asks you to confirm the deletion.

4 Click Yes.

Editing a collaboration note or task

You can edit the text of collaboration notes and tasks, and you can remove attachments from
collaboration notes.

To edit the text of a task:

1 In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

2 In the Tasks Browser, select a task.

3 On the toolbar, click Edit, or double-click the task.
The Task Editor dialog box appears.

4 Edit the task as necessary, and click OK.

To edit the text of a collaboration note:

1 In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

2 In the Collaboration Notes Browser, sclect the collaboration note that you want to edit.
3 On the toolbar, click Edit, or double-click the collaboration note.

The Collaboration Note Editor dialog box appears.
4 Edit the collaboration note as necessaty, and click OK.

To remove an attachment from a collaboration note:

1 In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

2 In the Collaboration Notes Browser, select a collaboration note, and click Edit.

The Collaboration Note Editor dialog box appears.
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3 Click the Attachments button (a paperclip icon).
The Attachment dialog box appears.
4 Select the file that you want to remove, and click Remove.
5 Click OK.
For more information, see:
Collaboration Note Editor dialog box - Option descriptions (on page 152).

Task Editor dialog box - Option descriptions (on page 155).

Printing a collaboration note or task

1 In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

2 Do one of the following:
e For tasks—In the Tasks Browser, select a task.

e For collaboration notes—In the Collaboration Notes Browser, select a collaboration note.

3 Click Print.

Tasks Browser

The Tasks Browser displays all tasks that are attached to the study object that is selected in the
Project Explorer and, optionally, its child study objects. All users can see the tasks assigned to them.

In the Tasks Browser, you can:

e Create, view, sort, filter, and group tasks.

¢  Modify and delete a task.

e  Print tasks.

e Select Show Children. You see all tasks attached to the selected study object and its children.
e Tilter the tasks that appear. For more information, see Filteting data in a gtid (on page 22).

By default, the browser is located at the bottom of the application window.
To open the Tasks Browser:

e  Select the View menu, and make sure Tasks is selected.

For more information, see Tasks Browser - Option descriptions (on page 154).

52 Oracle® Health Sciences Central Designer 2.1.2



User Guide

Creating a collaboration note

You can create a collaboration note from the Project Explorer and from the Collaboration Notes
Browser.

Note: You must save a study object before you can attach a collaboration note or task.

1 In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

2 Right-click the study object, and select Add Collaboration Note.
or
In the Collaboration Notes Browser, click New Note.
The Collaboration Note Editor dialog box appears.

3 From the Note Type drop-down list, select a collaboration note type.

Note: Collaboration note types are defined in the Central Desigher Administrator
application.

4 On the Instructions tab, type the instructions for the task. To edit the appearance of the text, use
the buttons on the toolbar.

5 To add an attachment, complete the following steps:

Note: The maximum size of the attachment is determined by a variety of factors, including
information defined in the configuration file, available hard disk space, and available
memory. To determine the approximate maximum attachment size, check the
maxRequestLength attribute in the machine.config file.

a  Click the Attachments button ( u )-
The Attachments dialog box appears.
b Click Add.
The Open dialog box appeats.
¢ Navigate to a file, and click Open.
Click OK.
6 Click OK.

For more information, see Collaboration Note Editor dialog box - Option descriptions (on page
152).
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Collaboration notes

A collaboration note is a note that you attach to any study object, such as a project, study, study
element, study event, form, or item. A collaboration note is like an electronic sticky note in which
you include annotations, comments, messages, and file attachments. View the collaboration notes
that are attached to a study object and, optionally, to its children, in the Collaboration Notes
Browser.

When you create a collaboration note, you must choose a type on which to base it.

Collaboration note types

When you create a collaboration note, you choose a collaboration note type on which to base the
collaboration note. Administrators define collaboration note types in the Central Designer
Administrator application. Collaboration note types are used to identify the type and purpose of a
collaboration note. You can filter the view of collaboration notes in the Collaboration Notes Browser
according to type.

For example, an administrator might create a collaboration note type called Information to provide
important information about study objects in a study and a Usage note type to tell where a study
object can be used.

Collaboration Notes Browser

The Collaboration Notes Browser displays the collaboration notes that are attached to the study
object that is selected in the Project Explorer and, optionally, its child study objects.

In the Collaboration Notes Browser, you can:

e Create, view, sort, filter, and group collaboration notes.
e Modify and delete a collaboration note.

e Print one or more collaboration notes.

e  Select Show Children. You see all collaboration notes attached to the selected study object and
its children.

e Filter the collaboration notes that appear. For more information, see Filteting data in a grid
(on page 22).

By default, the browser is located at the bottom of the application window.

To open the Collaboration Notes Browser:

e  Select the View menu, and make sure Collaboration Notes is selected.

For more information, see Collaboration Notes Browser - Option descriptions (on page 152).
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About locking study objects

Determining whether a study object is locked

Only the user who holds the lock can modify a study object. The following types of locks are
available:

e An automatic lock, also known as an implicit lock, is applied to a study object when you modify
it and released when you save or close without saving.

¢ A requested lock, also known as an explicit lock, is applied to a study object when you explicitly
lock a study object and released only when you unlock the study object. You might request a
lock if you plan to work on a study object for an extended period of time.

To determine whether a study object is locked:
e In the Project Explorer, view the icon for the study object.
e Normal icons appear for unlocked study objects.
e Shaded icons appear for locked study objects.
e If the lock icon is green, you hold the lock.

e If the lock icon is red, someone else holds the lock. The tooltip for the study object has
the name of the user who holds the lock.

Note: The Modified property in the tooltip indicates whether you modified the
study object since the last time you saved it. If someone else holds the lock, the
property is set to False.

or

In the Properties Browser, check whether the Locked property is set to True or False.

Locking and unlocking a study object

You can lock and unlock a study object (study design, study element, study event, form, section,
item, codelist, and codelist item).

To explicitly lock a study object:
e In the Project Explorer, right-click a study object, and select Lock.

The study object is locked, and a green lock icon appears in the Project Explorer.

To unlock a study object:

Note: If you unlock a study object without saving, you are prompted to save changes, discard
changes, or cancel.

e In the Project Explorer, right-click a study object, and select Unlock.

The study object is unlocked, and the green icon in the Project Explorer is removed.
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Locking and unlocking a deployment instance
1 In the Project Explorer, select the Study Information Explorer bar.
2 Select the study.
3 Select the Deployment Setup tab.
4

To explicitly lock a deployment instance, right-click a deployment instance, and select Lock and
Protect > Lock.

5 To unlock a deployment instance that you explicitly locked, right-click a deployment instance,
and select Lock and Protect > Unlock.

Locking and unlocking an in-place revision object
1 In the Project Explorer, select the Visit Schedule Explorer bar.
2 Select the study design.
The Study Design Editor appears.
3 Select the IPR Summary tab.

4 To explicitly lock an in-place revision, right-click an in-place revision, and select Lock and Protect
> Lock.

5 To unlock an in-place revision that you explicitly locked, right-click an in-place revision, and
select Lock and Protect > Unlock.

Locking and unlocking a StudyAdministration object

1 In the Project Explorer, select the Study Information Explorer bar.

2 To explicitly lock a StudyAdministration object, right-click the Administration folder, and select
Lock.

3 To unlock a StudyAdministration object that you explicitly locked, right-click the Administration
folder, and select Unlock.

Note: When you lock and unlock the StudyAdministration object, the following objects are also
locked and unlocked: Sponsor, StudyConfiguration, ltemGroup, RightsGroup, QueryGroup, and
SignatureGroup.

Locking and unlocking a workflow rule
To explicitly lock a workflow rule:

1 In the Project Explorer, select a study design, study element, or study event.
2 Select the Workflow Diagram tab.

3 Right-click a workflow rule, and select Lock Rule.

Note: Workflow rules appear as diamond-shaped objects in the workflow.
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To unlock a workflow rule that you explicitly locked:
1 In the Project Explorer, select a study design, study element, or study event.
2 Select the Workflow Diagram tab.

3 Right-click a workflow rule, and select Unlock Rule.

Locking and unlocking a global condition
1 In the Project Explorer, select a study design, study element, or study event.
2 Select the Workflow Diagram tab.
3 On the toolbar, click Global Conditions.
The Edit Global Conditions dialog box appears.
4 To explicitly lock a global condition, right-click a global condition, and select Lock.

5 To unlock a global condition that you explicitly locked, right-click a global condition, and select
Unlock.

Locking and unlocking a data-entry rule

A lock is automatically applied when you begin editing a rule and is released when you save the rule.
If you want to work on a rule for an extended period of time, you can explicitly lock it to prevent
others from working on it.

1 In the Project Explorer, select the study object on which the data-entry rule is created.
2 Select the Rules tab.

3 To explicitly lock a data-entry rule, right-click the data-entry rule, and select Lock.

4

To unlock a data-entry rule that you explicitly locked, right-click the data-entry rule, and select
Unlock.

Revoking and transferring a lock on a study object

You can perform the following actions on a study object (study design, study element, study event,
form, section, item, codelist, and codelist item):

e Revoke someone else's lock on a study object.

e For a study object that you locked in another session, such as on another computer, transfer the
lock to your current session.

If a study object has a parent object that is locked by another user:
®  You cannot revoke the lock on the study object.

e If you revoke the lock on the parent object, remote locks on the parent object's children ate also
revoked.

Note: When you revoke a lock, any unsaved changes made by the person who holds the lock are
lost.
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To remove another user's lock on a study object:

1 In the Project Explorer, right-click a study object that someone else has locked, and select Revoke
Lock.

2 In the confirmation message, click Yes.
Any unsaved changes that the other user made are lost, and the lock is removed.

To transfer a lock from another session:

1 In the Project Explorer, right-click a study object that someone else has locked, and select
Transfer Lock.

2 In the confirmation message, click Yes.
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Working in a collaborative environment

Interacting with assigned tasks

Viewing all tasks assigned to you

You can view all tasks assigned to you in the Home Page in the Recent Tasks tab and the My Tasks
section.

e On the toolbar, click the Home Page button (@)

The Home Page appears. The Recent Tasks tab and the My Tasks section display tasks assigned
to you.

Accepting, unaccepting, completing, closing, and reopening a task

1 In the Project Explorer, select a study object (study design, study element, study event, form,
section, item, codelist, codelist item, mapping, data set, or data series).

2 In the Tasks Browser, select a task.
3 On the toolbat, click an action.
or
Double-click the task. In the Task Editor dialog box, click an action.

For more information, see Task Editor dialog box - Option descriptions (on page 155).
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Reusing study objects
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About projects, studies, and libraries

Characteristic Description

About projects Projects are containers used to hold study design building blocks. You
can create two types of projects:

e Study project—A project containing one or more studies that are
related to each other.

e Library project—A project containing a library.

Number of studies You can create one library in each library project. There is no limit on the

and libraries to create number of studies you can create in a study project. However, you might
experience performance degradation if you have multiple studies in a
single project, especially if the number of study objects is large.

Contents Studies and libraries contain the same types of study objects. A study
object is a study building block that appears in the Project Explorer.

Repository All study objects and components are stored in a single database instance
called the repository. The repository can be organized into multiple
libraries, each of which can be managed differently and can serve a
different purpose. For example, you can organize libraries by therapeutic
area or by team. Central Designer libraries store study objects for reuse
and help enforce standards.

A library project is a project containing a library. A library is a container
used to store related study objects and templates to be published for
reuse in studies or other libraries. A library provides a logical view of the
study objects in the repository.

A librarian creates libraries within library projects and then includes
resources from the repository or defines new resources within the library
itself.

If you have the appropriate rights (assigned in the Central Designer
Administrator application) and you are a member of the library team, you
can:

e  Create study objects and templates.

e  Publish study objects for other team members to use in study
designs.

e Search for study objects using categories and keywords.

Reuse Study objects that are created in libraries can be copied easily into
multiple studies. Additionally, study objects that are created and saved in
studies are available for reuse when copied directly from the repository.

Oracle® Health Sciences Central Designer 2.1.2



User Guide

Characteristic Description

System library Oracle recommends that you do not modify information in the System
Library. Instead, copy item types from the System Library to another
library, and modify information in the new library.

When you create an item, you can choose to base it on any of the types
in the libraries in the Library List, so make sure you add the new library
to the list. Optionally, if you do not want the item types in the System
Library to appear as options, you can remove the System Library from
the Library List.
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Library administration

The study objects and components that are used to design studies are stored in the repository. A
library is a container used to store related study objects and templates to be published for reuse in
studies or other libraries. A library provides a view of the study objects in the repository

To set up a library in which users can develop and publish study objects, you use the tabs of the
Library Editor in a library within a library project.

In the Library Editor, you define library properties, such as the supported locales and form layouts
for deployment, the users who can work in the library, and the functions and constants that can be
used when creating rules for study objects in the library.

Note: To define additional properties for a study object, consider using custom properties. In the
Central Designer Administrator application, an administrator creates custom properties and can
provide predefined values or allow Central Designer users to provide values. For more
information, see the Administrator Guide.

Creating a library

When you create a library, the Central Designer application creates a library project with the same
name by default. You can change the library project name when creating the library. Each library
project can have only one library.

1

Select File > New Library Project.
The New Library dialog box appeats.
Type a name and description.

In the Targets section, select the target applications for which you will create study objects in the
library.

To change the name of the associated library project, select the Library Project tab, and type a
name and description for the library project.

Click OK.

Opening and closing a study or library project

To open a study or library project:

64

In the Recent Projects List of the Home Page, double-click a study or library project.
or
a  Select File > Open, or press Ctrl+0.

The Open dialog box appears.

b  Optionally, in the Filter field, specify the text to use for filtering the list of study or library
projects.

The list of study or library projects changes to include only projects whose name or
description includes the specified text (not case-sensitive).
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¢ Optionally, in the Project Types field, select whether to show only study or only library
projects.

Note: To appear in the list of study and library projects, a project must match both the
text in the Filter field and the project type selected in the Project Types field.

d  Select a study or library project, and click Open.
To close a study or library project:
1 Select File > Close.

2 If prompted, confirm that you want to save changes.

Setting up library teams

Users Browser searches

To open the Users Browser:

e Select the View menu, and make sure Users is selected.

Characteristic Description

Use To find users and add them to:

e A study team (in a study project), which an administrator creates as a role
with a study scope in the Central Designer Administrator application.

e A library team (in a library project), which an administrator creates as a role
with a library scope in the Central Designer Administrator application.

Note: A user must be assigned to the corresponding role to be added to a team.

Location of the By default, the browser is located to the right in the application window.
Users Browser

Features You can:
e Create and save search criteria for personal or global use.

e  Open, close, delete, rename, and switch to different searches.

Required search  No required parameters.
parameters

Optional search  Use one, several, or none of the following:

patrameters
o Text

e (Categories
e Keywords

The asterisk (*), percent sign (%), and underscore (_) are wildcard operators,
which are inserted before and after text. For example, dem automatically
becomes *dem*. Use a comma as a delimiter.
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Characteristic Description

How the search is Text, keywords, categories, and libraries are connected with the AND operator.
performed Criteria within each parameter are connected with the OR operator. For
example:

e Text that you type
AND

e Keywordl OR Keyword2
AND

e Categoryl OR Category?2

Which User names, display names, titles, first names, and last names of:

information is )
e Active users

searched
e Inactive users
Note: You can add inactive but not terminated users to teams. View the status
of users in the Central Designer Administrator application.

Search results Users are listed in alphabetical order according to display name, with user names

in parentheses.

Finding and adding a user to a library team and saving the search

An administrator creates library teams as library roles in the Central Designer Administrator
application. A user must be assigned to the corresponding role to be added to a team.

For example, if a user is assigned to the Librarian library role in the Central Designer Administrator
application, the user must be a member of the Librarian library team for a library (in the Central
Designer application) to work in the library. You assign users to roles in the Central Designer
Administrator application and to study and library teams in the Central Designer application. You
assign a user to a library team for the selected library only.

Note: To view all users, click Find without entering parameters. Depending on the size of the
repository, this search might take several minutes.

To add a user to a library team:

1 Open alibrary project and select the library containing the team to which you want to add a user.
2 Select the Users Browser.
3 Optionally, to name the search:
a  Select Actions > New Search. The Actions menu is located at the top of the browser.
The New search dialog box appears.
b  Type a name for the search, and click OK.
The name of the search appears on a tab to the right of the browser.

4 In the Enter search text ficld, type text that appears in the user's name or display name, title, first
name, or last name.
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5 To include categories and keywords (on page 74) as parameters, click the down arrows button

( %) next to the Search Filter, and then:
e Optionally, select the Categories tab, and select one or more categoties.
e  Optionally, select the Keywords tab, and select one or more keywords.
The parameters you select appear in the field below the Search Filter.

6 Click Find.

The Central Designer application performs a search based on your search criteria. For more
information about how searches work, see Users Browser searches (on page 65).

7 In the Project Explorer, select the Library Information Explorer bar.
8 Select the library.
9  Select the Teams tab.

All teams created in the library scope in the Central Designer Administrator application appear in
the workspace.

10 In the [Study name] - Teams section, select a team.
The name of the team appears above the right section on the tab.
11 In the Users Browser, select a user, and drag the user to the right section.

The user is added to the team. You can add the user to more teams or add different users to
teams.

Note: You can also add a user to a team by dragging the user directly to the team name in
the left section.

Note: The user that you added must log out and log on again to have the privileges
associated with the team.

To save the search:

1 Select Actions > Save Search to Repository. The Actions menu is located at the top of the browser.
The Save Search to Repository dialog box appears.

2 Optionally, type a description for the search.

3 Select an option:
¢ Just me—Only you can see and use the search.

¢ Everyone—Everyone can see and use the search.

4 Click Save.

Opening a search saved in the repository

All saved searches are stored in the repository, which contains all data created and saved in the
application.

1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search).

2 Select Actions > Open Search from Repository. The Actions menu is located at the top of the
browser.
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The Open Search from Repository dialog box appears.
3 Select a search, and click Open.

The search opens. A tab with the name of the search appears to the right of the browser.

Clearing search parameters

Note: If you clear the parameters of a saved search but do not save after clearing, the search is
saved with parameters.

e In the Libraries Browser or Users Browser, click Clear Search, which is located at the top of the
browser.

The following information is cleared:
e Text in the Enter search text field.
e Sclected categories and keywords.

e Selected libraries (in the Libraries Browser only).

Closing an active search

All saved searches are stored in the repository, which contains all data created and saved in the
application. If you close a saved search, the search is removed from your view but is not deleted.

1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search).
2 Select a tab. Tabs are located along the right side of the browser.
3 Select Actions > Close Active Search. The Actions menu is located at the top of the browser.

The search is closed. If it is a saved search, it remains in the repository. If it is not saved, it is
removed and cannot be reopened.

Deleting a search from the repository
1 Select either the Libraries Browser (for a study object search) or Users Browser (for a user search).

2 Select Actions > Delete Search from Repository. The Actions menu is located at the top of the
browser.

The Delete Search from Repository dialog box appears.

3 Select a search, and click Delete.

Removing a user from a study or library team
1 In a study, select the Study Information Explorer bar.
or
In a library, select the Library Information Explorer bar.
2 Select the study or library.
3 Select the Teams tab.

4 In the left section, right-click the user, and select Remove from Team.
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Library security

Access to a library is determined by the following library security features.

Security feature Where to perform Description

Assign rights and  Central Designer Libraries contain published and unpublished

roles (in the Administrator resources for reuse within studies. The libratian

Administrator Guide) manages the users who are granted access to a
library.

Assign users to Library An administrator must add you to a library study

Libraty teams (on team before you can create or modify objects in

page 606) that library.

Enable and disable Library Libraries are enabled (or made accessible to other

a library (on page 70) users) by default. The librarian can enable or

disable the library at any time. For example, a
librarian might disable a library to create and
organize its resources before making the library
visible to other users. When the library is ready for
use, the librarian enables it.

Note: You cannot search a disabled library.

Publish library Library You must publish a study object that was created
objects (on page 72) in a library to allow other users to search for it in
the Libraries Browser.

Create a library list  Study You can search only libraries that appear in a

(in the InForm Design study's library list for study objects to include in
Guide) the study.

Protect and Study or library e You can:

unprotect study , , . o
objects (on page 70) e Protect study objects in studies and libraries to

prevent users from making changes.

e If you protect a study object, all of its children
are also protected.

e Protect an entire study or library.
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70

Disabling and enabling a library

You can disable a library to:

e Prevent users from using library resources while you are working on them.

e Close a library that you no longer use.

Members of a library team can work in a disabled library if they have the necessary rights. However:
e Study administrators cannot add the library to the Library List for a study.

e Study designers cannot search for study objects in the library, even if it is already in the Library
List for the study.

To disable or enable a library:

1 In the Project Explorer, select the Library Information Explorer bar.

2 Right-click a library, and select or deselect Enable Library.

Protecting and unprotecting a library

To protect a library:

1 In the Project Explorer, select the Library Information Explorer bar.
2 Right-click the library and select Protect.
The selected library and all of the study objects within the library are protected.

The icons to the left of the library and all of the study objects within the library change to reflect
a protected status.

Note: You cannot delete study objects that are the direct children of a protected study object.
After you protect a study object, you cannot select Undo, but you can select Unprotect.

To unprotect a library:
1 In the Project Explorer, select the Library Information Explorer bar.
2 Right-click the library and select Unprotect.

The selected library is unprotected.

The icon to the left of the library changes to reflect an unprotected status.

Note: Unprotecting a library or a study object in a library does not affect study objects that you
copied from the library into a study.

Oracle® Health Sciences Central Designer 2.1.2




User Guide

Publishing, republishing, and unpublishing

About publishing, republishing, and unpublishing

You must publish study objects that were created in a library to allow users to search for them in the
Libraries Browser. You can publish, republish, and unpublish study objects only in a library. You
must save a study object before you publish or republish it.

In a library, you can publish any of the following.

What to publish ‘ Notes

A single study object. When you publish a study object, you publish its
most recent version or revision.

A study object and its child study objects. When you publish a form and its children,

sections on the form are also published.

e  Publishing child study objects is not supported
for mappings.

e If you modify a study object or one of its
children, you can use the republish option to
publish the study object and its children again.

e If you copy a study object with child study
objects from the Libraries Browser to a study or
library, the child study objects ate also copied,
regardless of whether they are published.

All study objects.

Note: To prevent users from finding study objects using the Libraries Browser, unpublish the study
objects.
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72

Guidelines for publishing, republishing, and unpublishing

Publish and reuse study objects at the highest-level study object that makes sense. For example,
consider publishing and reusing forms rather than individual items, unless you specifically need

individual items to be available in a library. A reused form can save you more time than a reused
item.

Where possible, consider publishing and reusing study events and study elements rather than
forms.

Consider publishing codelists and codelist items so they can be shared and reused.

If you copy a study object in a library to another library and link to the study object and its
children, when you modify the study object in one library, you cannot subsequently publish it in
the library into which it is copied. To publish a study object that you modified in one library and
linked to in another library, you must delete the linked study object and create a new link to the
modified study object.

For more information, sece Results of adding study objects to studies and libtraties from the
Libraries Browser (on page 84).

Workflows and published study objects

You can develop study workflows in either a study or a library, and you can use study objects found

in a Libraries Browser search to define a workflow in a study in the following ways:

Adding a published study object to a workflow—You can drag a published study object from
the Libraries Browser to a workflow tab in a study (for example, you can drag a published study
event to the Workflow Diagram tab in the Study Editor or Study Element Editor). When you do
this, the study object from the Libraries Browser is added to the workflow in the study.

Replacing a published study object in a workflow—You can drag a published study object
from the Libraries Browser onto a study object in a study (for example, you can drag a published
form from the Libraries Browser and drop it onto a form object in the Workflow Diagram tab in
the Study Event Editor of a study). When you do this, the study object from the Libraries
Browser replaces the definition of the study object. This method enables you to create an outline
of a study workflow without defining the properties of the study objects and then to replace the
placeholder study objects with fully defined, published study objects.

Publishing, unpublishing, and republishing a study object

Publishing a study object (a study element, study event, form, section, item, codelist, and codelist
item) created in a library makes it available for copying into a study. Unpublishing a study object
makes it unavailable for future copying unless you republish it.

To publish or republish a study object (with or without child study objects):

1
2

3

In a library project, save the study object that you want to publish or republish.
In the Project Explorer, right-click a study object, and:

e To publish—Select Publishing > Publish.

e To republish—Select Publishing > Republish.

If prompted, confirm whether to publish or republish the child study objects.
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To publish or republish all study objects in a library:
1  Select File > Save Project.
2 Do one of the following:
e To publish—In the Project Explorer, right-click a library, and select Publish Study > Publish.

e To republish—In the Project Explorer, right-click a library, and select Publish Study >
Republish.

To unpublish a study object (with or without child study objects):

1 In the Project Explorer of a library project, right-click a study object, and select Publishing >
Unpublish.

2 If prompted, confirm whether to unpublish the child study objects.

To unpublish all study objects in a library:

e In the Project Explorer of a library project, right-click a library, and select Publish Study >
Unpublish.

Publishing a template

After creating or modifying a template, you must do the following to make your changes available:

e For study project templates and study templates, save the template.

e  For all other study object templates, save and publish the template at any time. Your changes are
not available to others until you publish the template.

1 Open alibrary project.
2 In the Project Explorer for a library, select the Types and Templates Explorer bar.

3 Expand the Templates folder, and expand the folder for the type of study object (for example, the
Study Events folder).

4 Right-click the template, and select Publish.

Publishing a type

After you create or modify a type, save and publish the type. Your changes are not available to others
until you publish the type.

1 Open alibrary project.
2 In the Project Explorer for a library, select the Types and Templates Explorer bar.

3 Right-click a type, and select Publish.
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Categorizing study objects

Categorization of study objects

You can categorize a study object with keywords and categories to facilitate searching for study
objects in the Libraries Browser. You must save a study object before categorizing it.

Usefulness of categorization

Categories and keywords are especially helpful in libraries with many study objects. When study
objects are categorized, you can find a study object by selecting categories or keywords when you
search rather than scanning study objects in the search results list.

Types of keywords and categories

The following keywords and categories are available.

Type of keyword or category Location in

Libraries Browser

System keywords are keywords that are installed by default with the Central =~ Keywords tab >
Designer application or that an administrator creates in the Central Designer ~ System list
Administrator application.

User keywords are keywords that a Central Designer user creates. Keywords tab >

User list
You cannot view keywords that other users create, and other users cannot

view your user keywords.

Automatically generated categoties ate categories that automatically catalog  Categories tab >

study objects by auditing information (for example, the study object type, Automatically

original author, creation date, and library in which the study object was Generated tree

created).

Manually generated categoties ate categories that you create by dragging Categories tab >

keywords to the Categories tree. Manually Generated
tree

All study objects are categorized in the following way:

e Ina study: [Study Project Name] > Study > [Study Namel].
e In alibrary: [Library Project Name] > Library > [Library Name].

The categorization information appears below a Project category. When you change the name of a
project, library, or study, the corresponding category is automatically updated.

When to categorize

If you have a categorization plan, consider categorizing study objects as you create them. If you
expect your categorization plan to change, consider categorizing study objects after creating most of
them.

Note: You can categorize multiple study objects at once in study object container editors.
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Example

In the following example, cardiology appears as a category. The categories of heart, arteries, and
veins appear below cardiology, and cardiology also appears below the therapeutic area category.

You can search for a study object that has been categorized with cardiology:
e No matter where cardiology appears in the Categories tree.
e  When cardiology appears only under therapeutic area.

¢  When cardiology appears with arteries, heart, and veins below it.

i arteries

El therapeutic area
i cardiology

Categorizing a study object

You categorize a study object (study design, study element, study event, form, section, item, codelist,
and codelist item) with keywords and categories to facilitate searching for study objects in the
Libraries Browser.

1 In the Project Explorer, right-click a study object, and select Categorize.
The Categorize dialog box appears.

2 Optionally, select one or more the categories on the Categories tab.

Note: If you select a category, all child categories beneath it are also selected.

3 Click Next, or select the Keywords tab.
The Keywords tab appears.

a  Optionally, select the keywords from the list of system keywords or the list of user-defined
keywords.

b To create a keyword, type the keyword in the Keywords field, and press Enter. Separate
multiple keywords with a comma.

The keyword is added to the list of User keywords.
4 Click Apply.
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Finding and using study objects in a library

Searching for study objects

Libraries Browser searches

To open the Libraries Browser:

e  Select the View menu, and make sure Libraries is selected.

Libraries Browser
searches

Use

To find items, forms, and other study objects in a study or library, and then
copy the study objects into a study or library.

Location of the
Libraries Browser

By default, the browser is located to the right in the application window.

Features

Create and save search criteria for personal or global use.

Open, close, delete, rename, and switch to different searches.

Required search
parameters

In a study project, you must select at least one library.

In a library project, selecting a library is optional.

Optional search
parameters

Use one, several, or none of the following:

Text
Categories
Keywords

Libraries

Note: You can select libraries in study projects only. Choose from the
libraries in the Libraries tab.

The asterisk (*), percent sign (%), and underscore (_) are wildcard operators,
which are inserted before and after text. For example, dem automatically
becomes *dem*. Use a comma as a delimiter.

76
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Libraries Browser

searches

How the search is Text, keywords, categories, and libraries are connected with the AND
performed operator. Criteria within each parameter are connected with the OR operator.
For example:

e Text that you type
AND

e Keywordl OR Keyword2
AND

e Categoryl OR Category?2
AND

e Libraryl OR Library2
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Libraries Browser

searches

Information thatis  Titles, RefNames, and descriptions of:

searched
e  Study elements and study events.

e FPorms and items.

e Codelists and codelist items.

e Mappings.

Titles and RefNames of:

e Templates and types.

RefNames of:

e Functions.

e Constants.

Additionally:

¢ In a study project
e In selected libraries, only published study objects are searched.
e In libraries you do not select, no study objects are searched.
e  Studies are not searched.

For more information about publishing, see Publishing, republishing,
and unpublishing (on page 71).

e In alibrary project

e In selected libraries, only published study objects are searched, unless
you select Include latest object revisions in Repository.

If you select Include latest object revisions in Repository:

e The /atest revisions of study objects in libraries are searched.
e _A//study objects in all studies are searched.

If you leave the checkbox unselected, studies are not searched.

e Inlibraries you do not select, only the latest revisions of study
objects are searched.

Note: The Include latest object revisions in Repository checkbox is available in
the Search Filter section only in a library project.
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Libraries Browser
searches

Search results e In a study project

e Results include only published study objects, which appear below the
Objects Found container and are organized by library.

e In alibrary project

Study objects are grouped according to whether they are the published
versions or the latest revisions.

e Below the Objects Found container, published study objects are
organized by library and then study object type, such as form or
item.

e If you select Include latest object revisions in Repository, the Repository
container appears below all library containers and holds the latest
revisions of study objects, organized by study or library and then
study object type, such as form or item.

e If the published version of a study object is different from the
latest revision, the study object appears in two places—in the
container for the library that holds it (for the published version),
and below the Repository container (for the latest revision).

e If the latest revision is the same as the published version, the
study object appears as a published study object, in the top
section, organized by library.

Study objects appear as follows:

Title (RefName): Description

Copied study If you copy a study object with child study objects from the Libraries
objects Browser to a study or library, the child study objects are also copied,
regardless of whether they are published.

When you drag a study object that is in a library from the Libraries Browser
to another library, you are prompted to choose whether you want to link to
the existing study object and its children or create new copies of the study
object and its children.

When you drag a study object that is in a library from the Libraries Browser
to a study, or drag a study object that is in a study from the Libraries Browser
to a library, new copies of the study object and its children are created.

When you copy a template from the Libraries Browser, a study object
without a link to the template is created.
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About searching for a template or type

To create a study object from a template, find the template in the Libraries Browser and copy it to a
study. To narrow your Libraries Browser search, you can select categories that limit the search.

You can select one or more of the following categories, which are automatically applied to templates
and types, to narrow your search.

Category type k\/here the categories appear in the Categories tab of the Libraries
Browser

Template categories Template categories appear below Automatically Generated > Template.

Type categories Type categories appear below Automatically Generated > Types:

e Item—User-created items and System Library types, including Integer
Item, Text Item, Float Item, Compound Item, and Date Time Item.

e Primitive Type—Items that are installed with the Central Designer
application, including Integer Variable, Text Variable, Float Variable,
Compound Variable, and Date Time Variable.

Finding and adding a study object to a study or library and saving the
search

In a library, you can create, save, and publish study objects, and then use the Libraries Browser to
copy them into studies or other libraries. You can also copy study objects created in studies into
libraries.

To search using the Libraries Browser, select a library, study, or study object in the Project Explorer.

Note: To view all results, search without entering criteria. Depending on the size of the repository,
this search might take several minutes.

To add a study object to a study or library from the Libraries Browser:

1 Open a study or library.
2 In the Project Explorer, select any study object except the library project or study project.
3 Select the Libraries Browser.
4 Optionally, to name the search:
a  Select Actions > New Search. The Actions menu is located at the top of the browser.
The New search dialog box appears.
b  Type a name for the search, and click OK.
The name of the search appears on a tab to the right of the browser.

5 To search by title, RefName, or description of the study object, type text in the Enter search text
field.
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6 To include categories, keywords, and libraries as parameters:

a  Click the double down arrows ( ¥) next to the Search Filter.
b  Optionally, select the Categories tab, and select one or motre categories.

¢ Optionally, select the Keywords tab, and select one or more keywords. For more information
about categories and keywords, see Categorization of study objects (on page 74).

d Ifyou are in a study project, select the Libraries tab, and select the libraries to search. You
must select at least one library. This step is optional if you are in a library project.

The parameters you select appear in the field below the Search Filter.
7 Click Find.

The Central Designer application performs a search based on your search criteria.

For more information about how searches work, see Libraries Browser searches (on page 76).
8 Make sure the Project Explorer is selected.
9  From the Libraries Browser, do one of the following:

¢ To add the study object to a parent (for example, add an item to a form)—Drag the study
object to the parent study object.

¢ To add the study object outside the hierarchy of the study (available in a library)—Drag
the study object to the folder for the study object. For example, drag a study event to the
Events folder.

The result depends on the type of project to which you added the study object. For more
information, see Results of adding study objects to studies and libraties from the Libraties
Browser (on page 84).

Note: Study objects are added to the bottom of the list of child study objects under the
parent.

To save the search:

1 Select Actions > Save Search to Repository. The Actions menu is located at the top of the browser.
The Save Search to Repository dialog box appears.

2 Optionally, type a description for the search.

3 Select an option:
e Just me—Only you can see and use the search.

e Everyone—Everyone can see and use the search.

4 Click Save.
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Clearing search parameters

Note: If you clear the parameters of a saved search but do not save after clearing, the search is
saved with parameters.

In the Libraries Browser ot Users Browser, click Clear Search, which is located at the top of the
browset.

The following information is cleared:
e Textin the Enter search text field.
e Selected categories and keywords.

e Sclected libraries (in the Libraries Browser only).

Closing an active search

All saved searches are stored in the repository, which contains all data created and saved in the
application. If you close a saved search, the search is removed from your view but is not deleted.

1
2
3

Ope

Select either the Libraries Browser (for a study object search) or Users Browser (for a user search).
Select a tab. Tabs are located along the right side of the browser.
Select Actions > Close Active Search. The Actions menu is located at the top of the browser.

The search is closed. If it is a saved search, it remains in the repository. If it is not saved, it is
removed and cannot be reopened.

ning a search saved in the repository

All saved searches are stored in the repository, which contains all data created and saved in the

application.

1
2

Select either the Libraries Browser (for a study object search) or Users Browser (for a user search).

Select Actions > Open Search from Repository. The Actions menu is located at the top of the
browser.

The Open Search from Repository dialog box appears.
Select a search, and click Open.

The search opens. A tab with the name of the search appears to the right of the browser.

Deleting a search from the repository

1
2

Select either the Libraries Browser (for a study object search) or Users Browser (for a user search).

Select Actions > Delete Search from Repository. The Actions menu is located at the top of the
browser.

The Delete Search from Repository dialog box appears.

Select a search, and click Delete.
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Reusing study objects

About reusing an item on a form

You can reuse an item on a form as long as the item's reuse does not create identical context paths
for the item. A context path is created with only the visit, form, section, and top-level item, even if
the top-level item has child items or has items that are conditional on it. For instance, consider the
following hierarchies in the Central Designer application and InForm application:

Hierarchy in the Central Designer Becomes the following in the InForm

application application

Study event > Form or section > Visit > Form > Section >

Ttem 1 Ttem 1

Item 2 (conditional on Item 1) Item 2 (Conditional on Item 1)

Item 3 (Compound item, conditional on Item Item 3 (Conditional on Item 2)

2) Item 4 (Has a rule, conditional on
Item 4 (Has a rule, conditional on Item 3) Item 3)

Item 4 (Has a rule, conditional on Item 1) Item 4 (Has a rule, conditional on Item 1)

In this example, using Item 4 in two places creates the following identical context paths, causing
validation to fail. The context paths appear below in bold; the non-bold information is the additional
information that makes the item's placement unique but, that information is not visible to the Central
Designer application when it tries to determine when rules run:

e Visit > Form > Section > Item 1 > Item 2 > Item 3 > Item 4

e Visit > Form > Section > Item 1 > Item 4

If Item 4 were not conditional on Item 1, you could reuse the item without issues because the
hierarchy would appear in the following way:

Hierarchy in the Central Designer Becomes the following in the InForm

application application

Study event > Form > Section (optional) > Visit > Form > Section >

Item 1 Item 1

Item 2 (conditional on Item 1) Item 2 (Conditional on Item 1)

Item 3 (Compound item, conditional on Item Item 3 (Conditional on Item 2)

2) Item 4 (Has a rule, conditional on
Item 4 (Has a rule, conditional on Item 3) Item 3)

Item 4 (Has a rule) Item 4 (Has a rule)
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In this example, the following context paths would exist for Item 4. Because the information in the
context paths is unique down to the first-level item, the reuse is acceptable.

e Visit > Form > Section > Item 1 > Item 2 > Item 3 > Item 4

e Visit > Form > Section > Item 4

Results of adding study objects to studies and libraries from the Libraries
Browser

The following table describes the results of searching for a study object in the Libraries Browser and
then adding it to a library or study.

Note: In the following sections, the library or study that contains the study object is the source
location. The library or study to which you are adding a study object is the target location.

Process Results of adding the study object

Library to library ~ You are prompted to choose one:

(The study objectis e  Link to the existing study object and its children.
in a library, and
you are adding the
study object to a
library.)

The study object and its children are added to the target location as links.
Each study object is a single study object that exists in multiple libraries. If
you change a study object in either library, the change is reflected in the
other library.

=  Object ancestry links are maintained by object ID, not RefName. If
an object is dropped from a library into a study and then the library
object is replaced in the library, the next time the object is dropped
into the study, a new object is created in the study; the existing object
is not updated.

®  When you modify the study object in one library, you cannot
subsequently publish it in the library into which it is copied. To
publish a study object that you modified in one library and linked to
in another library, you must delete the linked study object and create a
new link to the modified study object.

e Copy the study object and its children to the target location.

If the study object or any of the child objects have already been copied
into the target location, new copies of the study objects are not created.
The existing study objects ate referenced correctly by other study objects
that are copied in.

For the study object or any children that have not been copied into the
target location, new copies are created.

If you change a study object in either library, the study object in the other
libraty is not updated.
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Process Results of adding the study object

Library to study Copies of the study object and its children are created in the target location. If
you change a study object in either the target or original location, the study

he study object i
(The study object is object in the other location is not updated.

in a library, and
you are adding the Because two study objects in a study cannot have the same RefName, the
study object to a Central Designer application renames study objects in a study when you:
study.

¥) e Drag a study object from a library to a study, and its RefName is identical
of to an existing study object in the study.
Study to library e Use the Copy > With Children and the Copy > Without Children options.

(The study objectis yyphen 5 study object is renamed, it is appended with "_1" (or similar).
in a study, and you

are adding the Note: Study object names in a library might not be unique. Additionally, a
study object to a study object can appear in multiple places in a study if it is copied using the
library.) Copy > Link option.

Note: If you drag and drop a study object that is mapped to a data series, and
the study object already exists in the libraty, the database contains a data point
for the study object, and the drop operation reuses that data point as is. The
application warns you that the drag and drop operation is not supported. If
you continue, any data mappings in the dropped study object that are different
from the data mappings that are associated with the study object that already
exists in the library are removed.

Note: You cannot have duplicate RefNames in a study. Duplicate RefNames are allowed in a
library with the following exceptions:

e All children of a study object must have unique RefNames. For example, a form can contain
only one item with the RefName of Item1. However, a library can contain multiple study objects
with the RefName of Item1.

e Below any given parent, such as a study event, all child study objects must have unique names.
For example, a library cannot contain two nonlinked items named Weight on two forms that are
on the same study event.

Note: A linked item can appear on two forms in the same study event.
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Results of modifying study objects that have been copied to studies and
libraries

The following table describes the results of modifying a study object after you drag the study object
from the Libraries Browser to a study or library.

Note: In the following sections, the library or study that contains the study object is the source
location. The library or study to which you are adding a study object is the target location.

Action Result Example

After you add a study object from a
library to a library using the
Libraries Browser:

If you modify the study object or one  You are prompted to choose After you add a form from
of its children in the source location  one of the following: LibraryA to LibraryB using

and drag the modified study object the Libraries Browser, if you
e Update the study object

objects to the target location: ) .
in the target location.

modify the form or one of
its items in LibraryA and

If you choose this drag the modified form or
option, the study object item to LibraryB, you are
and any modified prompted to choose one of

children are updated, but the options described above.
unchanged study objects
are not updated.

o Create a link to the
updated study object
and its children in the
target location.

If you choose this
option, a new RefName
is created for the study
object in the target
location.

If you modify the study objectin the ~ You are prompted to choose After you add a form from
target location and then drag the study one of the following: LibraryA to LibraryB using

object to the source location: the Libraries Browser, if you
e Update the study object

) ) modify the form in LibraryB
in the source location.

and then drag the form to

e (Create a link to the LibraryA, you are prompted

modified study object. ~ t© choose one of the
options described above.

After you add a study object from a
library to a study or from a study to
a library using the Libraries
Browser:
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Action

If you create a new study object in the
target location and drag a child of the
original study object to the new study
object:

Result

The two child study objects
in the target location are
automatically linked.

Example

After you add FormA from
a library to a study using the
Libraries Browsert, if you
create FormB in the study
and drag ItemA (a child of
FormA) to FormB using the
Libraries Browser, [temA on
FormA and ItemA on
FormB are automatically
linked in the study.

If you modify the original study object
in the source location and then drag it
to the same parent in the target
location:

You are prompted with the
following two options:

e Update the study object
and its children in the
target location.

The study object and
any modified children
are updated to the study
object that you
previously added.
Unchanged study
objects are not updated.

e Cancel adding the
original study object and
its children to the target
location.

After you add FormA from
a library to EventA in a
study using the Libraries
Browser, if you modify
FormA in the library and
then drag it again to EventA
in the study, you are
prompted to choose one of
the options described above.

If you modify the original study object
in the source location and then drag it
to a different parent (that does not

already contain the study object) in the ®

target location:
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You are prompted with the
following two options:

Update the study object
and its children in the
target location.

The study object and
any modified children
are linked to the study
object in the target
location, and the study
object in the target
location is updated.

e Cancel adding the
original study object and
its children to the target
location.

After you add FormA from
a library to EventA in a
study using the Libraries
Browser, if you modify
FormA in the library and
then drag it to EventB
(which does not yet contain
FormA), you are prompted
with the options described
above.
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Action Result Example

If you modify one or more children of You are prompted with the — After you add FormA from
the study object in the source location following two options: a library to a study using the
and then drag the study object to the Libraries Browser, if you

e Update the children in

) modify one or more items
the target location.

on FormA in the library and

The child study objects ~ then copy FormA to the
that were modified are  study again, you are

updated in the target prompted with the options
location. described above.

target location:

e Cancel adding the
original study object and
its children to the target

location.
If you drag the study object that you  You receive a message After you add FormA from
already added to the same parent in indicating that the study a library to a study using the
the target location: object cannot be added to Libraries Browser, if you

the same parent more than  have not modified FormA

once if the study object has  and try to add FormA to the

not been updated. study again using the
Libraries Browser, a
message appears, indicating
that the study object cannot
be added to the parent more
than once if the study object
has not been updated.

Notes:

If you create a study object in the source location, add it to a target location, and then drag the
study object back to the source location without modifying the study object in the target location,
you are asked if you want to update the study object.

For example, if you create a study object in LocationA (either a study or library), copy it to
LocationB (either a study or library), and then drag the study object from LocationB back to
LocationA without modifying it in LocationB, you are asked if you want to overwrite the study
object in LocationA or cancel. If you updated the study object in LocationA and you choose to
overwrite, you lose the changes when the study object from LocationB is added to LocationA.

If you add a study object to a study from a library, copy and paste the study object within the
study, and then add the study object from the library to the study again, none of the copies is
updated.

The RefNames of study objects are never updated when a study object is updated.

You cannot use the Libraries Browser to create multiple copies of a study object within a target
location. Use the Copy option to create multiple copies of a study object within a study or library.

To determine whether a study object is a link or a copy of another study object, check the
Identifier field in the Properties Browser. If the identifiers are identical, the study objects are links;
otherwise, they are copies.
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Results of adding templates to studies and libraries

The children of templates are treated like regular study objects unless they are also marked as
templates. For example, if you add a codelist template from a library to two different items in
another library, the codelist items are links as long as they are not marked as templates.

You can add study objects to a study template using the Libraries Browser. If you copy a study object
from a library to a study template and then create a study from the study template, the study objects
in the study are linked to the original study objects in the library.
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Copying, cutting, and pasting

When you copy and paste a study object (on page 91), all of its child study objects ate copied with
it. The method of copying that you choose determines whether the new study object and new child
study objects retain links to the original study objects.

When you copy a study object into a study twice, the two study objects are links to each other.

You can cut linked study objects but not instances of study objects. Cutting a link is the same as
deleting the link to (but not the instance of) the study object. After cutting, you must paste the link
on the correct parent study object. For example, you can cut an item that is on a form and then paste
it on another form.

The following copying options are available.

Copying option Description

Link e The new study object retains a link to the original. If either the original
or the new study object is modified, the other study object is modified,
and all other reference copies of it within the study are also modified.

e All child study objects are copied with links to the original study objects.

With children e The new study object has no link to the original. If either the original or
the new study object is modified, the other study object is not affected.

e All child study objects are also copied and do not retain links to the
original study objects. Therefore, a change to either the original or new
child study objects does not affect the other.

Without children e The new study object has no link to the original. If either the original or
the new study object is modified, the other study object is not affected.

e All child study objects are copied with links to the original study objects.
Therefore, if cither an original or a new child study object is modified,
the other study object is modified, and all other reference copies of it
within the study are also modified.

Note: Advanced copying options (Link, With children, and Without children) are not available for
codelist items. When you copy a codelist item, a copy of the original codelist item is created with
a new identifier.
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Renamed RefNames

Because two study objects in a study cannot have the same RefName, the Central Designer
application renames study objects in a study when you:

e Drag a study object from a library to a study, and its RefName is identical to an existing study
object in the study.

e Use the Copy > With Children and the Copy > Without Children options.

When a study object is renamed, it is appended with "_1" (or similar).

Note: Study object names in a library might not be unique. Additionally, a study object can appear
in multiple places in a study if it is copied using the Copy > Link option.

Copying and pasting a study object

1 In the Project Explorer, right-click a study object and select Copy. Select one of the following
copying options from the menu that appears:

Link: (Not available for study elements and study events)

e The new study object retains a link to the original. If either the original or the new study
object is modified, the other study object is modified, and all other reference copies of it
within the study are also modified.

e All child study objects are copied with links to the original study objects. Therefore, if either
an original or a new child study object is modified, the other study object is modified, and all
other reference copies of it within the study are also modified.

With children:

e The new study object has no link to the original. If either the original or the new study
object is modified, the other study object is not affected.

e All child study objects are also copied and do not retain links to the original study objects.
Therefore, a change to either the original or new child study objects does not affect the
other.

Without children:

e The new study object has no link to the original. If either the original or the new study
object is modified, the other study object is not affected.

e All child study objects are copied with links to the original study objects. Therefore, if either
an original or a new child study object is modified, the other study object is modified, and all
other reference copies of it within the study are also modified.

2 In the Project Explorer, right-click a parent study object, and then select Paste.

Note: You cannot copy study objects as links from one study to another within the same
study project.

When you copy a template from the Libraries Browser, a study object without a link to the template
is created.
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Dragging and dropping study objects
You can drag and drop a study object in the Project Explorer to copy a study object as a link.

When you drag a study object that is in a library from the Libraries Browser to another library, you
are prompted to choose whether you want to link to the existing study object and its children or
create new copies of the study object and its children.

When you drag a study object that is in a library from the Libraries Browser to a study, or drag a
study object that is in a study from the Libraries Browser to a library, new copies of the study object
and its children are created.

Note: Before you copy a study object by dragging and dropping it, you must first navigate to the
Explorer bar and folder in which the target study object exists.

The following table describes the target study objects onto which you can copy each study object
type.

Study object Location of available target study objects

Study element Visit Schedule Explorer bar > Study Design folder.

Study event e  Visit Schedule Explorer bar > Study Design folder > Element name.
or

e Elements and Events Explorer bar > Elements folder > Element name.

Form Elements and Events Explorer bar > Events folder > Event name.

Ttems e Forms and Transactions Explorer bar > Target application folder > Forms
folder > Form name.

or

e TForms and Transactions Explorer bar > Target application folder > Forms
folder > Non-Clinical folder > Form name.

Codelist Items Explorer bar > InForm items folder > Item name.
Notes:
For the item, the Use Codelist option must be selected.

The codelist must match the type of the item. For example, you can drag an
integer codelist only to an integer item.
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Cutting and pasting a study object

You can cut linked study objects but not instances of study objects.

1

In the Project Explorer, right-click a study object, and select Cut.
The study object is removed from the Project Explorer.
Right-click a parent study object (such as a form, if you cut an item), and select Paste.

The study object appears under its parent study object in the Project Explorer.

Copying and moving data-entry rules

To copy and paste a data-entry rule:

1

[ N T N \ S

In the Project Explorer, select a study design (in a study only), study element, study event, form,
section, or item.

The editor for the study object appears in the workspace.

Select the Rules tab.

In the grid, select a rule.

Right-click the rule, and select Copy.

In the Project Explorer, select a study object onto which to copy the rule.
Right-click the study object and select Paste.

The pasted data-entry rule appears in the grid, and the row containing the pasted data-entry rule
is selected.

Note: You can also copy and paste a data-entry rule by holding down the Ctrl key, dragging the
rule from the Rules tab, and dropping it onto a study object.

To move a data-entry rule:

1

5

In the Project Explorer, select a study design (in a study only), study element, study event, form,
section, or item.

The editor for the study object appears in the workspace.
Select the Rules tab.

In the grid, select a rule.

Right-click the rule, and select Cut.

The data-entry rule is grayed out.

Note: When you select Cut, the data-entry rule is not immediately deleted from its parent
study object. The rule is only deleted when you paste it onto another study object. If you do
not paste a cut rule, it remains associated with its original parent study object. This
behavior is different from the cut and paste functionality that is used when you move a
study object in the Project Explorer. In the Project Explorer, when you cut a study object, it is
immediately deleted from its parent study object.

In the Project Explorert, select a study object.
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6 Right-click the study object and select Paste.

The data-entry rule is removed from the original study object on which it was created, the pasted
data-entry rule appears in the grid, and the row containing the pasted data-entry rule is selected.

Note: You can also move a data-entry rule by dragging the rule from the Rules tab, and dropping it

onto a study object without holding down the Ctrl key.

About copying study objects grouped by data mappings

94

The following table explains how study objects are copied when they are part of a data mapping. You
can copy study objects from a library to a study or another library as well as from a study to another
study. You also can copy study objects in the Project Explorer.

When you copy a data mapping, data set, or data series within a study or library, the new study object
contains item mappings.

Copied study Copied within a study or library Copied from one study or library to

object another

Data mapping, Mappings to items that are part of Item mappings are not copied to the
data set, or data  the data series are retained in the new new study object.
series study object.

Item, Form, or The new study object is mapped to  The study object is copied, but data
study event thatis the data series. mappings are not copied.
mapped to a data

h If you break the link between the Note: If you drag and drop a study
series

original and the new study object, the object that is mapped to a data series,

new study object is still mapped to and the study object already exists in the

the data series. library, the database contains a data
point for the study object, and the drop
operation reuses that data point as is.
The application warns you that the drag
and drop operation is not supported. If
you continue, any data mappings in the
dropped study object that are different
from the data mappings that are
associated with the study object that
already exists in the library are removed.

Note: When a data series is copied within a study or library, the items that are part of a data
series are not copied, but data series mappings to items are copied. For example, if an item is
added to a data series, and the item is mapped to be part of the data series only when the item
appears in a specific form, the mapping of the item to the data series for the form is copied.
Similarly, if you copy a data set or mapping definition containing a data series, the mappings are
also copied. If you use the new data series in another study, the mappings are retained. If you
later add the item and form that are mapped to the data series to the study containing the data

series, the mapping appears in the Data Series Summary tab.
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Working with templates and types

About templates

Characteristic Description

A template is study object that is either partially or fully defined and that can
be used to create other study objects.

Definition

Available for

You can create templates for the following study objects:

Study projects
Studies

Study elements
Study events
Forms

Items
Codelists

Mappings

Purpose of study
templates

Study templates can decrease the time and effort required to build a study.
Think about how to set up study templates to minimize work that users
might need to perform. For example, you might create templates for different
therapeutic areas, compounds, devices, and biologic areas.

After creating

After you create and publish a template, users can create study objects from
the template. You do not need to publish study project templates and study
templates to make them available.

When you create a study object, you can (but are not required to) create it
from a template.

History links

A study object created from a template inherits the characteristics of the
template but has no history link to the template. Therefore, changing the
template does not affect the study object, and the reverse is also true.

Versions

Templates do not have versions; therefore:

For study project templates and study templates, the last saved version
of a template is used when you create a study project or study from the
template.

For other study object templates, the last published version of a
template is used when you create a study object from a template.
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Characteristic Description

Where to view Study project and study templates are viewable when you create a study
templates project or study. You can view all other templates in the library project in
which they are created in the following places in the Project Explorer:

e Under the Templates container. For example, within the Templates
container, the Forms container has all form templates.

e Under the containers for each study object.

Rule templates You can also create rule templates.

Note: You can protect templates and types. However, if you create a new study object from a
protected template or type, the newly created study object is not protected.
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About types

A type is a study object that is either partially or fully defined and can be used to create other study
objects. Types are like templates except that types appear as options in the Actions menu and in the
Project Explorer menu when you create a new study object. Types are used only for items. Some
commonly used types, including Float, Text, and Integer, are included in the system library.

Marking an item as a type automatically marks it as a template, as well.
Types have the following requirements:

®  You can create types for items only.
®  You can create types in libraries only.

e Anitem marked as a type is automatically marked as a template (and you cannot remove the
template categorization).

After you create an item type and publish it, other users can create items from the type.

When you create an item, you must select a type on which to base it, and you choose from types that
are in:

e The System Library. These types are installed with the Central Designer application.
e Libraries that appear in the Library List for the study.

If a type with the same name appears in both the System Library and another library, the type from
the non-System Libraty is used for creating the item.

An item created from a type inherits the characteristics of the type on which it was based, but the
item has no history link to the type. Therefore, a change to the type does not affect the item, and the
reverse is also true. Additionally, types do not have versions, so the last published version of a type is
always used.

Types appear in the following places in the Project Explorer:

e Inalibrary, types appear under the Types container. For example, the Items container contains
all item types in the library.

e In studies and libraties, item types appeatr under the container for items.

Note: You can protect templates and types. However, if you create a new study object from a
template or type, the newly created study object is not protected.

Oracle® Health Sciences Central Designer 2.1.2 97



Chapter 4 Reusing study objects

Differences between templates and types

Characteristic Templates Types
Purpose To provide predefined information To provide predefined information
about a study object. about an item.

You are not required to base new  When you create an item, you must

study objects on templates. choose a type on which to base it.
You can create Study projects, studies, study Items only.
templates and types elements, study events, forms,
for the following items, codelists, and mappings.
study objects
How to create study  Creating a study project or Creating an item:
objects from a study:

cemplat You must choose an item type.
emplate or type .
p op You are allowed but not required to

For more information, see Creating
choose a template.

an item ftom a type (on page 103).
Creating all other study objects:

To create a study object based on a
template, find the template in the
Libraries Browser and then copy it
to your study.

For more information, see
Creating a study object from a
template (on page 101).

Information you can define for templates and types

The following table contains examples of the kinds of information that you can define for templates
and type. All study objects created from a template or type inherit the characteristics of the template
or type.

Note: You can create a study object, such as a study or study event, copy study objects to it from
a library, and then mark the study object as a template. If you use the template to create a study
object, the study objects that were copied from the library do not retain history information from
the study objects in the library.

Study object Information you can define

Templates

Study project o  The references required for creating studies in the project, such as protocols or
goals.

e Any studies or study objects that are contained in the project.
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Study object Information you can define

Study

Study deployment requirements, including languages and form layouts.
Study language requirements.

A defined Library List containing the libraries from which study objects and
templates will be taken to build the study.

The references required for building a study, such as a protocol or study goals.
The users (assigned to study teams) who will be working on the study.

The instructions and Help information for the study.

The functions and constants that will be used in the study.

Workflow components, including commonly used forms, special forms, and
any other commonly used study objects.

Mappings, including items and mappings to items, forms, and study events.

Study element e

The study objects contained in the study element and their workflow.

Instructions and Help for the study element.

Study event

The study objects contained in the study event and their workflow.

Instructions and Help for the study event.

Form

A designed layout.
The study objects contained in the form.

Instructions and Help for the form.

Item

Design information, including a question, title, units, and length.
A codelist including codes and labels.

Data entry rules, such as a range check.

A designed layout.

Instructions and Help for the item.

Codelist

The codes and labels contained in the codelist.

Mapping

A name, RefName, and description of the mapping.

The data sets, data series, and items contained by the mapping,.

Types

Item

Design information, including a question, title, units, and length.
A codelist including codes and labels.

Data entry rules, such as a range check.

A designed layout.

Instructions and Help for the item.
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Marking a study object as a template

1

Do one of the following:
e For study projects and studies—Open a study project.
e For all other study objects—Open a library project.

In the Project Explorer, right-click a study project, study, or study object, and select Set Advanced
Options.

The Advanced Options dialog box appears.

Select Mark as Template, and click OK.

Note: You cannot mark a project as a template if it contains hidden studies, which are
studies on which you are not a team member.

(Not for study project templates and study templates) Optionally, to make the template available for
others to use, right-click the template, and select Publish. Only published study objects appear in
the search results for the library in which they are created.

Note: Study project templates and study templates are available to be used by default.

After creating or modifying a template, you must do the following to make your changes available:

e For study project templates and study templates, save the template.
e For all other study object templates, save and publish the template at any time. Your changes are
not available to others until you publish the template.
Modifying a template

100

After creating or modifying a template, you must do the following to make your changes available:

For study project templates and study templates, save the template.

For all other study object templates, save and publish the template at any time. Your changes are
not available to others until you publish the template.

To modify a study project template or study template:

1

2

3

Select File > Open.
The Open Project dialog box appears.

Select the study project template or the study project that contains the study template, and click
Open.

Note: Only users with rights to modify templates can see templates in the Open Project

dialog box.

Modify the template, and save the changes.
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To modify other study object templates:
1 In the Project Explorer for a libraty, select a study object template.
2 Modify the template, and save the changes.

3 To make the template available for use, right-click the template, and select Publish.

Removing a template categorization from a study object
To remove a template categorization from a study project or study template:
1 Select File > Open.
The Open Project dialog box appears.

2 Select the study project template or the study project that contains the study template, and click
Open.

Note: Only users with rights to modify templates can see templates in the Open Project
dialog box.

3 In the Project Explorer, right-click the study project or study, and select Set Advanced Options.
The Advanced Options dialog box appears.
4 Deselect Mark as Template, and click OK.

To remove a template categorization from other study objects:

1 In the Project Explorer for a library, select the Types and Templates Explorer bar.
2 Right-click a template, and select Set Advanced Options.
The Advanced Options dialog box appears.

3 Deselect Mark as Template, and click OK.

Creating a study object from a template

To create a study element, study event, form, item, codelist, codelist item, or mapping from a
template, you search for the template in the Libraries Browser and then copy it into your study or
library.

A study object created from a template inherits the characteristics of the template but has no history
link to the template. Therefore, changing the template does not affect the study object, and the
reverse is also true.

1 Open a study or library, and make sure a library, study, or other study object (but not a library
project ot study project) is selected.

2 Select the Libraries Browser.

3 To search by title, RefName, or description of the study object, type text in the Enter search text
tield.
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4

7

To include categories, keywords, and libraries as parameters:

a  Click the double down arrows ( ¥) next to the Search Filter.
b  Optionally, select the Categories tab, and select one or mote categories.

¢ Optionally, select the Keywords tab, and select one or more keywords. For more information
about categories and keywords, see Categotization of study objects (on page 74).

d Ifyou are in a study project, select the Libraries tab, and select the libraries to search. You
must select at least one library. This step is optional if you are in a library project.

The parameters you select appear in the field below the Search Filter.

Note: For more information about narrowing your search using template categories, see
About searching for a template or type (on page 79).

Click Find.
The Central Designer application performs a search based on your search criteria.

In the Libraries Browser, select a template from the search results, and drag it to the appropriate
location in the Project Explorer.

A new study object is created in the Project Explorer from the template. The new study object
has the same name as the template but is editable.

Type a name for the study object, and press Enter.

Marking an item as a type

1

In the Project Explorer for a library, right-click an item, and select Set Advanced Options.
The Advanced Options dialog box appeats.
Select Mark as Type, and click OK.

To make the type available for others to use, right-click the type, and select Publish.

Modifying a type

1
2
3

In the Project Explorer for a library, select the Types and Templates Explorer bar.
Select and modify the type.

To make the type available for others to use, right-click the type, and select Publish.

Removing a type categorization from an item

102

After you remove a type categorization from an item, the item type is no longer listed with the item
types that appear when you create a new item.

1
2

In the Project Explorer for a library, select the Types and Templates Explorer bar.
Right-click a type, and select Set Advanced Options.
The Advanced Options dialog box appears.

Deselect Mark as Type, and click OK.
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Creating an item from a type

When you create an item, you must choose a type on which to base it. You can create items in
studies and libraries.

Note: If you are working in a study project, the only types available to you are the types in the
libraries in the Library List for the study.

1 In the Project Explorer, select the ltems Explorer bar.
2 Right-click the InForm Items node, and select New Item > [Item type].
The Object Name dialog box appears.

3 Enter the Title, RefName, and optionally, a Description, and click OK.

Note: You can protect templates and types. However, if you create a new study object from a
template or type, the newly created study object is not protected.
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Managing study objects
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Creating, replacing, updating, and deleting

About creating study objects

Characteristic Description

Naming conventions Oracle recommends developing naming conventions, which help you
identify study objects that appear in search results in the Libraries
Browser.

Parents You can create study objects on the following parents. You create a:

e Study element on a study design.

e Study event on a study design or study element.
e Form on a study event.

e Section on a form.

Note: You cannot create a section outside the hierarchy. You must
create a section on a form.

e Jtem on a form or section.
o (Codelist on an item.

e Codelist item on a codelist.

RefNames and titles When developing naming conventions, consider that all study objects
(except study projects, library projects, libraries, and studies) have
RefNames and titles, which can be different.

e RefNames are referenced in rules and are deployed to the target
application. Therefore, they must:

e Follow C# variable standards.
e Start with a letter or an underscore.
e Contain only letters, numbers, and underscores.

e Be unique within a study or library. For example, you cannot
have a form and an item with RefNames of DOV in the same
study or library.

e Titles are the more readable display names for study objects. They
can contain spaces and special characters, but are not referenced in
rules and are not deployed to the target application.
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Characteristic Description

Automatically generated When you create a new study object (not by copying an existing study

RefNames object), its title and RefName are automatically generated. For example,
the title of a new integer item is Integer Item, and the RefName is
Integerltem. The first time you rename the study object, both the title and
RefName are updated. Subsequent changes to the study object name
change the title but not the RefName.

Some words cannot be used for RefNames. For more information, see
Reserved words for RefNames.

Viewing RefNames or  In the Project Explorer, you can select whether to display RefNames or

titles titles for study objects, and this selection is reflected in most tabs in the
workspace.

Order to create study You can create study objects in any order. Consider the following

objects options:

e  Start by determining whether any required study objects already exist
in libraries.

e If you are working from the study protocol, you might want to start
with the study workflow to create an overview of the study.

e If you are working from CRF specifications:

e Determine whether the study contains study objects and
components that can be reused in multiple locations.

e  Create these study objects and components (for example,
codelists, constants, date time items) first.

Renaming a study object
1 In the Project Explorer, right-click a study object, and select Rename.
The study object name becomes editable.

2 Type a name for the object, and press Enter.

Note: You can also rename a study object by clicking the name of the study object once. The
name becomes editable.

Renaming a study object in a workflow diagram
1 In the Project Explorer, select the study object.
2 Select the Workflow Diagram tab.
3 Right-click the workspace, and select the Rename option for the study object.
In the workflow diagram, the name becomes selected.

4 Type the new name for the study object, and press Enter, or click outside the study object.
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About deleting

The way a study object and its children are deleted depends upon whether the study object is an
instance or a link. Before deleting a study object, make sure that you understand the implications of
the deletion.

For more information, see:

e Instances and links (on page 109).
e How instances are deleted (on page 111).

e How links are deleted (on page 112).

When you delete a study object from a library, the study object is removed from the database only if
it is not in any other library.

Deleting a study object

You can delete any study object, including a study (the study design is also deleted), study event,
study element, form, section, item, codelist, and codelist item. The way that study objects are deleted
depends on whether they are instances or links.

Note: If you delete a study object that has been copied as a link, only the selected study object is
deleted. No copies of it are deleted. For more information, see Copying, cutting, and pasting (on
page 90).

e In the Project Explorer, right-click a study object, and select Delete.

If a confirmation message appears, select the appropriate option. For more information, see

About deleting (on page 108).

Deleting a study object in a workflow diagram
1 In the Project Explorer, select a study design (in a study only), study element, or study event.
2 Select the Workflow Diagram tab.

3 Right-click a study object, and select Delete.

Deleting a study object in a workflow grid
1 In the Project Explorer, select a study design (in a study only), study element, or study event.
2 Select the Workflow Grid tab.

3 Right-click the gray box located at the beginning of a row, and select Delete.

Note: To delete multiple study objects, select multiple rows.
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Deleting a workflow rule from a workflow diagram
1 In the Project Explorer, select a study design (in a study only), study element, or study event.
2 Select the Workflow Diagram tab.

3 Right-click the rule in the workflow diagram, and select Delete Rule.

Deleting a global condition
1 In the Project Explorer, select a study design (in a study only), study element, or study event.
2 Select the Workflow Diagram tab.
3 On the toolbar, click Global Conditions, or right-click in the workflow, and select Global Conditions.
The Edit Global Conditions dialog box appeats.
4 Select a global condition in the list, and click Delete.

5 Click OK.

Deleting one or more rules

1 In the Project Explorer, select a study design (in a study only), study element, study event, form,
section, or item.

The editor for the study object appears in the workspace.
2 Select the Rules tab.
3 Select one or more rules, pressing CTRL or Shift to select multiple rules.

4 On the toolbar, click Delete.

Note: If any of the selected rules are locked by someone else or on a study object that is
protected by someone else, the Delete options are grayed out.

About instances and links

Instances and links

Type Description  Appearance in the Project Explorer

Instance  An actual Study objects that are instances appear in study object containers.

study object in . .
Y Ob) For example, all study elements in the Elements container are

a study .
instances.
Link Alink to a Study objects that are links appear as children in study object
study objectin containers.
a study.

For example, if a study event is a child of a study element in the
Elements container, the study element is an instance, and the study
event is a link.
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Viewing the parents of a linked form

You can view the parents of a form, section, item, codelist, or codelist item that:

®  You copied using the Copy > Link option.
®  You use on multiple parents.

To view the parents of a linked study object:

1 In the Project Explorer, select a study object, and confirm that a blue icon (gj) appears in the
uppet-left corner of the study object's icon.

Note: If the icon does not appear, the study object could be used multiple times in the study
but always on the same parent.

2 Right-click the study object, and select Show Parents.
The Show Parents dialog box appears.
3 Review the paths of the parent study objects in the current project.
The paths begin with the project name and work down; the last study object listed is the parent.
4 To copy paths to the Microsoft Windows clipboard:
a  To copy one path, select it and click Copy.
ot
Click Copy All.
b Paste the information in a text editor.

Notes:

e Show Parents is available in both a study and library, but it lists only the parents in the current
project.

e Show Parents is not available for a study object on a single parent that appears multiple times,
such as an item on a form that is used multiple times in a study.

Breaking the link of a study object

Breaking the link of a study object creates a new study object in the place of the original study object.

e The new study object is identical to the original, except it has a new study object identifier.

e The original study object remains in the study, but the link to it is removed from the study object
tree in the Project Explorer.

You must choose whether to break the links of child study objects. Child study objects for which
links are not broken become the children of the new study object and are no longer the children of
the original study object.

Note: You can break links for study objects that are links only. You cannot break the links of study

objects that are instances. For more information, see /nstances and links (on page 109).
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To break the link of a study object:

e In the Project Explorer, right-click a study object and point to Break link, and select one of the
following options:

With new children:

e The original study object is removed from the study object tree in the Project Explorer (but
not the study), and an identical study object (with a new identifier) is created in its place.

e If the original study object has child study objects, the child study objects are also removed
from the study object tree in the Project Explorer, and identical study objects (with new
identifiers) are created in their places. The new child study objects are children of the new
study object, and the original children are no longer associated with the original parent study
object.

With links to children:

e The original study object is removed from the study object tree in the Project Explorer (but
not the study), and an identical study object (with a new identifier) is created in its place.

e If the original study object has child study objects, the child study objects are not changed.
However, they are no longer associated with the original study object. Instead, they become
the children of the new study object.

How instances are deleted

Description Example When you delete the Gender item
No child study Item name— The instance of the PregnancyTest item is
objects. PregnancyTest removed from the study.

Not used by other e No codelist.

study objects in the
e Not used on any

study.

oy form.
No child study Item name— A dialog box informs you that the delete will
objects. PregnancyTest remove all links to the instance. You can

. continue or cancel.
Used by one or more o  No codelist.
study objects in the If you continue:

e Used on the Visitl

tudy.
e and Visit2 forms. e The instance of the PregnancyTest item is
removed from the study.
e The links to the PregnancyTest item are
removed from the Visit]l and Visit2 forms.
One or more child Item name— The instance of the PregnancyTest item is
study objects that are PregnancyTest removed from the study.

not used by any other
study object.

Not used on an
Not used by oth * y
s t:l) d;soi)jec?csoin f}ie form. e If you select Yes, the codelist is deleted.

study. e If you select No, the codelist is not deleted.

Has a codelist. You are asked if you want to include the child
study objects in the delete.
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Description Example

One or more child Item name—

study objects that are PregnancyTest
d b

nsed by one or more Has a codelist.

other study objects.

Not used on any

When you delete the Gender item

The instance of the PregnancyTest item is
removed from the study.

The codelist on the item is not affected because
it is being used by one or more other study

Not used by other P objects in the study.

study objects in the orm.

study.

One or more child Item name— A dialog box informs you that the delete will

study objects that are PregnancyTest
h

not used.by any other o delist.

study object.

Used on the Visitl

Used by one or more -
and Visit2 forms.

study objects in the
study.

remove all links to the instance. You can
continue or cancel.

If you continue:

e You are asked if you want to include the
child study objects in the delete.

= If you select Yes, the codelist is
removed from the study.

= Ifyou select No, the codelist is not
affected.

In addition:

e The instance of the PregnancyTest item is
removed from the study.

e The links to the PregnancyTest item are
removed from the Visitl and Visit2 forms

How links are deleted

Description ‘Example
Has child study Item name—
objects or has no PregnancyTest

hil jects.
child study objects e Has a codelist or
Is used by multiple has no codelist.

study objects. .
e  Used on the Visitl

and Visit2 forms.

Results of deleting the item

When you delete the PregnancyTest item from a

form (for example, the Visit2 form):

e The link to the PregnancyTest item is deleted
from the Visit2 form.

e The link to the PregnancyTest item remains
on the Visitl form.

The PregnancyTest item can be used on other
forms.

Has no child study
objects. PregnancyTest

Item name—

Is used by a single e No codelist.

study object. .
e Used on the Visit2

form only.

The link to the PregnancyTest item is deleted
from the Visit2 form, and the instance of the
PregnancyTest item is removed from the study.
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Description ‘Example Results of deleting the item

Has one or more child Item name— The link to the PregnancyTest item is removed
study objects. PregnancyTest from the Visit2 form.

Is used by a single e Has a codelist. If the codelist on the item is used by only the

study object. PregnancyTest item, then you are asked if the
child study objects should be included in the

delete:

e Used on the Visit2
form only.

e Ifyou select Yes, the instances of the codelist
and its codelist items are removed from the
study.

e If you select No, only the PregnancyTest
item is removed from the study. The codelist
still exists and can be used by other items.

Note: When you delete the final link of a study object, you receive a message that only a single link
to the study object exists in the study or library, and you are asked if you want to delete the study
object from the study or library after the link is removed. If you click:

¢ Yes—DBoth the link to the study object and the study object itself are deleted from the study or
library.

e No—The link to the study object is removed from the study or library, but the study object
remains in the study or library.
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Adding study objects

If a study object exists in a study but has not been added to the study object hierarchy, you can use
the Add To browser to locate the study object and add it to a parent study object.

About the Add To browser

The Add To browser displays the list of study objects, within the current study, that you can add to
the selected study object. For example, if you select a form, the Add To browser contains a list of
items and sections that you can add to the selected form.

In the Add To browser, you can:
e Filter the list of available study objects by:
e Typing a keyword.
e Specifying the fields on which to apply the filter (RefName, Title, Description, or Labels).
e Display the filtered list of study objects by RefName or Title.
e Do the following for the selected study object:
e Copy a study object with or without its children.
e Add alink to a study object.

Before you add a study object using the Add To browser, you can also view details about the study
object, including:

e Study object properties.
e DParent study objects.

e Form layout (available for InForm forms only).

Adding study objects to a study from the Add To browser
In the Project Explorer, select a study object.
To open the Add To browser
e In the upper-right corner of the application window, select Add To.
To filter study objects in the Add To browser
1 Do one of the following:
e In the Filter field, type a keyword.

e (lick Advanced Filtering.
a  Specify the properties on which to apply the filter.
b Specity the display format for the filtered results.

. 1
2 Click Refresh Results ( #= ).
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To view details for a study object in the Add To browser

1

In the Add To browser, select the study object.

2 Click Show Details.

3

The Show Details dialog box appears.

Do one of the following:

e To view the form layout for forms, select the Preview Form tab.

e To view properties for the study object, select the Object Details tab.

e To view the parent study objects for the study object, select the Referenced By tab.

To add a study object from the Add To browser

Select the study object and do one of the following:

e Drag the study object from the Add To browser and drop it onto the study object selected
in the Project Explorer.

e Sclect the Add link drop-down list, and select one of the following:
e  Add as link—Adds a link to the study object.
e Add with children—Adds a copy of the study object and the study object's children.

e Add without children—Adds a copy of the study object without the study object's children.

Previewing study objects in the Add To browser

1

2
3
4

In the Project Explorer, select a study object.

To open the Add To browser, in the upper-right corner, select Add To.
In the Add To browser, select a study object to preview.

Click Preview.

The Preview Object dialog box appears.

If the study object you selected is an InForm form, select Preview Form to view the form layout.
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Saving study objects

About saving study objects

Characteristic Description

What you can save e A study object and its child study objects.
e All study objects in a study.

e All study objects in a study project.

Study objects that Only the study objects that have been modified since the last save are saved.

are saved

Level at which to e If you are working on multiple study objects and are not finished with all

save of them, you might want to save individual study objects after you finish
working on them using Actions > Save.

e If you are working at a global level (for example, on mappings) you
might want to save at the project level (File > Save Project or Ctrl+S).

Locks that are Saving releases the locks that you hold on all study objects that you have
released edited.

e If you are collaborating with users who need access to study objects you
are working on, consider saving as soon as you are finished with each
study object.

e If you are working on multiple related study objects and do not want to
release the locks until the related work is completed, consider not saving
until you exit the study or library, or apply explicit locks.

Undoing You cannot undo after a save action.

Note: Although you cannot undo after a save, you can revert to a previous

version or revision. If you are unsure whether you want to keep the changes

you are making, you might not want to save so you can still undo your
changes.
Revisions When you save a study object, a revision (on page 121) is created.

Saving one or more study objects

To save a study object:

e In the Project Explorer, right-click a study object, and select Save.

To save all study objects in a study:

1 In the Project Explorer, select the Study Information Explorer bar.

2 Right-click a study, and select Save Study.
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To save all study objects in a study project:

e  Select File > Save Project, or press Ctrl+S.

Saving a rule

You can save a rule at any stage of development. For example, you can save a rule after providing
only the name and description, and a more technical user can create the expression. You can also
save a rule that has errors and return to it later. Validation checks the syntax of all rules.

e Atany time in the Rule Wizard, click Finish.
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References

A reference is a text note, a link to a Web page or file (URL), a document, or a combination of all
three, that is attached to a study project for users to consult during the development of a study.

You can attach a reference to a study or study project and view references already attached to a study
or project.

References include standard operating procedures, protocols, naming or project standard documents,
and other relevant documents. Study designers can use reference information to construct a study.

You can attach the following references:

e A shortcut that references a file.

For example, you can attach a shortcut to a file if the file is checked in to a version-control
application and you want all users to view the most recent version.

e A physical file.

You can attach a physical file if the file is stored in a location that everyone cannot access.
e A shortcut that references a URL address.

You can attach the address of a web site that contains information relevant to a study.

References attached to a study project are available for all studies in the project, but references
attached to a study are available only for the study.

Note: Version control is available only for study objects and is not available for references.

Attaching a reference to a study

1 In the Project Explorer, select Study Information.

2 Select a study.

3 Select the References tab.

4 In the Title field in the top grid, type a name for the reference.
5

In the Attachments section (located in the lower-right corner), click the drop-down arrow next to
the Add File button.

A menu of attachment options appears.

6 Attach one of the following references.

To attach the following Perform these steps

Shortcut to a file 1 Select Attach file.
The Open dialog box appears.

2 Navigate to the file that you want to attach, select the file, and
click Open.

A reference to the file appears in the Attachments section.
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To attach the following Perform these steps

Physical copy of a file 1 Select Copy and Attach File.

The Open dialog box appears.

2 Navigate to the file that you want to attach, select the file, and
click Open.

The file appears in the Attachments section.

Shortcut to a URL address 1 Select Attach URL.
The Attach URL dialog box appears.
2 In the field, type the URL address.

A shortcut to the URL appears in the Attachments section.

Note: The maximum size of the attachment is determined by a variety of factors, including
information defined in the configuration file, available hard disk space, and available memory. To
determine the approximate maximum attachment size, check the maxRequestLength attribute in
the machine.config file.

Removing a reference from a study
1 In the Project Explorer, select Study Information.
2 Select a study.
3 Select the References tab.
4 In the Attachments section, select a reference.
5

Click Remove.

Maximum attachment size

By default, the maximum size of a file that is attached as a reference is 10 MB. When a user copies or
attaches a file in the References editor, an error message appears if the size exceeds the configured
maximum.

The maximum file size is set in the DesignerUI.config file, in the <ReferencesEditor> section. To
change it, update the <MaxFileAttachmentSize> value, using an integer value in megabytes.
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About versions and revisions

Versions

A version is an explicitly requested audit history record for a study object. Every study object has a
version that is composed of three numbers: the major number, the minor number, and the revision
number, which appear in the following format:

<Major number>.<Minor number>.<Revision number>

For example, for version 1.2.34, the major number is 1, the minor number is 2, and the revision
number is 34.

When you version a study object, you can choose to increment either the major or minor number.
When you increment the major number, the minor number and revision number are both reset to 0.

When you increment the minor number, the revision number is reset to 0. For example, for version
1.2.34:

e If you increment the major number, the new version is 2.0.0.

e If you increment the minor number, the new version is 1.3.0.

Versioning and revising a study object

You can version and revise a study object (study design, study element, study event, form, section,
item, codelist, and codelist item).

To version a study object:

1 In the Project Explorer, right-click a study object, and select Create Version.
The Create Version dialog box appears.

2 Select one of the following increment options:

®  Increment major number—Increment the major number by one and reset minor and revision
numbers to 0.

For example, version 1.2.34 changes to 2.0.0.

e  Increment minor number—Increment the minor number by one and reset revision number to

0.
For example, version 1.2.34 changes to 1.3.0.
3 Type a version label and description.

4 Click Create.

Note: The version or revision of a study object is saved in the Revision property in the Properties
Browser.
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To revise a study object:

e Save your changes.

Revisions are generated automatically when you save a study object with changes. The revision
number for all saved study objects is incremented by 1 automatically.

Note: The version or revision of a study object is saved in the Revision property in the Properties
Browser.

Reverting to a previous version or revision of a study object

You can revert to a previous version ot revision of a study object (study design, study element, study
event, form, section, item, codelist, and codelist item) if the study object is not locked by another
usef.

Note: A revision is created automatically every time someone edits a study object and saves the
changes. A version is created only when you explicitly request it.

1 In the Project Explorer, right-click a study object, and select Audit History.
The History Viewer dialog box appears.
2 Select one of the following options:
e View Versions—All versions of the selected study object appear in the top grid.
e View Every Edit—All revisions of the study object appear in the top grid.
3 Double-click the version or revision to which you want to revert.
4 Click Revert to.
The study object reverts to the selected version or revision.

For more information, see Histoty Viewer dialog box - Option desctiptions (on page 159).

Revising study objects

Revisions

A revision is an audit history record that is created automatically when a user edits a study object and
saves the changes. Study objects are revisioned automatically when you save them, and their versions
are updated automatically. Every study object has a version that is composed of three numbers: the
major number, the minor number, and the revision number, which appear in the following format:

<Major number>.<Minor number>.<Revision number>

For example, for version 1.2.34, the major number is 1, the minor number is 2, and the revision
number is 34.

When you save a study object after making changes, the revision number increases by 1. When you
version a study object, the revision number is automatically reset to 0.
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Object revisions in the InForm application

Object revisions are created in the InForm application when you perform the following actions:

e Modify study objects.
e  Use linked study objects multiple times in a study.

e Deploy a study that was previously deployed in eatlier releases of the Central Designer
application.

Only some object revisions are visible in the InForm application, but all revisions are reported during
submission by the CRF Submit application.
How modifying study objects affects revisions in the InForm application

In a study that has already been deployed, object revisions are created for modified study objects.

Study event A new revision is created for the visit.
Form A new form revision is created.
Section New revisions are created for both the section and the form on

which it is used.

Ttem New revisions are created for the item as well as the section and
form on which it is used.

Note: Sections are created for all items in the InForm application
by default, so a revision is created for the default section if the item
is not in a section in the Central Designer application.

Control portion of an item New revisions are created for the control and item as well as the
(for example, the information section and form on which the item is used.

that appears in the right

column of a layout).

How using linked study objects affects revisions in the InForm application

Object revisions are sometimes created during the initial deployment of a study when an item,
section, or form is used as a link (that is, it is used multiple times in a study).

Because the presentation of a study object (its layout) is separated from the data of study objects, you
can create different layouts for each instance of the study object. Object revisions are created for the
study objects with modified layouts.

For example, if the Dem form is used on two study events and each form has a different form title in
the Layout tab, a form revision is created for one of the Dem forms in the InForm application.

The following table provides examples of information that, when you modify it for a linked study
object, results in the creation of object revisions.
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Form Section modifications Item modifications
modifications
e Form title e  Section note e Caption override
e Section header o Codelist item label override
e Section title e Size of a text box

e  Width of the question column

e Orientation of radio buttons, checkboxes, or a
group control

How deployment of a study created with an earlier release of the Central Designer
application affects revisions in the InForm application

If you deploy a study using release 1.0 or 1.1 and then upgrade to a later release, revisions are created
for study events, forms, sections, and items that existed during the deployment from release 1.0 or

1.1.
Study object Result in the InForm application when the study is deployed
deployed in release
10o0r1.1
Study event A new revision is created for the visit.
Form A new form revision is created.
Section New revisions are created for both the section and the form on which it is
used.
Item New revisions are created for the item as well as the section and form on

which it is used.

Note: Sections are created for all items in the InForm application by
default, so a revision is created for the default section if the item is not in
a section in the Central Designer application.

Control portion of an ~ New revisions are created for the control and item as well as the section
item (for example, the  and form on which the item is used.

information that

appears in the right

column of a layout).

Post-production revision management

A study design represents the root of the study workflow, including study events, forms, and rules
that govern the behavior of study events and forms. The study workflow is independent of locale;
therefore, there are special considerations for designing a single study with different workflows for
different sites or locales in the target application.

For example, consider the case where you want to add a form to a visit in some sites or locales but
not to others. Because the study has only one study workflow, the form must be added to all sites.
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Your options are:

e Create a workflow rule or global condition for the form that causes the form to never appear
unless the site code or locale is one that has been specified. This approach might work for simple
cases, but the approach can create maintenance problems if there are many similar
customizations, or if different sites require different versions of the form.

e  Create a separate workflow for the different sites. This approach would normally require having
two study designs in the study, which is not supported by the Central Designer application.

Many production multi-site studies undergo different maintenance paths, in which some changes are
distributed to all sites and others are limited to only a few sites. The Central Designer application
does not allow you to create a single study with multiple study designs (in other words, multiple
workflows) that you maintain in parallel.

However, you can split the different maintenance paths into separate copies of the study, each of
which can be maintained separately, as follows:

1 Create a study that will be used in production. Consider this study to be the 1.0 study.
2 Create a deployment package and deploy and install it in all study sites.

3 Export the study and import it into a new study (which can be, but does not have to be, part of
the same study project). The new study is comparable to a 1.1 branch. The new study will be
maintained separately from the existing study.

4 Before making any changes to the new study, create a baseline and deployment package. This
package is identical to the original study package. The new package will be the basis for
incremental deployment packages in the 1.1 study.

5 Add study objects to or modify the 1.1 study.

6 Create an incremental deployment package, and deploy the package to the specific sites that
require the changes.

This approach requires you to maintain both studies independently of each other. For example, if
you modify a form in one study, the change is not propagated to the form in the other study unless
the study object is in a library and is used in both studies.

Viewing audit history for a study object

124

You can view the audit history for a study object (study design, study element, study event, form,
section, item, codelist, and codelist item) in the History Viewer dialog box. The History Viewer
shows the properties and structure of the study object, including its children, but it does not show
associated rules or layout information.

1 In the Project Explorer, right-click a study object, and select Audit History.
The History Viewer dialog box appears.
2 Select one of the following options:
e View Versions—All versions of the selected study object appear in the top grid.

e View Every Edit—All revisions of the study object appear in the top grid.
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3

Click among the versions or revisions to view the structure of the study object (in the lower-left
grid) and the properties for the study object selected in that grid (in the lower-right grid).

For more information, see Histoty Viewer dialog box - Option desctiptions (on page 159).

Viewing the differences between two versions or revisions of a study object

In the History Differences dialog box, you can view the differences between two versions or
revisions of a study object, including the child study objects and properties, for each version or
revision. A revision is created automatically every time someone edits a study object and saves the
changes. A version is created only when you explicitly request it.

1

In the Project Explorer, right-click a study object, and select Audit History.

The History Viewer dialog box appears.

Select one of the following options:

e View Versions—All versions of the selected study object appear in the top grid.

e View Every Edit—All revisions of the study object appear in the top grid.

In the Revision/Version grid, select the two versions or revisions that you want to compare:

a  To select the first version or revision, double-click within the gray box at the left end of the
row.

b To select the second version or revision, click within any field in the row.
Click Differences.
The History Differences dialog box appears.

In the top grid, compare the child study objects that appeared in each version or revision. In the
bottom grid, compare the properties of the study object in each version or revision.

For more information, see Histoty Viewer dialog box - Option desctiptions (on page 159).
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Exporting and importing text for translation

About exporting and importing text

You can export all text strings for a target application and locale into a CSV file, translate them
locally, and then re-import the translated strings.

This option is useful for outsourcing translations. After exporting the text strings for a selected target
application and locale to a CSV file, you can send the file to a third-party translation vendor to
translate the strings. When the translated strings are returned, you import them back into the Central
Designer database. You perform the export and import separately for each locale to be translated.

You can export and import text strings at any time during the development of a study, including
updates after a study has gone live. For example, to generate a test file to validate the process with a
translation vendor, you can export the text strings for a partially developed study. When the study is
completely developed, you can export the strings again, have the vendor translate the remaining
strings, and import the completed translation file.

Note: The text string export and import feature works only with the current format of layouts. If
your study contains layouts that were created in release 1.2 or earlier of the Central Designer
application, you must convert the layouts to the current format before exporting or importing text
strings. For more information, see Converting layouts (in the InForm Design Guide).

Exporting text strings from a study or library

1 In the Project Explorer, right-click a study or library, and select Translations > Export.
The Export Translations dialog box appears.

2 Fillin the fields of the dialog box. For more information, see Export Translations dialog
box—Option desctiptions (on page 158).

3 Click Export.

The Central Designer application exports all of the text strings that match the selected criteria
and saves them in CSV format in the location you specified. Status messages appear in the
Exportt log results field.

4 To save the export log file, click Save Log Results As and select a location.
5 To interrupt the export process, click Stop.

The export process stops, and no further records are written to the output file.

Note: You can undo a string export.
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Importing translated text strings

To import translated text strings successfully, make sure that the translation file is in the correct
format and that all requirements for character formatting are met.

For more information, see:

Translation file format (on page 128).

Translation file requirements (on page 129).

In the Project Explorer, right-click a study or library, and select Translations > Import.
The Import Translations dialog box appears.

Browse to the location of the CSV file containing translated strings to import.

Click Import.

The Central Designer application imports each text string to the study object specified in the
CSV file. Status messages appear in the Import log results field. If an entry cannot be imported
(for example, if the import process cannot acquire a lock on the target study object), a message is
written to the import log, and the import continues with the next entry. You can re-import the
file to process modified or corrected entries.

To save the import file messages, click Save Log Results As, and select a location.
To interrupt the import process, click Stop.

The import process stops, and no further records are updated in the study. Records that were
updated before the stop remain in the study.

Note: You can undo a string import.

Translating exported text strings

After the text strings for a study or library are exported, a translator adds translated strings to the
exported file.

In the exported file, provide translated values for each text string, and save the file.

Note: If you use Microsoft Excel spreadsheet software as the CSV file editor, you must import the
exported file as Unicode UTF-8; you cannot simply open the file and edit it. Additionally, you must
export the edited file as Unicode UTF-8 CSV; you cannot save it and preserve the correct
formatting. You might want to develop a Microsoft Excel macro specification or other tool that
performs this processing. For guidance, see the Microsoft Excel documentation.

For more information, see:

Translation file format (on page 128).

Translation file requirements (on page 129).
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Translation file format

The translation export and import CSV file consists of a header and translation records in the
following formats.

Header

The header contains the following values: RefName,OwnerType,StType, Id,Revision,
<Referencelocatel alne>,< LocaleToTranslate>

o <Referencel .ocalel”alue>—1I.ocale of the strings from which to translate, as specified in the Locale
to translate from field of the Export Translations dialog box. Example: en-US.

o <LocaleToTranslate >—Locale to which text strings are being translated, as specified in the Locale
to translate field of the Export Translations dialog box. Example: fr-FR.

Example of file header

RefName,OwnerType,SrType, Id,Revision,en-US, fr-FR
Records

Each translation record contains the following fields: <RefName>,<OwnerType>,<SrType,
<Id>,<Revision>,<Referencel_ocalelalue>,< LocaleToTranslate>, as described in the following table.

Field Description

RefName RefName of the study object that owns the string.

OwnerType Internal type of the study object that owns the string resource.

StType Internal type of the field that references the string resource.

Id GUID of the string resource in CSML.

Revision Revision number of the study object for which the text string is
defined.

ReferenceLocaleValue Text string in the locale to translate.

LocaleToTranslate Translated text string. This value is empty when you export the file.

The translator fills in the value before you import the file.

Note: The LocaleToTranslate is the only value that may be
changed in each record.

Examples of file records

Layout_5fxx,LayoutPlan, ItemCaption,d067b170-8885-11el1-b0c4-0800200c9a66,12, '‘DOV
Form","Forme pour la date de visite"”
I1tm_DOB,DateTime,Question,26beca46-663e-4841-ab8b-03ff6b7a78f9,5, " Date of
Birth',""Date de naissance'
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Translation file requirements

e Do not change any values in the translation file except the strings in the LocaleToTranslate
position (last field in each record).

e The header record must be present.
e Each record must conform to the following standards:
e All records must have the same number of fields.
e RefName and Id fields must not be empty.
e RefName length must be less than or equal to 63 characters.
e Revision and OwnerType lengths must be less than or equal to 255 characters.

e ReferencelLocaleValue and LocaleToTranslate lengths must be less than or equal to 32000
characters.

e Double quotation marks (") are required for any field that contains a line break, double quote, or
comma and are optional for any other field.

e Ifa field contains a double quotation mark character [for example, Dizzy ("Groggy™)], you must
include another double quotation mark as an escape character, as follows: "Dizzy (""Groggy"™")"

e Lines must end with a Windows-style (CRLF) line terminator.

Checking for empty strings
You can generate a list of the empty strings in a study for a specified locale.
1 In the Project Explorer, select a study.
2 Do one of the following:
e  Select Actions > Translations > Check for Empty Strings.
or
a  Select Actions > Translations > Export Strings for Translation.
The Export Strings for Translation dialog box appears.
b  Click Check for Empty Strings.
The Check for Empty Strings dialog box appears.
3 In the Locale drop-down list, select the locale to check.
4 Click Run.
The empty strings in the study appear in the Empty strings for study < study name> grid.

5 To navigate to the location of an empty string, click the button at the left of the Owner RefName
column, and select Goto empty string.
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Importing and exporting a study

Importing and exporting are useful for:

e Working with customer support to analyze problems in a study.

¢ Moving a study from one server to another.

Note: Exporting and importing do not preserve notes, categorization, or ancestry.

About importing

130

You can import study objects into a library or study. For example, if a study contains many study
objects that you expect to reuse, you can use the import feature to create the study objects quickly in
a library or study. After a study has been imported, you can revise, add, or delete study objects as
needed.

You can import a file in CSML or ODM format

e  (Clinical Study Markup Language (CSML) is an XMI-based markup language developed by
Oracle for representing and exchanging clinical data definitions created in the Central Designer
application.

e Operational Data Model (ODM) is an XML-based standard developed by the Clinical Data
Interchange Standards Consortium (CDISC) for representing and exchanging clinical data.

For example, you can use the CSML option to import an exported Central Designer study into
another study.

Note: You cannot import a CSML file into a library if the file contains a study design. A CSML file
contains a study design if you exported the CSML from a study. To add study objects that are in a
CSML file to a library, import the CSML file into a study, use the Libraries Browser to search for
the study objects, and then drag them to the library.

Importing study objects

Note: You cannot import a CSML file into a library if the file contains a study design. A CSML file
contains a study design if you exported the CSML from a study. To add study objects that are in a
CSML file to a library, import the CSML file into a study, use the Libraries Browser to search for
the study objects, and then drag them to the library.

1 In the Project Explorer, right-click a study or libratry, and select Import Study.
The Central Designer Import Wizard appears.

2 Complete the pages of the Central Designer Import Wizard. Click Next after you finish filling in each
page. On the Import Type page, select the source of the data to import.
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Based on your selection, the Central Designer Import Wizard prompts for different information
as you progress through the wizard.

After you select a file to import and click Next, the wizard reviews all the study objects in the
file. This process might take several minutes.

3 On the final page of the Central Designer Import Wizard, click Finish.

If you are importing a CSML file containing study objects for a system that is not selected as a
Deployment System for the study or library, a message appears; choose one of the following
options:

e Continue with the import, and select all the systems in the CSML file as Deployment
Systems. If you choose this option, continue to the next step.

e Cancel the import.

A slide-up message appears in the lower-right corner to indicate when the job starts and
completes.

4 When the job completes, check the status in the Jobs Browser.

5 Review the imported study objects, and add, delete, or modify them as necessary.

Note: If you uninstall a deployment system, you cannot import a CSML file that contains study
objects for that system.

For more information, see:
Import Wizard options - CSML or ODM file (on page 160).

Import Wizard options - InForm resources (on page 161).

Viewing import job results
1 In the Project Explorer, select a study or library.
2 In the row of browser tabs, select the Jobs Browser.

The Jobs Browser appears.

Note: In the Jobs Since list, you can select the period for which you want to view job results.
You can also sort the list by the Name or Start Time column to locate a job quickly by a
specific starting date.

3 Click Refresh.
The list of jobs is refreshed from the database.
4 On the toolbar, click Show Job Results, and expand the results for an individual job.

Information, warning, and error messages appear for the jobs run in the selected period.

Note: To view the complete text of a message that is truncated because of column size,
hold the cursor over the portion of text that is visible. Alternately, select a row, and then
right-click it and select Properties.
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CSML metadata imports

If you export and then re-import a study using the CSML format, the Study Design object is
overwritten. (Each study has only one Study Design object.) The following rules apply when an
imported study object and an existing study object have the same object ID.

Import target Imported study object has the Result

same ID as a study object in...

Study Any other study. The ID of the imported study object is
changed to a new 1D.

All references to the imported study object
in the import are updated to refer to the

new ID.

Study The same study. The ID of the imported object does not
change.

Library Any library. The ID of the imported object does not
change.

Library Any study. The ID of the imported study object is

changed to a new ID.

All references to the imported study object
in the import are updated to refer to the
new ID.

When functions are declared in the study CSML, functions are imported except under the following
circumstances:

e When you import CSML in a study, and a function in the CSML already exists in a library that is
in the Library List for the study. The function is already available for use. You do not receive an
error or warning.

e When the function assembly does not exist in the database. You receive a warning.
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ODM metadata imports

The Operational Data Model (ODM) is an XML-based standard developed by the Clinical Data
Interchange Standards Consortium (CDISC) for representing and exchanging clinical data. ODM is a
vendor-neutral, platform-independent format used for importing, exporting, and archiving clinical
study data and metadata.

The Central Designer import feature supports a subset of the ODM standard, using only the
metadata that fits into the Central Designer CSML schema.

You can import metadata in ODM format into the Central Designer application as long as the
metadata:

e Complies with version 1.3 of the ODM standard.
e Contains only standard ODM objects with no extensions.
e Has a file type of Snapshot and contains only one study, one metadata version, and one protocol.

e Includes measurement units that are present in the Central Designer Units definition in the
database.

Note: If the metadata contains units that are not present in the Central Designer database,
a warning occurs, and the units are not imported.

ODM mappings

The following table describes how ODM elements are mapped to Central Designer study objects
during import.

ODM element Central Designer study object
Study Study design
StudyEventDef Study event
FormDef Form
ItemGroupDef Section
ItemDef (datatype=INTEGER) Integer item
ItemDef (datatype=FLOAT) Float item
ItemDef (datatype=DATE, TIME, DATETIME) Date time item
ItemDef (datatype=TEXT, STRING) Text item
CodelList CodelList
CodeListltem CodeListltem
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Considerations for ODM import in InForm studies

You can reuse ODM-formatted study design metadata that is exported from a third-party
application. Consider the following if you are importing metadata in ODM format into the Central
Designer application to use in the creation of InForm studies or libraries.

Common visits—The ODM specification allows multiple common StudyEventDefs, while the
Central Designer application allows only one common visit.

All common StudyEventDefs in an ODM import file are consolidated into a single common
visit after import. The forms defined for the common visits in the ODM import file appear in
the single common visit in the Central Designer application.

The CommonVisit definition for the common visit that appears in the Central Designer
application contains a LongTitle and ShortTitle, which are populated by the Description and
Name defined in the first common StudyEventDef in the ODM import file.

Units—The MeasurementUnit in the ODM import file is matched with entries in the Central
Designer database based on unit symbols, but not unit names. If a unit in the ODM import file is
not recognized as a unit in the Central Designer database, a warning message appears and the
unit is not imported.

Metadata—The Central Designer application does not recognize some ODM metadata (for
example, the attribute SDSVarName). Any element or attribute in the ODM import file that is
not recognized by the Central Designer application is ignored, and is not imported. You cannot
recover this metadata after import.

Rules—RangeCheck is the ODM simple range-checking attribute. Because the Central Designer
application uses rules for range checking, ODM RangeChecks are imported as collaboration
notes so that you can create the appropriate RangeCheck rules after importing.

Import file type—Snapshot ODM represents a complete picture of a study at a point in time.
Transactional ODM represents the life of the study over time. The Central Designer application
supports standard ODM with a file type of Snapshot.

The Central Designer application does not support ODM file chaining. The ODM specification
allows files to be chained together through the FileOID and PriorFileOID attributes. File
chaining is primarily used in Transactional ODM, but can also be used in Snapshot ODM to
break up study metadata into multiple files that are chained together. Transactional ODM uses
file chaining to create a final end state of a study upon import completion. Because the Central
Designer application does not support file chaining, if you import Transactional ODM, an error
occurs.

Note: You cannot import InForm metadata that you extracted from the InForm Adapter
application with a Transactional file type. You must specify Snapshot as the file type
parameter when you export data from the InForm Adapter application. For more
information see the InForm Adapter User Guide.

Workflow—Because the OrderNumber attribute is optional for StudyEventDefs in an ODM
import file, the order in which the StudyEventDefs appear in the ODM is the order in which
they appear in the Central Designer workflow.

e A study event with an OrderNumber attribute is assigned a sequence number, unless its
predecessor in the workflow has a type of Scheduled.
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e A study event with no OrderNumber attribute is placed at the end of the workflow, in the
order in which it is read from the ODM import file.

Note: Any study event, with or without an OrderNumber attribute, is assigned a sequence
number of zero if its predecessor in the workflow has a type of Scheduled.

e Localization—The Central Designer application imports localized data specified in an ODM
import file. The translated data appears in the Central Designer application in the language to
which it was localized. For more information, see the ODM specification for the TranslatedText
element on the CDISC web site.

The following localized study objects can be imported:
e Forms.

e  Sections.

e Items (Question, Text, and Description).

e The decoded value for codelist items.

e Symbols for measurement units.

e  Granularity—Granularity is an optional ODM file attribute. If present, it must be set to All or
Metadata. If Granularity is set to Metadata, the document cannot contain AdminData ,
ClinicalData, or ReferenceData sections.

¢ Naming uniqueness—The Central Designer application enforces naming uniqueness with
Universal Unique Identifiers (UUIDs). A UUID is a Global Unique Identifer (GUID) that is
created using the Object Identifier (OID) for a study object. If the OID is not a valid GUID or
is already used by another object, the import process generates a GUID using Microsoft’s GUID
generation algorithm.

For example, during the import, to create a StudyEventOID, the Central Designer application:
1 Truncates the OID to the maximum allowed length.
2 Removes disallowed characters.

In addition, within an ODM import file, ODM allows the reuse of RefNames if the RefName is
for a different type of study object. However, the Central Designer application requires unique
RefNames for all study objects in a study, and for all study objects in an import file. To enforce
the uniqueness of RefNames in the import file, the Central Designer application adds prefixes to
the imported study object RefNames according to the study object type.

If an ODM import file contains study objects with the same RefName, the Central Designer
application uses the following logic:

e For study objects of the same type, the Central Designer application creates a new object
with a different ID but the same RefName, and adds a prefix to the RefName.

e For study objects not of the same type, the Central Designer application imports the study
object and displays a warning that duplicate RefNames exist.

Note: If you import multiple ODM files, and duplicate RefNames exist between the files, the
Central Designer application allows you to import the study objects. You must resolve
RefName conflicts after import in order to validate the study.
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The Central Designer application applies the following prefixes for study objects with duplicate
RefNames within an ODM import file.

CSML object type Prefix

StudyDesign SD_
StudyEvent SE_
DataView (from the FormDef definition in the ODM import file) DF_
DataView (from the ItemGroupDef definition in the ODM import file) DI_
IntegerVariable, FloatVariable, DateTimeVariable, or TextVariable VR_
CodeList CL_
CodeListItem CL_

Pre-import checking

Pre-import checking verifies that the following conditions are met before ODM is transformed to
CSML for import into the Central Designer application.

e All requirements are met. For more information, see Considerations for ODM import in
InForm studies (on page 133).

e The input file is a well-formed XML file and is fully compliant with the ODM 1.3 schema.

Note: Error and warning messages appear as Job Results in the Central Designer Job Browser.

Post-import modifications

After you import a study from an external source, you should review the imported study object
definitions to identify the additions and changes they require. For example:

e If you import a file in CSML format, Central Designer rules are created. If any rule refers to a
user-defined function that does not exist in the target study, import the user-defined function to
the study. If a required constant does not exist in the study or in a library that the study uses, add
the constant or add the appropriate library to the Library List.

e If you import from a source other than CSML, imported rules are not converted to Central
Designer rules; instead, they appear as collaboration notes. You must create a rule for each rule
in the import file that you want to use in the library or study.

e In order to use imported study objects as valid deployable Central Designer study objects, you
should review the imported study objects to add additional information that is not contained in
the ODM format. For example, you must:

e  Create form layouts for imported forms.
e Translate study object labels and text strings as needed for multi-lingual studies.

e  Create a range check rule for each imported ODM RangeCheck that you want to use in the
library or study. For more information, see the Rules Reference Guide.

e Resolve RefName conflicts for all study objects you want to deploy to a target application.
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e Connect any scheduled imported events or elements in the proper order with arrows, and
provide hours between the visits.

If studies or study objects were marked as templates, you must re-mark the study objects as
templates.

Note: If you harvest InForm resources and publish them in a library, both forms and sections
appear in the forms group when you search for study objects. However, in the Project Explorer,
forms and sections have different icons. Using naming conventions that clearly distinguish forms
from sections is recommended.

About exporting

The export feature enables you to export a study or library to a file, for archiving or for importing
back into the Central Designer application or to an ODM-compliant system. With the export feature,
you can generate export files in Clinical Study Markup Language (CSML) or in Operational Data
Model (ODM)-compliant format:

Clinical Study Markup Language (CSML) is an XML-based markup language developed by
Oracle for representing and exchanging clinical data definitions created in the Central Designer
application.

Operational Data Model (ODM) is an XML-based standard developed by the Clinical Data
Interchange Standards Consortium (CDISC) for representing and exchanging clinical data. The
Central Designer application exports XML that is compliant with the 1.3 version of the ODM
standard.

Note: When you export a study or library, you export the entire study or library. You cannot
selectively export certain study objects.

Exporting study objects

1

In the Project Explorer, right-click the study or library from which you want to export study
objects, and select Export Study.

The Central Designer Export Wizard appears.

Complete the pages of the Central Designer Export Wizard. Click Next when you finish filling out
each page.

On the final page of the Central Designer Export Wizard, click Finish.

An export file is created in the location you specified in the wizard.

Note: If errors result when you export to the ODM format, a dialog box containing the errors
appears.

For more information, see Export Wizard options (on page 158).
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Reserved words for RefNames

The following keywords and reserved words cannot be used as RefNames. You can use the following
words as part of a RefName; for example, abstract_1is allowed.

138

Note: You cannot use non-English characters in RefNames.

C#
keywords

e abstract e default
e as e declegate
e base e do

e bool e double
e Dbreak e clse

e Dyte e enum

e case e cvent

e catch e  explicit
e char e null

e checked e extern
e class e false

e const e fixed

e continue e float

e decimal e for

e foreach U
e ooto .
e public .
o if .
e implicit .
e in .
e int .
e interface .
e internal .
o is .
e lock .
e long .

e Microsoft e

L namespace o

new
object
operator
Oracle
out
override
params
private
protected
readonly
ref
return
sbyte

sealed

short e ulong
sizeof e unchecked
stackalloc e unsafe
static e ushort
string e using
struct e virtual
switch e volatile
system e void
this e while
throw o

true o

try .

typeof .

uint .

Oracle keywords

e AFROWID

e CD_COUNT

e DATETIME

e DELETEDFORM

e DELETEDITEM

e TFORMID

e TFORMIDX

e TFORMINDEX

e FORMMNEMONIC
e FORMREV

ITEMSETID
ITEMSETIDX
ITEMSETINDEX
NOTDONE
SECTIONID
SITECOUNTRY
SITEID
SITEMNEMONIC
SITENAME

STUDYVERSIONID

SUBJECTVISITID
SUBJECTVISITREV
SUBJECTID
SUBJECTINITIALS
VISITID
VISITINDEX
VISITMNEMONIC
VISITORDER
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Rules-related keywords

e Current

e Currentlndex

e CurrentValuesIndex

e CurrentAllValuesIndex
e CurrentObjectsIndex

e CurrentAllObjectsIndex

Oracle reserved words

A, ABORT, ACCESS, ACCESSED, ACCOUNT, ACTIVATE, ADD, ADMIN, ADMINISTER,
ADMINISTRATOR, ADVISE, ADVISOR, AFTER, ALGORITHM, ALIAS, ALL, ALLOCATE,
ALLOW, ALL_ROWS, ALTER, ALWAYS, ANALYZE, ANCILLARY, AND, AND_EQUAL,
ANTIJOIN, ANY, APPEND, APPLY, ARCHIVE, ARCHIVELOG, ARRAY, AS, ASC,
ASSOCIATE, AT, ATTRIBUTE, ATTRIBUTES, AUDIT, AUTHENTICATED,
AUTHENTICATION, AUTHID, AUTHORIZATION, AUTO, AUTOALLOCATE,
AUTOEXTEND, AUTOMATIC, AVAILABILITY, BACKUP, BECOME, BEFORE, BEGIN,
BEHALF, BETWEEN, BFILE, BIGFILE, BINARY_DOUBLE,
BINARY_DOUBLE_INFINITY, BINARY_DOUBLE_NAN, BINARY_FLOAT,
BINARY_FLOAT_INFINITY, BINARY_FLOAT_NAN, BINDING, BITMAP, BITS, BLOB,
BLOCK, BLOCKS, BLOCKSIZE, BLOCK_RANGE, BODY, BOTH, BOUND, BROADCAST,
BUFFER, BUFFER_CACHE, BUFFER_POOL, BUILD, BULK, BY,
BYPASS_RECURSIVE_CHECK, BYPASS_UJVC, BYTE, CACHE, CACHE_CB,
CACHE_INSTANCES, CACHE_TEMP_TABLE, CALL, CANCEL, CARDINALITY,
CASCADE, CASE, CAST, CATEGORY, CERTIFICATE, CFILE, CHAINED, CHANGE,
CHAR, CHARACTER, CHAR_CS, CHECK, CHECKPOINT, CHILD, CHOOSE, CHUNK,
CIV_GB, CLASS, CLEAR, CLOB, CLONE, CLOSE, CLOSE_CACHED_OPEN_CURSORS,
CLUSTER, CLUSTERING_FACTOR, COALESCE, COARSE, COLLECT,
COLLECTIONS_GET_REFS, COLUMN, COLUMNS, COLUMN_STATS, COLUMN_VALUE,
COMMENT, COMMIT, COMMITTED, COMPACT, COMPATIBILITY, COMPILE,
COMPLETE, COMPOSITE_LIMIT, COMPRESS, COMPUTE, CONFORMING, CONNECT,
CONNECT_BY_ISCYCLE, CONNECT_BY_ISLEAF, CONNECT_BY_ROOT,
CONNECT_TIME, CONSIDER, CONSISTENT, CONSTRAINT, CONSTRAINTS,
CONTAINER, CONTENT, CONTENTS, CONTEXT, CONTINUE, CONTROLFILE,
CONVERT, CORRUPTION, COST, CPU_COSTING, CPU_PER_CALL, CPU_PER_SESSION,
CREATE, CREATE_STORED_OUTLINES, CROSS, CUBE, CUBE_GB, CURRENT,
CURRENT_DATE, CURRENT_SCHEMA, CURRENT_TIME, CURRENT_TIMESTAMP,
CURRENT_USER, CURSOR, CURSOR_SHARING_EXACT,
CURSOR_SPECIFIC_SEGMENT, CYCLE, DANGLING, DATA, DATABASE, DATAFILE,
DATAFILES, DATAOBJNO, DATE, DATE_MODE, DAY, DBA, DBA_RECYCLEBIN,
DBTIMEZONE, DDL, DEALLOCATE, DEBUG, DEC, DECIMAL, DECLARE,
DECREMENT, DEFAULT, DEFERRABLE, DEFERRED, DEFINED, DEFINER, DEGREE,
DELAY, DELETE, DEMAND, DENSE_RANK, DEREF, DEREF_NO_REWRITE, DESC,
DETACHED, DETERMINES, DICTIONARY, DIMENSION, DIRECTORY, DISABLE,
DISASSOCIATE, DISCONNECT, DISK, DISKGROUP, DISKS, DISMOUNT, DISTINCT,
DISTINGUISHED, DISTRIBUTED, DML, DMI,_ UPDATE, DOCUMENT,
DOMAIN_INDEX_NO_SORT, DOMAIN_INDEX_SORT, DOUBLE, DOWNGRADE,
DRIVING_SITE, DROP, DUMP, DYNAMIC, DYNAMIC_SAMPLING,
DYNAMIC_SAMPLING_EST_CDN, EACH, ELEMENT, ELSE, EMPTY, ENABLE,
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ENCRYPTED, ENCRYPTION, END, ENFORCE, ENFORCED, ENTRY, ERROR,
ERROR_ON_OVERLAP_TIME, ESCAPE, ESTIMATE, EVENTS, EXCEPT, EXCEPTIONS,
EXCHANGE, EXCLUDING, EXCLUSIVE, EXECUTE, EXEMPT,EXISTS,
EXPAND_GSET_TO_UNION, EXPIRE, EXPLAIN, EXPLOSION, EXPORT,
EXPR_CORR_CHECK, EXTEND, EXTENDS, EXTENT, EXTENTS, EEXTERNAL,
EXTERNALLY, EXTRACT, FACT, FAILED, FAILED_LOGIN_ATTEMPTS, FAILGROUP,
FALSE, FAST, FBTSCAN, FIC_CIV, FIC_PIV, FILE, FILTER, FINAL, FINE, FINISH, FIRST,
FIRST_ROWS, FLAGGER, FLASHBACK, FLOAT, FLOB, FLUSH,FOLLOWING, FOR,
FORCE, FORCE_XML_QUERY_REWRITE, FOREIGN, FREELIST, FREELISTS,
FREEPOOLS, FRESH, FROM, FULL, FUNCTION, FUNCTIONS,
GATHER_PLAN_STATISTICS, GBY_CONC_ROLLUP, GENERATED, GLOBAL,
GLOBALLY, GLOBAL_NAME, GLOBAI_TOPIC_ENABLED, GRANT, GROUP,
GROUPING, GROUPS, GROUP_BY, GUARANTEE, GUARANTEED, GUARD, HASH,
HASHKEYS, HASH_AJ, HASH_SJ, HAVING, HEADER, HEAP, HIERARCHY, HIGH,
HINTSET_BEGIN, HINTSET_END, HOUR, HWM_BROKERED, ID, IDENTIFIED,
IDENTIFIER, IDENTITY, IDGENERATORS, IDLE_TIME, IF, IGNORE,
IGNORE_ON_CLAUSE, IGNORE_OPTIM_EMBEDDED_HINTS,
IGNORE,_WHERE_CLAUSE, IMMEDIATE, IMPORT, IN, INCLUDE, VERSION,
INCLUDING, INCREMENT, INCREMENTAL, INDEX, INDEXED, INDEXES,
INDEXTYPE, INDEXTYPES, INDEX_ASC, INDEX_COMBINE, INDEX_DESC,
INDEX_FFS, INDEX_FILTER, INDEX_JOIN, INDEX_ROWS, INDEX_RRS,
INDEX_SCAN, INDEX_SKIP_SCAN, INDEX_SS, INDEX_SS_ASC, INDEX_SS_DESC,
INDEX_STATS, INDICATOR, INFINITE, INFORMATIONAL, INITIAL, INITIALIZED,
INITIALLY, INITRANS, INLINE, INNER, INSERT, INSTANCE, INSTANCES,
INSTANTIABLE, INSTANTLY, INSTEAD, INT, INTEGER, INTEGRITY, INTERMEDIATE,
INTERNAL_CONVERT, INTERNAL_USE, INTERPRETED, INTERSECT,
INTERVAL,INTO, INVALIDATE, IN_MEMORY_METADATA, IS, ISOLATION,
ISOLATION_LEVEL, ITERATE, ITERATION_NUMBER, JAVA, JOB, JOIN, KEEP,
KERBEROS, KEY, KEYFILE, KEYS, KEYSIZE,KEY_LENGTH, KILL, LAST, LATERAL,
LAYER, LDAP_REGISTRATION, LDAP_REGISTRATION_ENABLED,
LDAP_REG_SYNC_INTERVAL, LEADING, LEFT, LENGTH, LESS, LEVEL, LEVELS,
LIBRARY, LIKE, LIKE2, LIKE4, LIKEC, LIKE,_EXPAND, LIMIT, LINK, LIST, LOB, LOCAL,
LOCALTIME, LOCALTIMESTAMP, LOCAL_INDEXES, LOCATION, LOCATOR, LOCK,
LOCKED, LOG, LOGFILE, LOGGING, LOGICAL, LOGICAI, READS_PER_CALL,
LOGICAL_READS_PER_SESSION, LOGOFF, LOGON, LONG, MAIN, MANAGF,
MANAGED, MANAGEMENT, MANUAL, MAPPING, MASTER, MATCHED,
MATERIALIZE, MATERIALIZED, MAX, MAXARCHLOGS, MAXDATAFILES,
MAXEXTENTS, MAXIMIZE, MAXINSTANCES, MAXLOGFILES, MAXLOGHISTORY,
MAXLOGMEMBERS, MAXSIZE, MAXTRANS, MAXVALUE, MEASURES, MEMBER,
MEMORY, MERGE, MERGE_A], MERGE_CONST_ON, MERGE_S], METHOD, MIGRATE,
MIN, MINEXTENTS, MINIMIZE, MINIMUM, MINUS, MINUTE, MINVALUE, MIRROR,
MLSLABEL, MODE, MODEL,MODEL_DONTVERIFY_UNIQUENESS,
MODEL_MIN_ANALYSIS, MODEL_NO_ANALYSIS, MODEL_PBY, MODEL_PUSH_REF,
MODIFY, MONITORING, MONTH, MOUNT, MOVE, MOVEMENT, MULTISET,
MV_MERGE, NAME, NAMED, NAN, NATIONAL, NATIVE, NATURAL, NAV, NCHAR,
NCHAR_CS, NCLOB, NEEDED, NESTED, NESTED_TABLE_FAST_INSERT,
NESTED_TABLE_GET_REFS, NESTED_TABLE_ID, NESTED_TABLE,_SET_REFS,
NESTED_TABLE_SET_SETID, NETWORK, NEVER, NEW, NEXT, NLS_CALENDAR,
NLS_CHARACTERSET, NLS_COMP, NLS_CURRENCY, NLS_DATFE_FORMAT,
NLS_DATE_LANGUAGE, NLS_ISO_CURRENCY, NLS_LANG, NLS_LANGUAGE,
NLS_LENGTH_SEMANTICS, NLS_NCHAR_CONV_EXCP,
NLS_NUMERIC_CHARACTERS, NLS_SORT, NLS_SPECIAL_CHARS, NLS_TERRITORY,
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NL_AJ, NL_SJ, NO, NOAPPEND, NOARCHIVELOG, NOAUDIT, NOCACHE,
NOCOMPRESS, NOCPU_COSTING, NOCYCLE, NODELAY, NOFORCE,
NOGUARANTEE, NOLOGGING, NOMAPPING, NOMAXVALUE, NOMINIMIZE,
NOMINVALUE, NOMONITORING, NONE, NOORDER, NOOVERRIDE, NOPARALLEL,
NOPARALLEL_INDEX, NORELY, NOREPAIR, NORESETLOGS, NOREVERSE,
NOREWRITE, NORMAL, NOROWDEPENDENCIES, NOSEGMENT, NOSORT,
NOSTRICT, NOSWITCH, NOT, NOTFOUND, NOTHING, NOVALIDATE, NOWAIT,
NO_ACCESS, NO_BASETABLE_MULTIMV_REWRITE, NO_BUFFER,
NO_CPU_COSTING, NO_EXPAND, NO_EXPAND_GSET_TO_UNION, NO_FACT,
NO_FILTERING, NO_INDEX, NO_INDEX_FFS, NO_INDEX_SS, NO_MERGE,
NO_MODEL_PUSH_REF, NO_MONITORING, NO_MULTIMV_REWRITE,
NO_ORDER_ROLLUPS, NO_PARALLEL, NO_PARALLEL_INDEX,
NO_PARTIAL_COMMIT, NO_PRUNE_GSETS, NO_PUSH_PRED, NO_PUSH_SUBQ,
NO_QKN_BUFF, NO_QUERY_TRANSFORMATION, NO_REF_CASCADE,
NO_REWRITE, NO_SEMIJOIN, NO_SET_TO_JOIN, NO_STAR_TRANSFORMATION,
NO_STATS_GSETS, NO_SWAP_JOIN_INPUTS, NO_UNNEST, NO_USE_HASH,
NO_USE_MERGE, NO_USE_NL, NO_XMI,_QUERY_REWRITE, NULL, NULLS, NUMBER,
NUMERIC, NVARCHAR2, OBJECT, OBJNO, OBJNO_REUSE, OF, OFF, OFFLINE, OID,
OIDINDEX, OLD, ON, ONLINE, ONLY, OPAQUE, OPAQUE_TRANSFORM,
OPAQUE_XCANONICAL, OPCODE, OPEN, OPERATOR, OPTIMAL,
OPTIMIZER_FEATURES_ENABLE, OPTIMIZER_GOAL, OPTION, OPT_ESTIMATE, OR,
ORA_ROWSCN, ORDER, ORDERED, ORDERED_PREDICATES, ORGANIZATION,
OR_EXPAND, OUTER, OUTLINE, OUT_OF_LINE, OVER, OVERFLOW,
OVERFLOW_NOMOVE, OVERLAPS, OWN, PACKAGE, PACKAGES, PARALLEL,
PARALLEL_INDEX, PARAMETERS, PARENT, PARITY, PARTIALLY, PARTITION,
PARTITIONS, PARTTTION_HASH, PARTITION_LIST, PARTTTION_RANGE, PASSWORD,
PASSWORD_GRACE_TIME, PASSWORD_LIFE_TIME, PASSWORD_LOCK_TIME,
PASSWORD_REUSE_MAX, PASSWORD_REUSE_TIME,
PASSWORD_VERIFY_FUNCTION, PCTFREE, PCTINCREASE, PCTTHRESHOLD,
PCTUSED, PCTVERSION, PERCENT, PERFORMANCE, PERMANENT, PFILE, PHYSICAL,
PIV_GB, PIV_SSF, PLAN, PLSQL_CODE_TYPE, PLSQL_DEBUG,
PLSQL_OPTIMIZE_LEVEL, PLSQL_WARNINGS, POLICY, POST_TRANSACTION,
POWER, PQ_DISTRIBUTE, PQ_MAP, PQ_NOMAP, PREBUILT, PRECEDING, PRECISION,
PREPARE, PRESENT, PRESERVE, PRIMARY, PRIOR, PRIVATE, PRIVATE_SGA,
PRIVILEGE, PRIVILEGES, PROCEDURE, PROFILE, PROGRAM, PROJECT, PROTECTED,
PROTECTION, PUBLIC, PURGE, PUSH_PRED, PUSH_SUBQ, PX_GRANULE, QB_NAME,
QUERY, QUERY_BLOCK, QUEUE, QUEUE_CURR, QUEUE_ROWP, QUIESCE, QUOTA,
RANDOM, RANGE, RAPIDLY, RAW, RBA, READ, READS, REAL, REBALANCE,
REBUILD, RECORDS_PER_BLOCK, RECOVER, RECOVERABLE, RECOVERY, RECYCLE,
RECYCLEBIN, REDUCED, REDUNDANCY, REF, REFERENCE, REFERENCED,
REFERENCES, REFERENCING, REFRESH, REF_CASCADE_CURSOR, REGEXP_LIKFE,
REGISTER, REJECT, REKEY, RELATIONAL, RELY, REMOTE_MAPPED, RENAME,
REPAIR, REPLACE, REQUIRED, RESET, RESETLOGS, RESIZE, RESOLVE, RESOLVER,
RESOURCE, RESTORE_AS_INTERVALS, RESTRICT, RESTRICTED,
RESTRICT_ALL_REF_CONS, RESUMABLE, RESUME, RETENTION, RETURN,
RETURNING, REUSE, REVERSE, REVOKE, REWRITE, REWRITE_OR_ERROR, RIGHT,
ROLE, ROLES, ROLLBACK, ROLLUP, ROW, ROWDEPENDENCIES, ROWID,
ROWLABEL, ROWNUM, ROWS, ROW_LENGTH, RULE, RULES, SAMPLE, SAVEPOINT,
SAVE_AS_INTERVALS, SB4, SCALE, SCALE_ROWS, SCAN, SCAN_INSTANCES,
SCHEDULER, SCHEMA, SCN, SCN_ASCENDING, SCOPE, SD_ALL, SD_INHIBIT,
SD_SHOW,SECOND, SECURITY, SEED, SEGMENT, SEG_BLOCK, SEG_FILE, SELECT,
SELECTIVITY, SEMIJOIN, SEMIJOIN_DRIVER, SEQUENCE, SEQUENCED,
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SEQUENTIAL, SERIALIZABLE, SERVERERROR, SESSION, SESSIONS_PER_USER,
SESSIONTIMEZONE, SESSIONTZNAME, SESSION_CACHED_CURSORS, SET, SETS,
SETTINGS, SET_TO_JOIN, SEVERE, SHARE, SHARED, SHARED_POOL, SHRINK,
SHUTDOWN, SIBLINGS, SID, SIMPLE, SINGLE, SINGLETASK, SIZE, SKIP,
SKIP_EXT_OPTIMIZER, SKIP_UNQ_UNUSABLE_IDX, SKIP_UNUSABLE_INDEXES,
SMALLFILE, SMALLINT, SNAPSHOT, SOME, SORT, SOURCE, SPACE, SPECIFICATION,
SPFILE, SPLIT, SPREADSHEET, SQL, SQLBUF, SQLLDR, SQL_TRACE, STANDBY, STAR,
START, STARTUP, STAR_TRANSFORMATION, STATEMENT_ID, STATIC, STATISTICS,
STOP, STORAGE, STORE, STREAMS, STRICT, STRIP, STRUCTURE, SUBMULTISET,
SUBPARTITION, SUBPARTITIONS, SUBPARTITION_REL, SUBSTITUTABLE,
SUCCESSFUL, SUMMARY, SUPPLEMENTAL, SUSPEND, SWAP_JOIN_INPUTS, SWITCH,
SWITCHOVER, SYNONYM, SYSAUX, SYSDATE, SYSDBA, SYSOPER, SYSTEM,
SYSTIMESTAMP, SYS_DI, CURSOR, SYS_FBT_INSDEL, SYS_OP_BITVEC, SYS_OP_CAST,
SYS_OP_COI,_PRESENT, SYS_OP_ENFORCE_NOT_NULLS, SYS_OP_MINE_VALUE,
SYS_OP_NOEXPAND, SYS_OP_NTCIMGS$, SYS_PARALLEL_TXN, SYS_RID_ORDER,
TABLE, TABLES, TABLESPACE, TABLESPACE_NO, TABLE_STATS, TABNO, TEMPFILE,
TEMPLATE, TEMPORARY, TEST, THAN, THE, THEN, THREAD, THROUGH, TIME,
TIMEOUT, TIMESTAMP, TIMEZONE_ABBR, TIMEZONE_HOUR, TIMEZONE_MINUTE,
TIMEZONE_REGION, TIME_ZONE, TIV_GB, TIV_SSF, TO, TOPLEVEL, TRACE,
TRACING, TRACKING, TRAILING, TRANSACTION, TRANSITIONAL, TREAT,
TRIGGER, TRIGGERS, TRUE, TRUNCATE, TRUSTED, TUNING, TX, TYPE, TYPES,
TZ_OFFSET, UB2, UBA, UID, UNARCHIVED, UNBOUND, UNBOUNDED, UNDER,
UNDO,UNDROP, UNIFORM, UNION, UNIQUE, UNLIMITED, UNLOCK, UNNEST,
UNPACKED, UNPROTECTED, UNQUIESCE, UNRECOVERABLE, UNTIL, UNUSABLE,
UNUSED, UPDATABLE, UPDATE, UPDATED, UPD_INDEXES, UPD_JOININDEX,
UPGRADE, UPSERT, UROWID, USAGE, USE, USER, USER_DEFINED,
USER_RECYCLEBIN, USE_ANTI, USE_CONCAT, USE_HASH, USE_MERGE, USE_NIL,
USE_NL_WITH_INDEX, USE_PRIVATE_OUTLINES, USE_SEMI,
USE_STORED_OUTLINES, USE_TTT_FOR_GSETS, USE_WEAK_NAME_RESL, USING,
VALIDATE, VALIDATION, VALUE, VALUES, VARCHAR, VARCHAR2, VARRAY,
VARYING, VECTOR_READ, VECTOR_READ_TRACE, VERSION, VERSIONS, VIEW,
WAIT, WELLFORMED, WHEN, WHENEVER, WHERE, WHITESPACE, WITH, WITHIN,
WITHOUT, WORK, WRITE, XID, XMLATTRIBUTES, XMLCOLATTVAL, XMLELEMENT,
XMLFOREST, XMLPARSE, XMLSCHEMA, XMLTYPE, X_DYN_PRUNE, YEAR, ZONE

InForm reserved words

_SYS_CHANGEDINFO, _SYS_CLEARCRF_CHANGEDINFO,
_SYS_CLEARCRF_NEWINFO, _SYS_CLEARCRF_TRANSCRERROR,
_SYS_EA_CANDTYPE, _SYS_EA_OPENTYPE, _SYS_editl, _SYS_edit2, _SYS_edit3,
_SYS_LOCALE_PLACEHOLDER, _SYS_NEWINFO, _SYS_no, _SYS_None, _SYS_PSC_NO,
_SYS_PSC_UNKNSTR, _SYS_PSC_YES, _SYS_QUERYACTION_ANSWER,
_SYS_QUERYSTATE_CANDIDATE, _SYS_QUERYSTATE_OPEN, _SYS_SC_Disabled,
_SYS_SC_Enabled, _SYS_TRANSCRERROR, _SYS_TRIAL_DEPLOYMENT_EM,
_SYS_TRIAL_DEPLOYMENT_READONLY_EM, _SYS_UNK, _SYS_UNKN,
_SYS_UNKNSTR, _SYS_UR_ODM_SUBMIT_EM,
_SYS_UR_PORTAI_ADDEDITSECTIONS_EM, _SYS_UR_PORTAI_ADDEDITTABS_EM,
_SYS_UR_PORTAIL_ADMIN_EM, _SYS_UR_PORTAI_UPDATECOMPANYLOGO_EM,
_SYS_UR_PORTAL_UPDATEHOMEPAGE_EM,
_SYS_UR_PORTAL_UPLOADUPDATEDOCS_EM,
_SYS_UR_QRY_RSPND_TO_QUERY_EM, _SYS_yes, AboutInForm, ACTIVE_RB,
ACTIVE_SC, ADDRESS1, ADDRESS2, AdminDBSvt, AdminDBTtl, AdminHelp,
ALT_PHONE_NUM, ASNQUERY_ITEM, ASNRIGHT_ITEM, ASNSIGNATURE_ITEM,
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ASNSITE_ITEM, AU_Address_ SECT, AU_AltPhoneNum_ITEM, AU_AltPhoneNum_TC,
AU_BeeperNum_ITEM, AU_BeeperNum_TC, AU_City_ITEM, AU_City_TC,
AU_Contact_SECT, AU_Country_ITEM, AU_Country_TC, AU_DayPhoneNum_ITEM,
AU_DayPhoneNum_TC, AU_Description_ITEM, AU_Description_TC, AU_DisplayName_ITEM,
AU_DisplayName_TC, AU_EMailAddr_ITEM, AU_EMailAddr_TC, AU_FaxNum_ITEM,
AU_FaxNum_TC, AU_FirstName_ITEM, AU_FirstName_TC, AU_FORM,
AU_HomePage_ITEM, AU_HomePage TC, AU_LastName_ITEM, AU_LastName_TC,
AU_Misc_SECT, AU_PotalCode_ITEM, AU_PotalCode_TC, AU_StateProv_ITEM,
AU_StateProv_TC, AU_Street_ ITEM, AU_Street_TC, AU_Street2 ITEM, AU_Street2_TC,
AU_Title_ITEM, AU_Title_TC, AU_UserActive_CB, AU_UserActive_ CBC, AU_UserActive_EM,
AU_UserActive_ITEM, AU_UserBasic_SECT, AU_userImgFile ITEM,AU_userImgFile_TC,
AU_UserName_ITEM, AU_UserName_TC, AU_UserProductlocale,
AU_UserResetPassword_ITEM, AU_UserStudyLocale,
AU_UserType_INTEGRATION_USER_EM, AU_UserType INTEGRATION_USER_RB,
AU_UserType_ITEM, AU_UserType_RBC, AU_UserType_SITE_USER_EM,
AU_UserType_SITE_USER_RB, AU_UsetType_SPONSOR_USER_EM,
AU_UserType_SPONSOR_USER_RB, AU_UserType_SUPPORT_USER_EM,
AU_UserType_SUPPORT_USER_RB, AU_YESNO_RADIO, AUTGFORM, AUTGSECTION,
AutoAnswerManualQueries, BEEPER_NUMBER, BROW, CALC, CALCACTION,
CALCDEPEND, CALCTRIGGER, CBG_AUTOMATED_DEPLOYMENT_CBC,
CBG_AUTOMATED_DEPLOYMENT_ITEM, CBG_CRBADMIN_CBC,
CBG_CRBADMIN_ITEM, CBG_CRFADMIN_CBC, CBG_CRFADMIN_ITEM,
CBG_DVADMIN_CBC, CBG_DVADMIN_ITEM, CBG_NAVIGATE_CBC,
CBG_PORTAL_CBC, CBG_PORTAL_ITEM, CBG_QUERYADMIN_CBC,
CBG_QUERYADMIN_ITEM, CBG_RULEADMIN_CBC, CBG_RULEADMIN_ITEM,
CBG_USERADMIN_CBC, CBG_USERADMIN_ITEM, CBG_USERMISC_CBC,
CBG_USERMISC_ITEM, CBG_WEBSERVICE_CBC, CBG_WEBSERVICE_ITEM,
CHANGEREASONITEM, CHANGEREASONPULLDOWN, CHANGEREASONRADIO,
CHANGEREASONSECTION, CITY, CLEARCRF_CHANGEREASONITEM,
CLEARCRF_CHANGEREASONPULLDOWN, CLEARCRF_CHANGEREASONRADIO,
CLEARCRF_CHANGEREASONSECTION, CLEARCRF_OTHERREASONTEXT,
CLEARCRFFORM, COMMENTDATE, COMMENTDATECTL, COMMENTENTEREDBY,
COMMENTENTEREDBYCTL, COMMENTFORM, CONFLICT_DATE, CONFLICT_INFO,
CONFLICT_VISIT_NAME, CONV, COUNTRY, CRB, CRBADMIN_SECT,
CREATEGROUPFORM, CREATEGROUPSECTION, CRFADMIN_SECT,
CURRENTCOMMENTFORMSECTION, DateFormat_PC, DAY_PHONE_NUM,
DEPLOYMENT_SECT, DESCRIPTION_EF, DESCRIPTION_ITEM, DestinationServer,
DestinationServer_CTL, DICTIONARY, DTC_EnteredDate, DTC_SiteStudylnitiationDate,
DTC_SiteStudyTerminationDate, Duration, Duration_ CTL, DVADMIN_SECT,
EA_QUERYTEXT, EA_QUERYTYPE, EA_REFNAME, EDITCOMMENTFORMSECTION,
EDITDATE, EDITDATECTL, EDITENTEREDBY, EDITENTEREDBYCTL, EDITITEM,
editReasonPulldown, EDITRULESECTION, Elem_DD_MM_YYYY,

Elem_FIRST NAME_LAST NAME, Elem_LAST NAME_FIRST NAME,
Elem_MM_DD_YYYY, Elem_QuerySelection, Elem_YYYY_MM_DD, EMAIL, ADDRESS,
EndTransaction_CTL, EPScript, EVENT_DDL, EVENT_ITEM, EventAddForm,
EventAddSection, FAQCTL, FAQFORM, FAQFORMSECTION, FAQITEM,
FAX_PHONE_NUM, FORGOTPASSWORDSECTION, Freeze CRB, Freeze CRF, GettingHelp,
GroupAddDescription_ITEM, GroupAddDescription_TC, GroupAddName_ITEM,
GroupAddName_TC, GroupAddProp_FORM, GroupAddProp_SECT, GroupAddType_ITEM,
GroupAddType_TC, GroupDescription_ITEM, GroupDescription_TC, GroupEdtProp_ FORM,
GroupEdtProp_SECT, GROUPLIST_DDL, GROUPLIST_LB, GROUPNAME_EF,
GROUPNAME_ITEM, GroupName_ITEM_1, GroupName_TC, GroupRightsList_ ITEM,
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GroupRightsList TC, GroupSelectForm, GroupType_ITEM, GroupType_TC,
GroupUserList_ITEM, GroupUsetList TC, GRP_QUERY_SELECTION_ITEM,
GRP_QUERY_SELECTION_PD, GRP_REPORTING_SELECTION_ITEM,
GRP_REPORTING_SELECTION_LB, GRP_RIGHTS_SELECTION_ITEM,
GRP_RIGHTS_SELECTION_PD, GRP_SIGNATURE_SELECTION_ITEM,
GRP_SIGNATURE_SELECTION_PD, GRP_SITE_SELECTION_ITEM,
GRP_SITE_SELECTION_LB, GRP_USER_NAME_ITEM, GRP_USER_NAME_TC,
GRPDESCRIPTION_EF, GRPDESCRIPTION_ITEM, GrpQuery_RB, GrpQuery_SC,
GrpRights_RB, GrpRights_SC, GrpSignature_RB, GrpSignature_SC, GRPTYPE_ITEM,
GRPTYPE_RB, HELPTEXT_ITEM, HELPTEXT TXT, INACTIVE_RB, INACTIVE_SC,
INFORM_DLIL_VERSIONS_ITEM, INFORM_DLIL,_VERSIONS_LB, InSyncLogSummary,
INTEGRATION_SECT, Item_ClientID, Item_Conflict, [tem_CRBAffidavit, [tem_CRBForm,
Item_CRBMeaning, Item_CRFAffidavit, Item_CRFMeaning, Item_DateFormat, Item_DictCulture,
Item_DictType, Item_DictVersion, Item_Disabled, Item_EnteredDate, Item_GroupDescription,
Item_GroupName, Item_ListOfContextInfo, Item_ListOfCRFForms,
Item_ListOfInvGroupForms, Item_ListOfInvUserForms, Item_ListOfPatients, Item_ListOfRights,
Item_ListOfTargets, Item_ListOfVerbatimTypes, Item_NavigationMode, Item_SiteAddress1,
Item_SiteAddress2, Item_SiteAltPhoneNumber, Item_SiteBeeper, Item_SiteCity,
Item_SiteContactUser, Item_SiteCountry, Item_SiteDayPhoneNumber, Item_SiteEmailAddress,
Item_SiteFaxNumber, Item_SiteMnemonic, Item_SitePostalCode, Item_SiteServer,
Item_SiteStateProvince, Item_SiteStudylnitiationDate, Item_SiteStudyLocale,
Item_SiteStudyTerminationDate, Item_SiteSV AutoSelectRate, Item_SiteSVFirstNSubjects,
Item_SiteTimeZone, Item_SiteUserNameOtder, Item_SubjectGUID, Item_UPUserName,
Ttem_UserActiveState, Item_UserAddress1, Item_UserAddress2, Item_UserAltPhoneNumber,
Item_UserAuthType, Item_UserBeeper, Item_UserCity, Item_UserCountry,
Item_UserDayPhoneNumber, Item_UserDeleteState, Item_UserDescription,
Item_UserDisplayName, Item_UserEmailAddress, Item_UserFaxNumber, Item_UserFirstName,
Item_UserHashType, Item_UserHomeScreenURL, FAQFORM, FAQFORMSECTION,
FAQITEM, FAX_PHONE_NUM, FORGOTPASSWORDSECTION, Freeze CRB, Freeze CRF,
GettingHelp, GroupAddDescription_ITEM, GroupAddDescription_TC, GroupAddName_ITEM,
GroupAddName_TC, GroupAddProp_FORM, GroupAddProp_SECT, GroupAddType_ITEM,
GroupAddType_TC, GroupDescription_ITEM, GroupDescription_TC, GroupEdtProp_ FORM,
GroupEdtProp_SECT, GROUPLIST_DDL, GROUPLIST_LB, GROUPNAME_EF,
GROUPNAME_ITEM, GroupName_ITEM_1, GroupName_TC, GroupRightsList_ ITEM,
GroupRightsList_TC, GroupSelectForm, GroupType_ITEM, GroupType_TC,
GroupUserList_ITEM, GroupUserList 'TC, GRP_QUERY_SELECTION_ITEM,
GRP_QUERY_SELECTION_PD, GRP_REPORTING_SELECTION_ITEM,
GRP_REPORTING_SELECTION_LB, GRP_RIGHTS_SELECTION_ITEM,
GRP_RIGHTS_SELECTION_PD, GRP_SIGNATURE_SELECTION_ITEM,
GRP_SIGNATURE_SELECTION_PD, GRP_SITE_SELECTION_ITEM,
GRP_SITE_SELECTION_LB, GRP_USER_NAME_ITEM, GRP_USER_NAME_TC,
GRPDESCRIPTION_EF, GRPDESCRIPTION_ITEM, GrpQuery_RB, GrpQuery_SC,
GrpRights_RB, GrpRights_SC, GrpSignature_RB, GrpSignature_SC, GRPTYPE_ITEM,
GRPTYPE_RB, HELPTEXT_ITEM, HELPTEXT_ TXT, INACTIVE_RB, INACTIVE_SC,
INFORM_DLL_VERSIONS_ITEM, INFORM_DLL_VERSIONS_LB, InSyncLogSummary,
INTEGRATION_SECT, Item_ClientID, Item_Conflict, Item_CRBAffidavit, Item_CRBForm,
Item_CRBMeaning, Item_CRFAffidavit, Iltem_CRFMeaning, Item_DateFormat, [tem_DictCulture,
Item_DictType, Item_DictVersion, Item_Disabled, Item_EnteredDate, Item_GroupDescription,
Item_GroupName, Item_ListOfContextInfo, Item_ListOfCRFForms,
Item_ListOfInvGroupForms, Item_ListOfInvUserForms, Item_ListOfPatients, Item_ListOfRights,
Item_ListOfTargets, Item_ListOfVerbatimTypes, Item_NavigationMode, Item_SiteAddress1,
Item_SiteAddress2, Item_SiteAltPhoneNumber, Item_SiteBeeper, Item_SiteCity,
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Item_SiteContactUser, Item_SiteCountry, Item_SiteDayPhoneNumber, Item_SiteEmailAddress,
Item_SiteFaxNumber, Item_SiteMnemonic, Item_SitePostalCode, Item_SiteServer,
Item_SiteStateProvince, Item_SiteStudylnitiationDate, Item_SiteStudyLocale,
Item_SiteStudyTerminationDate, Item_SiteSV AutoSelectRate, Item_SiteSVFirstNSubjects,
Item_SiteTimeZone, Item_SiteUserNameOrder, Item_SubjectGUID, Item_UPUserName,
Ttem_UserActiveState, Item_UserAddress1, Item_UserAddress2, Item_UserAltPhoneNumber,
Item_UserAuthType, Item_UserBeeper, Item_UserCity, Item_UserCountry,
Item_UserDayPhoneNumber, Item_UserDeleteState, Item_UserDescription,
Item_UserDisplayName, Item_UserEmailAddress, Item_UserFaxNumber, Item_UserFirstName,
Item_UserHashType, Item_UserHomeScreenURL, Item_UserlmagelD, Item_UserLanglD,
Ttem_UserLastName, Item_UserName, [tem_UserPassword, Item_UserPostalCode,
Ttem_UserProductlocale, Item_UserResetPassword, Item_UserSalt, Item_UserStateProvince,
Item_UserStudyLocale, Item_UserTitle, Item_UserTrustPEUID, Item_UserType, Item_UUID,
ITEMGRP, ITEMNAME, ITEMSETROWCOMMENTFORM, List_ListOfContextlnfo,
List_ListOfCRFForms, List_ListOfInvGroupForms, List_ListOfInvUserForms,
List_ListOfPatients, List_ListOfRights, List_ListOfTargets, List_ListOfVerbatimTypes, Lock CRB,
Lock CRF, MachineName, MANAGER_USER_EM, Mark CRB, Mark CRF, MNGRGRP, NA,
NAMECTL, NAMEITEM, NAVIGATE_ITEM, NAVIGATE_SECT, ND, Item_UserImagelD,
Item_UserLanglD, Item_UserLastName, Item_UserName, Item_UserPassword,
Item_UserPostalCode, Item_UserProductlocale, Item_UserResetPassword, Item_ UserSalt,
Item_UserStateProvince, Item_UserStudyLocale, Item_UserTitle, Item_UserTrustPEUID,
Item_UserType, Item_UUID, ITEMGRP, ITEMNAME, ITEMSETROWCOMMENTFORM,
List_ListOfContextlnfo, List_ListOfCRFForms, List_ListOflnvGroupForms,
List_ListOfInvUserForms, List_ListOfPatients, List_ListOfRights, List_ListOfTargets,
List_ListOfVerbatimTypes, Lock CRB, Lock CRF, MachineName, MANAGER_USER_EM, Mark
CRB, Mark CRF, MNGRGRP, NA, NAMECTL, NAMEITEM, NAVIGATE_ITEM,
NAVIGATE_SECT, ND, NEWCOMMENTTEXTCTL, NEWCOMMENTTEXTITEM,
NEWPASSWORDCONFIRMCTL, NEWPASSWORDCONFIRMITEM, NEWPASSWORDCTL,
NEWPASSWORDITEM, no0, NOFAQ, None, NUMYESNORADIO, off,
OLDCOMMENTTEXTCTL, OLDCOMMENTTEXTITEM, on, OTHERREASONTEXT,
OutSyncLogSummary, PASSWORDCTL, PASSWORDITEM, PASSWORDSECTION,
PORTAI_SECT, POSTAL_CODE, PRODUCTLOCALE,
PSC_CHANGEREASONPULLDOWN, PSC_CURRENTSITE_CONTROL,
PSC_CURRENTSITE_ITEM, PSC_FORM, PSC_NEWSITE_CONTROL,
PSC_NEWSITE_ITEM, PSC_NO, PSC_NO_NEWSITE_CONTROL,
PSC_NO_NEWSITE_ITEM, PSC_NO_QUERIES_CONTROL, PSC_NO_QUERIES_ITEM,
PSC_NO_SIGNATURES_CONTROL, PSC_NO_SIGNATURES_ITEM,
PSC_NO_SOURCEVERIFICATION_CONTROL,
PSC_NO_SOURCEVERIFICATION_ITEM, PSC_OTHERREASONTEXT,
PSC_PATIENTNUMBER_CONTROL, PSC_PATIENTNUMBER_ITEM,
PSC_QUERIES_CONTROL, PSC_QUERIES_ITEM, PSC_REASON_CONTROL,
PSC_REASON_ITEM, PSC_REASON11, PSC_REASON21, PSC_REASON3, PSC_SECT,
PSC_SECT2, PSC_SIGNATURES_CONTROL, PSC_SIGNATURES_ITEM,
PSC_SOURCEVERIFICATION_CONTROL, PSC_SOURCEVERIFICATION_ITEM,
PSC_YES, PWDAUTH, QUERYA_AMBIGUOUS, QUERYA_CHNGDATA,
QUERYA_MEASURSKIPPED, QUERYA_NOTINPATIENTREC,
QUERYA_ORIGCORRECT, QUERYACTION, QUERYACTION_CLOSE,
QUERYACTION_CREATECANDIDATE, QUERYACTION_CREATEOPEN,
QUERYACTION_DELETE, QUERYACTION_PLACEOPEN,
QUERYACTION_REISSUECANDIDATE, QUERYACTION_REISSUEOPEN,
QUERYACTION_RESOLVE, QUERYACTIONPULLDOWNCTL, QUERYADMIN_SECT,
QUERYANSWER, QUERYANSWEROTHERTEXTCTL, QUERYANSWERPULLDOWNCTL,
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QUERYANSWERRADIOGROUPCTL, QUERYDATE, QUERYDATECTL,
QUERYENTEREDBY, QUERYENTEREDBYCTL, QUERYFORM, QUERYFORM?2,
QUERYFORMSECTION, QUERYFORMSECTION2, QUERYGRP,
QUERYQ_DATADIFFSRC, QUERYQ_ITEMINCOMPLETE, QUERYQ_MISSINGUNIT,
QUERYQ_SPECTEXT, QUERYREASON, QUERYREASONDUMMYSTRINGSTUBNEW,
QUERYREASONOTHERTEXTCTL, QUERYREASONPULLDOWNCTL,
QUERYREASONRADIOGROUPCTL, QUERYREISSUEOTHERTEXTCTL,
QUERYREISSUEPULLDOWNCTL, QUERYREISSUERADIOGROUPCTL,
QUERYREISSUETEXT, QuerySelection_El, QuerySelection_PC, QUERYSTATE,
QUERYSTATE_ANSWER, QUERYSTATE_CLOSE, QUERYSTATEPULLDOWNCTL,
QUERYTEXT, QUERYTEXTOTHERTEXTCTL, QUERYTEXTPULLDOWNCTL,
QUERYTEXTRADIOGROUPCTL, RAND, REASONINCOMPLETERADIOGROUPCTL,
REASONINCOMPLETERADIOGROUPITEM, REFNAME_EF, REFNAME_ITEM,
ReportDesc, REPORTINGGRP, RIGHTGRP, RIGHTS_GROUP_NAME_ITEM,
RIGHTS_GROUP_NAME_TC, RightsForm, RULE, RULEACTION, RULEADMIN_SECT,
RULEDEPEND, RULEEDITFORM, RuleltemEditForm, RuleltemSection, RULETEXT_ITEM,
RULETEXT_TXT, RULETRIGGER, RULETYPE_DDL, RULETYPE_ITEM,
SC_AdminDBSvt, SC_AdminDBSvrCDDCLSID, SC_AdminDBSvtCDDMTSID,
SC_AdminDBSvrDescrip, SC_AdminDBSvrName, SC_AdminDBSvrNTPwd,
SC_AdminDBSvtNTUserName, SC_AdminDBSvrRule CLSID, SC_AdminDBSvtRuleMTSID,
SC_AdminDBSvtStartup, SC_AdminDBSvrTtial CLSID, SC_AdminDBSvtTtialMISID,
SC_AdminDBSvtTxCLSID, SC_AdminDBTtl, SC_AdminDBTtlApproval,
SC_AdminDBTtICDDDSNS, SC_AdminDBTtICDDMode, SC_AdminDBTtIDBType,
SC_AdminDBTrlDeployBackupFolder, SC_AdminDBTrlDescrip, SC_AdminDBTrlHost,
SC_AdminDBTIMaintenance, SC_AdminDBTtIName, SC_AdminDBTtINTPwd,
SC_AdminDBTtINTUserName, SC_AdminDBTtIRandDSN, SC_AdminDBTtlRandPID,
SC_AdminDBT1lRandUID, SC_AdminDBTtlReportDSN, SC_AdminDBTtlReportPID,
SC_AdminDBTrlReportUID, SC_AdminDBTlStartup, SC_AdminDBTtITrial DSN,
SC_AdminDBT1ITtialPID, SC_AdminDBTtTrialUID, SC_AdminDBTITXT,
SC_AdminDBT1lType, SC_AdminDBTtIURL, SC_ALLOWEDRULEOBJECTS,
SC_ALLOWEDRULEOBJECTSText, SC_AllowPasswordReuse, SC_AutoAnswerManualQueries,
SC_DaysPasswordExpiration, SC_Disabled, SC_DisplayTrafficLightlcons,
SC_Elem_FIRST_NAME_LAST_NAME, SC_Elem_LAST_NAME_FIRST_NAME,
SC_EmailForForgotPasswordNotification, SC_EmailForNewSiteAndUserNotification, SC_Enabled,
SC_EnabledRADIO, SC_EnableForgotPassword, SC_EnforceVisitDate,
SC_EnrollWithIncompleteForms, SC_ExecutionPlanServer, SC_FormSavelnlineDuration,
SC_FormSaveNotificationMode, SC_FormSaveRADIO, SC_InactivateRetryCount, SC_Inline,
SC_InlineDurationControl, SC_MaxNumOfResubmissions, SC_MedMLInstallerServer,
SC_MinPasswordLength, SC_MinutesReauthenticate, SC_MinutesReldentification,
SC_NumOfExePlanListenThreads, SC_OneNonAlphaNumericCharactet,
SC_OneNumericalCharacter, SC_OneUppercaseCharacter, SC_PatientSequence,
SC_PFReportingUserName, SC_PFReportingUserPW, SC_Popup,
SC_PostQueryForConflictResolution, SC_QueryMaxLength, SC_QuerySelection,
SC_RandCentralStratified, SC_RandomizationSrc, SC_RandSimpleCentral,
SC_RandSimpleCentralSRC, SC_RandSimpleSite, SC_RandSimpleSiteSRC, SC_RandStratifiedBySite,
SC_RandStratifiedBySiteSRC, SC_ReadOnly, SC_ReportingAuthenticationNamespace,
SC_ReportingCAPAdminDB, SC_ReportingCAPAdminPW, SC_ReportingCAPAdminUser,
SC_ReportingDB, SC_Reportinglnternal URI, SC_Reportinglnternal URIControl, SC_ReportingPW,
SC_ReportingServer, SC_ReportingUserRoot, SC_RequireCommentForNA, SC_ScreeningSequence,
SC_ServerFriendlyName, SC_SPONSOREDITFROZEN, SC_SSLFlag, SC_TrialCenterUtl,
SC_TrialCenterUtrlControl, SC_TrialOrglD, SC_TrialOrglDControl, SC_UNC_DownloadDirectory,
SC_UNIQUEINTLDOBSWTCH, SC_UNIQUEPATIDSWTCH, SC_UserNameOrdert,

Oracle® Health Sciences Central Designer 2.1.2



User Guide

SC_USERNAMEORDER_PC, SC_ViewCRFSignList, SC_Virtual DownloadDirectory,
SC_VISITCALCULATORENABLED, SC_VisitCalculatorEnabledRADIO, ScreenDesc,
Section_Dict, Section_Group, Section_ListOfPatients, Section_ListOfRights, Section_Signature,
Section_Site, Section_UserInfo, Section_UserPassword, SectionRefName, SIGNGRP, Site,
SITE_MNEMONIC, SITE_NAME, SITE_SERVER, SITE_STUDYLOCALE,
SITE_STUDYLOCALE_PC, SITE_USERNAMEORDER, SITE_USERNAMEORDER_PC,
SiteForm, SITEGRP, SMP_MANAGER_USER, SourceServer, SourceServer_CTL, ssl_flag,
StartTransaction_CTL, STATE_PROVINCE, STATUS_ITEM, STATUS_RB, Study,
STUDYLOCALE, STUDYVERSION, SyncDate, SyncDate_CTL, SyncErrorInfo, SyncFileMedia,
SyncFileMedia_CTL, SyncFileProgtess, SyncFileProgress_CTL, SyncFileTransfer, SyncHistory,
SyncHistoryLog, SyncLog_CTL, SyncLogErrorInfo, SyncLogSummary, SyncLogTransactionCount,
SyncNumberAcknowledged, SyncNumberConfirmed, SyncNumberErrors,
SyncNumberInboundTransactions, SyncNumberOutboundTransactions, SyncNumberProcessed,
SyncNumberQueued, SyncNumberSent, SYS_ CONFLICT, SYSCFG, SYSCFGNOEDIT,
SYSCFGOPTIONS, SYSCFGSEC, SYSFORMS, SYSINFO_DB_DRIVER_ITEM,
SYSINFO_DB_DRIVER_TC, SYSINFO_DB_NAME_ITEM, SYSINFO_DB_NAME_TC,
SYSINFO_DB_SECT, SYSINFO_DB_VERSION_ITEM, SYSINFO_DB_VERSION_TC,
SYSINFO_IIS_VERSION_ITEM, SYSINFO_IIS_VERSION_TC,
SYSINFO_INFORM_PRODUCT_LOCALE_ITEM,
SYSINFO_INFORM_PRODUCT_LOCALE_TC, SYSINFO_INFORM_SCHEMA_ITEM,
SYSINFO_INFORM_SCHEMA_TC, SYSINFO_INFORM_SECT,
SYSINFO_INFORM_VERSION_ITEM, SYSINFO_INFORM_VERSION_TC,
SYSINFO_LEGAL_NOTICE_ELT_2013, SYSINFO_LEGAL_NOTICE_ITEM,
SYSINFO_LEGAL_NOTICE_SC, SYSINFO_LEGAL_SECT,
SYSINFO_NT_VERSION_ITEM, SYSINFO_NT_VERSION_TC,
SYSINFO_ODBC_DRIVER_ITEM, SYSINFO_ODBC_DRIVER_TC,
SYSINFO_SOFTWARE_SECT, SYSINFO_WEBSERVER_SECT, SystemInfoForm,
TC_ClientID, TC_Contflict, TC_CRBAffidavit, TC_CRBForm, TC_CRBMeaning,
TC_CRFAffidavit, TC_CRFMeaning, TC_DictCulture, TC_DictType, TC_DictVersion,
TC_Disabled, TC_GroupDescription, TC_GroupName, TC_SiteAddress1, TC_SiteAddress2,
TC_SiteAltPhoneNumber, TC_SiteBeeper, TC_SiteCity, TC_SiteContactUser, TC_SiteCountry,
TC_SiteDayPhoneNumber, TC_SiteEmailAddress, TC_SiteFaxNumber, TC_SiteMnemonic,
TC_SitePostalCode, TC_SiteServer, TC_SiteStateProvince, TC_SiteStudyLocale,
TC_SiteSVAutoSelectRate, TC_SiteSVFirstNSubjects, TC_SiteTimeZone, TC_SiteUserNameOrder,
TC_SubjectGUID, TC_UPUserName, TC_UserActiveState, TC_UserAddress1, TC_UserAddress2,
TC_UserAltPhoneNumber, TC_UserAuthType, TC_UserBeeper, TC_UserCity, TC_UserCountry,
TC_UserDayPhoneNumber, TC_UserDeleteState, TC_UserDescription, TC_UserDisplayName,
TC_UserEmailAddress, TC_UserFaxNumber, TC_UserFirstName, TC_UserHashType,
TC_UserHomeScreenURL, TC_UserImagelD, TC_UserLanglD, TC_UserLastName,
TC_UserName, TC_UserPassword, TC_UserPostalCode, TC_UserProductlocale, TC_UserSalt,
TC_UserStateProvince, TC_UserStudyLocale, TC_UserTitle, TC_UserTrustPEUID, TC_UserType,
TC_UUID, TIMEZONE, Transactions, Transactions_CTL,
TRIAL_DEPLOYMENT_READONLY_SC, TRIAIL_DEPLOYMENT_SC, TrialName, UnFreeze
CRB, UnFreeze CRF, Unique_Initials_ DOB_Switch, Unique_Patient ID_Switch, UNK, UnLock
CRB, UnlLock CRF, UnMark CRB, UnMark CRF, UR_ADMIN_REPORTS_SC,
UR_ADMIN_REPORTS_SC_EM, UR_ADMN_ACTV_SITE_USR_EM,
UR_ADMN_ACTV_SITE_USR_SC, UR_ADMN_ACTV_SPNSER_USR_EM,
UR_ADMN_ACTV_SPNSER_USR_SC, UR_ADMN_CREATE_USR_EM,
UR_ADMN_CREATE_USR_SC, UR_ADMN_DEACTV_SITE_USR_EM,
UR_ADMN_DEACTV_SITE_USR_SC, UR_ADMN_DEACTV_SPNSER_USR_EM,
UR_ADMN_DEACTV_SPNSER_USR_SC, UR_ADMN_MAKE_TERM_USR_EM,
UR_ADMN_MAKE_TERM_USR_SC, UR_ADMN_MAKE_USR_OPERTVE_EM,
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UR_ADMN_MAKE_USR_OPERTVE_SC, UR_ADMN_MNGE_OTHER_GRPS_EM,
UR_ADMN_MNGE_OTHER_GRPS_SC, UR_ADMN_MNGE_RIGHTS_GRPS_EM,
UR_ADMN_MNGE_RIGHTS_GRPS_SC, UR_ADMN_MODIFY_SYS_CFG_EM,
UR_ADMN_MODIFY_SYS_CFG_SC, UR_ADMN_MODIFY_USR_EM,
UR_ADMN_MODIFY_USR_SC, UR_ADMN_VIEW_SYS_CFG_EM,
UR_ADMN_VIEW_SYS_CFG_SC, UR_ADMN_VIEW_USR_EM,
UR_ADMN_VIEW_USR_SC, UR_CANNED_REPORTS_EM, UR_CANNED_REPORTS_SC,
UR_CRB_FREEZE_EM, UR_CRB_FREEZE_SC, UR_CRB_LOCK_EM, UR_CRB_LOCK_SC,
UR_CRB_MARK_READY_FOR_SDV_EM, UR_CRB_MARK_READY_FOR_SDV_SC,
UR_CRB_SIGNATURE_EM, UR_CRB_SIGNATURE_SC, UR_CRB_UNFREEZE_EM,
UR_CRB_UNFREEZE_SC, UR_CRB_UNLOCK_EM, UR_CRB_UNLOCK_SC,
UR_CREATE_SITES_EM, UR_CREATE_SITES_SC, UR_CRF_EDIT_DATA_EM,
UR_CRF_EDIT_DATA_SC, UR_CRF_ENTER_COMMENT_EM,
UR_CRF_ENTER_COMMENT_SC, UR_CRF_ENTER_DATA_EM,
UR_CRF_ENTER_DATA_SC, UR_CRF_FREEZE_EM, UR_CRF_FREEZE_SC,
UR_CRF_LOCK_EM, UR_CRF_LOCK_SC, UR_CRF_MARK_AS_SDV_EM,
UR_CRF_MARK_AS_SDV_SC, UR_CRF_MARK_READY_FOR_SDV_EM,
UR_CRF_MARK_READY_FOR_SDV_SC, UR_CRF_SIGNATURE_EM,
UR_CRF_SIGNATURE_SC, UR_CRF_SVSETTING_EM, UR_CRF_SVSETTING_SC,
UR_CRF_UNFREEZE_EM, UR_CRF_UNFREEZE_SC, UR_CRF_UNLOCK_EM,
UR_CRF_UNLOCK_SC, UR_CUSTOM_REPORTS_EM, UR_CUSTOM_REPORTS_SC,
UR_DATA_EXPORT_LISTINGS_SC, UR_DATA_VIEWER_ASSIGN_EM,
UR_DATA_VIEWER_ASSIGN_SC, UR_DATA_VIEWER_ASSIGN1_EM,
UR_DATA_VIEWER_ASSIGN1_SC, UR_DATA_VIEWER_ASSIGN2_EM,
UR_DATA_VIEWER_ASSIGN2_SC, UR_DATA_VIEWER_ASSIGN3_EM,
UR_DATA_VIEWER_ASSIGN3_SC, UR_DATA_VIEWER_ASSIGN4_EM,
UR_DATA_VIEWER_ASSIGN4_SC, UR_DATA_VIEWER_ASSIGN5_EM,
UR_DATA_VIEWER_ASSIGN5_SC, UR_DATA_VIEWER_EM,
UR_DATA_VIEWER_READ_EM, UR_DATA_VIEWER_READ_SC,
UR_EDIT_STUDY_FAQ_SC, UR_ENROLL_PATIENTS_SC, UR_ENROLL_SUBJECTS_EM,
UR_MONITOR_EM, UR_MONITOR_SC, UR_ODM_SUBMIT_SC,
UR_PATIENT_SITE_CHANGE_SC, UR_PORTAL_ADDEDITSECTIONS_SC,
UR_PORTAL_ADDEDITTABS_SC, UR_PORTAI_ADMIN_SC,
UR_PORTAL_UPDATECOMPANYLOGO_SC, UR_PORTAIL_UPDATEHOMEPAGE_SC,
UR_PORTAIL_UPLOADUPDATEDOCS_SC, UR_PRINT_EM, UR_PRINT_SC,
UR_QRY_CHG_ANSWD_TO_CLSD_EM, UR_QRY_CHG_ANSWD_TO_CLSD_SC,
UR_QRY_CHG_CNDTE_TO_DELTD_EM, UR_QRY_CHG_CNDTE_TO_DELTD_SC,
UR_QRY_CHG_CNDTE_TO_OPEN_EM, UR_QRY_CHG_CNDTE_TO_OPEN_SC,
UR_QRY_CHG_OPEN_TO_CLSD_EM, UR_QRY_CHG_OPEN_TO_CLSD_SC,
UR_QRY_CHG_REISSUE_CNDTE_TO_CLSD_EM,
UR_QRY_CHG_REISSUE_CNDTE_TO_CLSD_SC,
UR_QRY_ENTR_CNDTE_MANUALLY_EM, UR_QRY_ENTR_CNDTE_MANUALLY_SC,
UR_QRY_ENTR_OPEN_MANUALLY_EM, UR_QRY_ENTR_OPEN_MANUALLY_SC,
UR_QRY_REISSUE_CNDTE_QRY_EM, UR_QRY_REISSUE_CNDTE_QRY_SC,
UR_QRY_REISSUE_OPEN_QRY_EM, UR_QRY_REISSUE_OPEN_QRY_SC,
UR_QRY_RESOLVE_QRY_EM, UR_QRY_RESOLVE_QRY_SC,
UR_QRY_RSPND_TO_QUERY_SC, UR_REORDERING_OF_PATIENTS_SC,
UR_REORDERING_OF_SUBJECTS_EM, UR_RULE_CREATE_EM,
UR_RULE_CREATE_SC, UR_RULE_DEACTV_EM, UR_RULE_DEACTV_SC,
UR_RULE_EXECUTE_EM, UR_RULE_EXECUTE_SC, UR_RULE_MODIFY_EM,
UR_RULE_MODIFY_SC, UR_SUBJECT_SITE_CHANGE_EM,
UR_UPDATE_STUDYLOGO_EM, UR_UPDATE_STUDYLOGO_SC, UR_VIEW_CRF_EM,
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UR_VIEW_CRF_SC, UR_VIEW_SIG_HISTORY_CRB_EM,
UR_VIEW_SIG_HISTORY_CRB_SC, UR_VIEW_SIG_HISTORY_CRF_EM,
UR_VIEW_SIG_HISTORY_CRF_SC, USERADMIN_SECT, USEREMAILCTL,
USEREMAILITEM, UserGroupSelection, USERINFO, USERLIST_EF, USERLIST_ITEM,
USERMISC_SECT, USERNAMECTL, USERNAMEITEM, USERPASSWORD, UsinglnForm,
Visit, yes]
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Collaboration

Collaboration Notes Browser—Option descriptions

Option ‘ Description

Fields

Author

Person who created the collaboration note.

Created Date

Date and time the collaboration note was created.

READ-ONLY

Description Description of the collaboration note.

1D Unique identifier of the collaboration note.

Object Name Study object to which the collaboration note is attached.

Object Type Type of study object (such as form or study event) to which the
collaboration note is attached.

Type Collaboration note type on which the collaboration note was based.

Collaboration note types ate defined in the Central Designer Administrator
application.

Toolbar options

New Note Create, edit, print, or delete the selected collaboration note.

Edit

Print

Delete

Show Children e Selected—You see all collaboration notes attached to the selected
study object and its children.

e Not selected—You see the collaboration notes that are attached to the

selected study object only.

Refresh Refresh the information in the Collaboration Notes Browser with

information from the database.
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Collaboration Note Editor dialog box—Option descriptions

Option Description

Study (READ-ONLY.) Study with the study object to which the collaboration
note is attached.

Object Name (READ-ONLY.) Study object to which the collaboration note is attached.

Object Type (READ-ONLY.) Type of study object to which you are attaching the
collaboration note, such as a form or study event.

Note Type (REQUIRED.) Type of the collaboration note. An administrator defines
collaboration note types in the Central Designer Administrator application.

Author (READ-ONLY.) User who created the collaboration note.

Instructions text field Text for the collaboration note.

Task areas—Field descriptions
The following fields appear in:
e Recent Tasks tab of the Home Page.
e My Tasks section of the Home Page.

e Tasks Browsert.

Note: Some fields appear on the Home page, but not in the Tasks Browser. In addition, not all
fields appear in the default view. Optionally, you can add the other fields to the browser view, and
you can rearrange the order of fields. For more information, see Showing and hiding a field (on

page 23).

Completed By Person who completed the task.

Completed Date Date and time the task was completed.
READ-ONLY

Created Date Date and time the task was created.

Description Description of the task.

Due Date Deadline for the task, selected by the task requester. If the task is overdue,
the date is red.
READ-ONLY

Id Unique identifier for the task.

Object Name Study object to which the task is attached.

Object Type Task type.
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Field Description

Owner User or team responsible for the task:
e Assigned task—The assignee (or assignees).
e Accepted task—The accepter.

e  Completed task—The creator.

Priority Priority of the task. Options are Critical, High, Medium, and Low.
Project 1d Unique identifier for the project that contains the task.

Project Name Project that contains the task.

Requested By Person who created the task.

Status Status of the task.

Study Id Unique identifier for the study that contains the task.

Study Name Study that contains the task.

Type Task type on which the task is based. An administrator defines task types

in the Central Designer Administrator application.

Tasks Browser—Option descriptions

154

Note: Some fields appear on the Home page, but not in the Tasks Browser. In addition, not all
fields appear in the default view. Optionally, you can add the other fields to the browser view, and
you can rearrange the order of fields. For more information, see Showing and hiding a field (on
page 23).

Field Description

Completed By Person who completed the task.
Completed Date Date and time the task was completed.
READ-ONLY
Created Date Date and time the task was created.
Description Description of the task.
Due Date Deadline for the task, selected by the task requester. If the task is overdue,
the date is red.
READ-ONLY
1d Unique identifier for the task.
Object Name Study object to which the task is attached.
Object Type Task type.
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Field Description

Owner User or team responsible for the task:

e Assigned task—The assignee (or assignees).

e Accepted task—The accepter.

e  Completed task—The creator.
Priority Priority of the task. Options are Critical, High, Medium, and Low.
Project 1d Unique identifier for the project that contains the task.

Project Name

Project that contains the task.

Requested By Person who created the task.

Status Status of the task.

Study Id Unique identifier for the study that contains the task.

Study Name Study that contains the task.

Type Task type on which the task is based. An administrator defines task types

in the Central Designer Administrator application.

Option Description

New Task Create, edit, print, or delete a task.

Edit

Print

Delete

Accept Accept, complete, close, reopen, and unaccept a task.

Complete

Close

Reopen

Unaccept

Show Children e Selected—You sce all tasks attached to the selected study object and
its children.

o Not selected—You see the tasks that are attached to the selected

study object only.

Refresh Refresh the information in the Tasks Browser with information from the

database.
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Task Editor dialog box—Option descriptions

The second tab that appears in the Task Editor dialog box depends on the type of task that is
selected. For standard tasks, the dialog box has an Instructions tab, and for translation tasks, the
dialog box has an Assignment tab.

Option ‘Description

156

Top toolbar

Accept, Complete,

Close, Reopen,
Unaccept

Accept, complete, close, reopen, and unaccept a task.

Top section

Study (READ-ONLY) Study with the study object to which the task is attached.

Object Name (READ-ONLY) Study object to which the task is attached.

Object Type (READ-ONLY) Type of study object on which the task was created.

Created (READ-ONLY) Date and time the task was created.

Requested By (READ-ONLY) User who created the task.

Status (READ-ONLY) Status of the task (Open, Accepted, Completed, or Closed).

Task Type (REQUIRED.) Type of the task. An administrator defines task types in the
Central Designer Administrator application.

Priority (REQUIRED.) Priority of the task. Options are Critical, High, Medium, and
Low.

Due (REQUIRED.) Deadline for when the task must be completed.
Default value—Current date and time.

Owner (READ-ONLY) Person or team to which the task is assigned.

Completed By (READ-ONLY) User who completed the task.

Completed Date (READ-ONLY) Date and time the task was completed.

Instructions tab

(Appears for standard tasks only)

Instructions text

field

Text for the task.

Assignment tab

(Appears for translation tasks only)

[List of roles]

List of roles to which the task can be assigned. If an administrator specified a
default role to which the task type is assigned, the role is selected.

Note: Use the buttons on the toolbar to add an attachment and format the text.
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Home page

Home Page—Section descriptions

Section ‘ Description

Recent Projects List ~ Projects you opened recently.

For more information, see Changing the number of projects that
appear in the Recent Projects list (on page 21).

Pending Approvals Deployment requests that you can approve. Use the toolbar buttons to

Tab approve or reject requests, and view a history of automated deployments.

Recent Tasks Tab Tasks that are open and assigned to you. Use the drop-down list to see
tasks added since yesterday, in the last three days, in the last week, and so
on.

My Tasks All tasks assigned to you.

Status toolbar—Option descriptions

Option Description

| JET 1750 Appears when study objects are loading,.
ou are logged on, and the application is connected to the application server.
& Y logged d the application i d to the applicati
&7 . reen circle icon)—The application is pulling information from the
G ircle i The application is pulling inf ion fi h
or

application server.

e (Yellow circle icon)—The application is unable to pull information from
the application server. For example, network connectivity might be
unavailable, or the server might have stopped responding.

ra e e (Gray circle icon)—The server is not processing information, and you can
work.

e  (Blue circle icon)—The server is processing information. Wait until the
process completes before performing another activity.
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Study objects

Export Translations dialog box—Option descriptions

Option Description

Field

Locale to translate from

Name of the locale in which the text strings to translate have
been defined.

Note: The Locale to translate from is not the global default
locale that is defined in the Tools > Options dialog box, but
rather any locale in which the text strings to export exist.

Translate </locale name> to

Locale into which strings will be translated.

Target

Target application for which to translate strings.

Export file location

Location and file name in which to store the file of strings to
translate. By default the file name has the format:

<StudyName>_ExportTranslations_<TargetSysten>_<SelectedL
ocale>.csv

For example:
TestStudy_ExportTranslations_InForm_fr-FR.csv

The Browse button enables you to browse to the location.

Include empty locale values

e Ifselected, the file of strings to translate includes strings
that are empty in the locale to translate from.

e If not selected, the export process skips empty strings.

Export log results

Displays messages that are generated during the export.

Optionally, you can save these results to a file by clicking the
Save Log Results As button.

Button

Check for Empty Strings

Opens a window listing all strings that are empty in the locale
to translate from.

Save Log Results As

Specifies the location of a log file containing the messages that
are generated in the Export log results box during the export.
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Export Wizard options

Page Option Description

Welcome

Introduction page.

Export Type

Select the output format and export type.

Data Type CSML—Export in Clinical Study Markup Language

format.

ODM—Export in Operational Data Model-compliant

format. The Central Designer application supports the
ODM 1.3 standard.

Administration data—FExport only study administration
data for the User Management Tool application.

Export Type Local—Exportt to the computer where the Central

Designer application is installed.

Export File Path Export Specify the path name and file in which to save the export
Directory file, or click Browse to browse for the path name and file

in which to save the export file.

Ready to Export
Central Designer
Data

View a summary of the parameters that will be used for
the export.

History Viewer dialog box—Option descriptions

Field Description

Top section

Object

Name of the study object.

Unlocked or Locked icon

Indicates whether study object is locked or unlocked.

Object [name of study
object] section

Revision/Version

Revision or version number of the study object, with either IVersion or
Revision in parentheses to indicate if it is a version or revision.

Note: This value is for the selected study object only, not for the study
in which the study object exists. This value may differ from the value
that appeats for the Revision property at the bottom of the History
Viewer dialog box.

Label

e Ifyou are viewing versions—Label given to the version when it
was created.

e Ifyou are viewing revisions—Study Revision.

Oracle® Health Sciences Central Designer 2.1.2 159



Appendix A Option and property descript

ions

Field Description

Altered By Name of the user who modified the study object for the version or
revision.

Date Day and time when the study object was modified for the version or
revision.

Description e If the last save created a version—The label and description

applied for the version.

e If the last saved created a revision—Auto-generated description
text.

View changing radio
buttons

View Versions

All versions of the selected study object appear in the top grid.

View Every Edit All revisions of the study object appear in the top grid.

Buttons

Differences (Enabled when you select two versions or revisions.)
View the differences between two versions or revisions of a study
object.

Revert to Revert to a previous version or revision of a study object.

Import Wizard options - CSML or ODM file

Page Option Description
Welcome Introduction page.
Import Type Select the source of the data to import.

Import CSML or Generate study objects from a file in CSML or ODM
ODM file format.

Harvest InForm Generate study objects from the components of an
Resources InForm study.

File Location

Path of file to import Specify the path of the CSML or ODM import file, or
click Browse to locate the import file.

Study
Administration
Import Mode

This page appears only for the CSML import type, if
the CSML file contains study administration objects.

Import study objects Import both study objects and study administration
and administration  objects.
data.

Import Import only study administration objects.
administration data
only.
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Page Option Description

Import study objects Import only study objects.
only.

Rule Import Mode ~ Rule Import Mode  Only the Import as Collaboration Notes option is
supported. With this option, each imported rule is
converted to a collaboration note in the Central
Designer application.

Note: This option applies only if the Import Type is
ODM,; if the Import Type is CSML, the import
process creates a Central Designer rule for each
imported rule.

IPR Import Mode ~ Import IPR data Select whether to import in-place revision objects.

Note: This page appears only if the file contains in-
place revision objects.

Ready to Import View a summary of the import options selected in the
Data to Central wizard.
Designer

Import Wizard options - InForm resources

Page ‘ Option Description
Welcome Introduction page.
Import Type Select the source of the data to import.
Import CSML or Generate study objects from a file in CSML or ODM
ODM file format.
Harvest InForm Generate study objects from the components of an
Resources InForm study.
InForm File Select the file or trial from which to harvest resources.
Location
RSP or XML file Specify the full path of the RSP or XML file

containing MedML definitions of InForm trial
components to import, or click Browse to browse to
the file.

Rule Import Mode Rule Import Mode Only the Import as Collaboration Notes option is
supported. With this option, each imported rule is
converted to a collaboration note in the Central
Designer application.

Ready to Import View a summary of the import options selected in the
Data to Central wizard.
Designer
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References tab—Option descriptions

Option Description

Top section

Title

Name of the file or URL attachment.

Preview

Text that appears in the Description section.

(Paper clip
button)

Indicates whether the reference has an attachment (a file, shortcut to a file, or

URL address).

Details section

Description

Description of the attachment.

Attachments

All file and URL attachments.

Note: The default maximum file size is 10 MB. This value can be configured.

For more information, see Maximum attachment size (on page 119) (in the
User Guide).
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A
annotated study book

A form-by-form summary of the design of a study.
Optionally, it includes a time and events schedule, a
preview of each form, and selected annotations that
list design details.

See also study book (on page 170).

application role

A role associated with administrative activities.

arm

See study arm (on page 170).

authentication

The method of ensuring that you ate using the
correct user name and password to log on.

authorization

The method of giving users access to information or
functionality. Access is controlled using rights, roles,
and teams.

automated deployment

The process through which a deployment package is
sent directly from the Central Designer application
to the InForm application and installed without
additional action required.

baseline

A snapshot of all components in a study. Validation
creates a baseline.

Baselines Browser

A browser in which you view the results of
validation and make temporary baselines public so
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that other usets can work with them.

branch

See study branch (on page 170).

C

calculation rule

A rule that sets the value of an item based on a
calculation.

catalog

A collection of categories and keywords that can be
attached to users and study objects to facilitate
searching in the Libraries Browser and Users
Browser.

catalog administration

The process of creating keywords and categories and
assigning them to users and study objects for faster
and more sophisticated searching,.

category

A hierarchical grouping of keywords. You can create
categories only from existing keywords.

CDISC

Clinical Data Interchange Standards Consortium.
CDISC is an open, multidisciplinary, non-profit
organization committed to the development of
industry standards to support the electronic
acquisition, exchange, submission and archiving of
clinical trials data and metadata for medical and
biopharmaceutical product development.

checkbox

A type of data entry control in which you can select
one or more options by selecting the box that
represents each option.
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clinical project

See study project (on page 170).

clinical protocol

See protocol (on page 168).

clinical study

See study (on page 169).

codelist

A collection of code-label pairs that gather together
the entry choices for an item. A code-label pair
consists of a single code (the value that is used for
analysis) and a label (the value that is visible to
users).

See also codelist item (on page 164).

codelist item

A code-label pair consisting of a single code (the
value that is used for analysis) and a label (the value
that is visible to users). Multiple codelist items make
up a codelist.

See also codelist (on page 164).

coding

The process of selecting terms and codes from a
dictionary for a verbatim.

coding dictionary

A standardized collection of terms and the codes
that correspond to those terms.

coding map

A study object that contains the necessary
information to code an item.

coding target

See tatget item (on page 171).

collaboration

The process by which users with different roles and
specialties can work together to create, validate, and
deploy a study.
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collaboration note

A note that you attach to any study object.

collaboration note type

A classification used to identify the type and purpose
of a collaboration note.

Collaboration Notes Browser

A browser in which you work with collaboration
notes.

common form

A form that is designed for use with multiple study
events. The same data appears in the form in all
study events in which the form is used.

component

Any design building block that is configured in a
study or library. Design components include study
objects (such as a project, study, study element,
study event, form, or item) as well as rules,
individual items selected from drop-down lists, and
controls (such as checkboxes and radio buttons).

compound item

An item that has one or more child items that can
have different data types.

constant

A value that is defined in a library or study and that
can be referenced by any rule.

constraint rule

A rule that checks whether data is valid. Constraint
rules are used to confirm that clinical data meets the
requirements of the clinical protocol.

container

A node in the Project Explorer that contains zero or
more study objects or components.

context item

An item that provides additional coding information,
such as the indication and route of administration
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for drugs, that can be displayed with an item coded
using the WHO-DD dictionary.

CSML

Clinical Study Markup Language. CSML is an XML-
based markup language developed by Oracle for
representing and exchanging clinical data definitions
created in the Central Designer application.

See also MedML (on page 168).

custom data dimension

See data dimension (on page 165).

custom property

A user-defined or default characteristic of a study
object.

D
data dimension

A key item for a data set. A data dimension specifies
the additional information that will be saved when
study data is collected. You can specify standard data
dimensions (Study, Subject, Event and Event Index,
Form and Form Index, and Item) and custom data
dimensions.

data series

A grouping of one or more items with the same
clinical meaning, such as one or more items that
measure weight.

See also data set (on page 165), mapping (on page
167).

data set

A grouping of one or more related data series.

See also data seties (on page 165), mapping (on
page 167).

data type

An attribute for items and data series. For an item,
the data type determines the type of entry an item
will accept. For a data series, the data type
determines which items can be added to it. Data
types include date time, integer, float, and text.
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data-entry rule

A rule that checks whether data is valid or that sets
the value of an item based on a calculation.

See also workflow rule (on page 172).

date time item

An item used to collect date and time information
on a form.

deployment

The process of sending a study to a target
application. To collect data, a study must be
deployed into a target application as a complete
deployment package.

deployment approval
The optional process by which a study deployment
is approved by a user with the appropriate rights.

deployment instance

The server to which you deploy a study.

deployment request

A request from a user with the appropriate rights to
initiate an automated deployment to the InForm
application.

dictionary metadata item

An identifier that describes administrative data about
a dictionary and that you can use to create a coding
map.

dictionary type

A name or identifier for the metadata for a
dictionary.

drop-down list

A data entry format in which you select an option
from a list.

dynamic form

A form that is automatically generated in the
InForm application when subject data satisfies
certain criteria tested in another form.
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dynamic visit

A visit that is automatically generated in the InForm
application when patient data satisfies certain criteria
tested in another visit.

E
edit check

A data-entry rule that checks whether entered data is
valid.

See data-entty rule (on page 165).

element

See study element (on page 170).

event

See study event (on page 170).

explicit lock
A lock that you request and that does not expite.

See also implicit lock (on page 160).

expression

The part of a rule that specifies what to evaluate.

field

The area in a data-entry window where the value for
an item is entered or displayed.

float item

An item used to collect numerical values with
decimal points.

form

A container for one or more items. A form can
contain one or more sections and supports multiple
locales and layouts. A form is deployed to a target
application as a data-entry form used to collect
subject information and other clinical data.

full installation deployment package

A deployment package that contains everything
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needed to deploy a complete study.

function

A reusable piece of code that extends the behavior
of a rule. A function can be predefined or user-

defined.

G
global condition

A logical construct that, when applied to a study
object, determines whether the study object will
appear for a patticular subject. A global condition
does not affect other study objects in the workflow.

See also workflow rule (on page 172).

globals

Study objects and properties that are related to
mappings.

grouping

A default or user-provided value used to organize
custom properties of a study object.

|
implicit lock

A type of lock used when you edit a study object. An
implicit lock is automatically applied when you select
or open a study object and is automatically released
when you close or save a study object.

See also explicit lock (on page 160).

incremental deployment package

A deployment package that contains a complete
study based on a previously created deployment
package, plus any additions or changes.

in-place revision (IPR)

A study design change that is applied to existing
study versions previously deployed to the InForm
application.
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integer item

An item used to collect a numerical value without a
decimal point.

internationalization

The process of configuring a study for translation
into different languages or for different regional
requirements.

intrinsic rule

A constraint rule or calculation rule based on a
predefined rule template.

item

A study object used as a container for the collection
of clinical data.

item group

A study object used to combine items so that you
can set their display override options in the InForm
application.

J
Job Log Browser

A browser in which you view the results of
asynchronous jobs, such as validation or import.

K
keyword

An identifier that is associated with users and study
objects to facilitate more powerful and efficient
searches.

L
Libraries Browser

A browser in which you search the repository for
study objects and then add them to studies or
libraries.
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library

A container used to store related study objects and
templates to be published for reuse in studies or
other libraries. A library provides a view of the study
objects in the repository.

See also repository (on page 169).

Library List

A hierarchical list of libraries from which resources
can be used. The hierarchy determines the order in
which libraries are searched. The Library List is
defined for each study in the Study Editor.

library project

A project containing a library.

library role

A role associated with library activities.

library team

A group of users who have rights granted by a
certain role to perform tasks in a particular library.
locale

A supported language or language variation.

localization

The process of designing a study for a specific
locale.

locked

A state in which only the user who created the lock
can modify a study object. Locks can be implicit or
explicit.

See also implicit lock (on page 160), explicit lock
(on page 166).

M
mapping

A data grouping that provides an alternate data view
of a study. Mappings were previously called logical
schemas.

See also data series (on page 165), data set (on
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page 165).

MedML

An XML-based markup language developed by
Oracle for representing and exchanging clinical data
definitions created in the InForm application..

See also CSML (on page 165).

method

A block of code that is called by a rule and that is
used to manipulate data.

normalization

The process of converting data to a required format.

o)
object

See study object (on page 170).

ODM

Operational Data Model. ODM is an XML-based
standard developed by the Clinical Data Interchange
Standards Consortium (CDISC) for representing
and exchanging clinical data.

P
precondition

The part of a rule that specifies when to evaluate the
rule expression.

project

See library project (on page 167) and study project
(on page 170).

Project Explorer

A browser that displays a view of the open project
and the study objects it contains.

Properties Browser

A browser in which you can view and modity the
properties of the study object selected in the Project
Explorer.
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property

A defining characteristic of a study object.

protocol

A detailed plan that describes how investigators
conduct a study. The clinical protocol sets the
guidelines for the study, describes the conditions of
the study, and contains a set of forms on which
clinical data is collected.

publish

The action that makes a study object created in a
library available to other usets.

See also unpublish (on page 171).

Q
query

A text string that appears on a CRF item in the
InForm application when a rule on that item fails.
When designing a rule in the Central Designer
application, you can specify the query text and the
circumstances under which a rule results in a query.

query group

A study object used to specify the users who can act
on queries created by other members of the group in
the InForm application.

radio button

A type of data entry format in which you must select
a single item from a list of choices.

reference

A text note, a link to a Web page or file (URL), a
document, or a combination of all three, that is
attached to a study project for users to consult
during the development of a study.

RefName

A unique identifier for a study object.

repeating form

A type of form for which the Repeating property is
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set to true. You use a repeating form to collect
multiple instances of the same data at different dates
and times.

repository

A single database instance that contains all Central
Designer study objects, components, and users.

revision

An audit history record that is created automatically
when a user edits a study object and saves the
changes.

right

A predefined permission that controls access to a
specific feature or activity in the Central Designer
client or Central Designer Administrator client and
that can be assigned to one or more roles.

See also role (on page 169).

rights group

A study object used to create a set of predefined
InForm rights in the InForm application.

role

A collection of rights. When a user is assigned to a
role, the rights associated with the role are granted
to the user.

See also library role (on page 167), study role (on
page 170), and user role (on page 171).
role administration

The process of managing tasks that users perform in
the Central Designer and Central Designer
Administrator applications, assigning rights to roles,
and assigning roles to users.

rule

See data-entry rule (on page 165), workflow rule
(on page 172).

rule action

The action, or actions, that takes place as a result of
the evaluation of a rule expression.
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rule scope

The set of study objects that a rule can reference.
The scope of a rule is determined by the study
object on which the rule is defined.

rule template

A function that is defined on a study object, study
object template, or study object type and can be
used as the expression clause of a rule.

rule type

See calculation rule (on page 163), constraint rule
(on page 164), and intrinsic rule (on page 167).

S
SDTM
Study Data Tabulation Model. SDTM is a CDISC

model used to standardize data structures in data
extracts.

shared form

See common form (on page 164).

signature group

A study object used to specify the forms that require
signature and the signature type in the InForm
application.

site

A location that participates in a study.

sponsor

A study object used to define the sponsor properties
of a study, such as name or address, in the InForm
application.

standard data dimension

See data dimension (on page 165).

standard task type

A task type that is typically used for all non-
translation tasks assigned to an individual or team.
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study

The definition of the workflow, data-entry, and data-
management system for a clinical study.

study administration object

A collection of study objects that are used to capture
study administration data for deployment to the
InForm application.

See also ftem group (on page 167), query group
(on page 168), rights group (on page 169),
signature group (on page 169), sponsor (on page
169), study configuration (on page 170).

study arm

The CDISC term for a study branch consisting of a
planned sequence of study elements. A study arm is
typically equivalent to a treatment group.

study book

The set of forms used to collect clinical data.

See also annotated study book (on page 163).

study branch

A path for which data is collected for certain
subjects. A study can contain multiple branches as
different conditions are assessed, and a branch is
followed depending on the subject and other
circumstances.

study configuration

A study object used to specify the value of an
InForm configuration variable in the InForm
application.

study design

A container for the structure of a study.

study element

The CDISC term for a basic building block of a
study. A study element represents a segment of a
study and can consist of one or more study events.
Study elements are optional.
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study event

A subject evaluation checkpoint when data is
collected. Study events usually correspond to visits,
but one visit can span multiple study events.

study object

A study building block that appears in the Project
Explorer. Study objects include study projects,
libraty projects, studies, libraries, study elements,
study events, forms, sections, items, codelists,
codelist items, deployment instances, in-place
revisions, and study administration objects.

See also component (on page 164) and study

administration object (on page 170).

study object editor

An editor for each study object, such as a project,
study, study element, study event, form, or item. A
study object editor appears in the workspace when
you select a study object.

study project

A project containing one or more studies that are
related to each other.

study role

A role associated with study activities.

study team

A group of users who perform tasks granted by a
certain role for a particular study.

study workflow

See workflow (on page 172).

subject

An individual who participates in a clinical study.

system

An application to which you deploy a study from the
Central Designer application.

system configuration administration

The process of creating, configuring, and managing
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internationalization, collaboration, and
customization information using the Central
Designer Administrator application.

T
target item

An item that holds a term, code, or additional
information after a verbatim is coded.

task

A request that you attach to a study object and
assign to an individual or a study team.

task classification

The classification of a task. You can choose either
standard (used for all non-translation tasks assigned
to an individual ot team) or translation (used for
tasks that request translation of a study object into
one or more languages). You define the classification
for task types in the Central Designer Administrator
application.

task type
A classification used to identify the type of the task
and the way the task is used.

Tasks Browser

A browser in which you work with tasks.

team

See study team (on page 170), Libraty team (on
page 167).

template

A study object that is either partially or fully defined
and that can be used to create other study objects.

You can create templates for study projects, studies,
study elements, study events, forms, items, codelists,

and mappings.

text box

A data-entry format in which you type data.
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text item

An item used to collect alphanumeric information.

translation task type

A task type that is used for tasks that request
translation of a study object into one or more
languages.

type

A study object that is either partially or fully defined
and can be used to create other study objects. Types
are like templates except that types appear as options
in the Actions menu and in the Project Explorer
menu when you create a new study object.

U
unpublish

The action that makes a study object in a library no
longer available to other users.

See also publish (on page 168).

user

A person who works in the Central Designer or
Central Designer Administrator application.
user administration

The process of managing users.

user role

A role associated with user activities.

Users Browser

A browser in which you search the repository for
users and then add them to study teams or library
teams.

\'}
validation

The process of checking the status of a study to
indicate if the study is ready for deployment. The
study validation process determines whether all
essential components exist and are consistent.
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verbatim

The original reported text that describes the adverse
event, disease, drug, or other item to be coded in the
Central Coding application.

verbatim type

A classification of a verbatim as defined in a coding
dictionary.

version

An explicitly requested audit history record for a
study object.

visit

See study event (on page 170).

W
workflow

The progression of work for a study, as determined
by the study designers.

workflow rule

A logical construct that tests data values to
determine the study element, study event, or form to
which a subject progresses next. A workflow rule
prevents study objects in the workflow from
appearing until the rule is evaluated.

See also data-entry rule (on page 165), global
condition (on page 160).

workspace

The work area of the Central Designer and Central
Designer Administrator applications. The contents
of the workspace depend on the type of activity you
are performing and the rights that you have been
granted. The workspace displays the editor for the
study object that is selected in the Project Explorer.

Y
yes no item

An item used to collect yes or no answers to
questions. A yes no item contains a predefined
codelist with Yes and No options.
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Add To Browser
about * 128
adding study objects with * 128
previewing study objects with * 129
application scope * 18
application window
rearranging a browser ¢ 30
resetting window layout ¢ 34
audit history
comparing versions ¢ 139, 173
viewing ¢ 138, 139

B

breaking the link of a study object * 124
browser
about * 29
Add To Browser * 128
arranging browsers * 34
filtering data in a grid * 36
grouping data in a grid * 37
navigating to * 33
opening and closing * 29
rearranging in the application window ¢ 30
showing and hiding * 31
sorting data in a grid 37
Tasks Browser * 66

c

categorization in Central Designer

about categorizing study objects * 88
categoty

automatically generated ¢ 88

manually generated * 88
Central Designer applications, about ¢ 18
Central Designer Export Wizard * 173
Central Designer Import Wizard

option descriptions for CSML or ODM import * 174

option descriptions for InForm harvest ¢ 175
codelist in Central Designer

deleting * 122
codelist item

deleting * 122
collaboration in Central Designer

best practices ¢ 40

collaboration notes * 68

examples © 41, 42

tasks * 60, 61, 62, 63
Collaboration Note Editor dialog box * 167
collaboration note in Central Designer
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about * 68
collaboration note type * 68
creating * 67
deleting * 65
editing ¢ 65
printing ¢ 66
collaboration note type
about * 68
Collaboration Notes Browser
about * 68
option descriptions * 166
copying
about * 104
about copying study objects grouped by mappings ®
108
copying and pasting a study object ¢ 105
more ways to copy study objects * 106
creating, about * 120
CSML
CSML metadata import * 146
importing * 144
cutting
about ¢ 104
cutting a study object * 107

D

data-entry rule
copying and moving * 107
deleting * 123
locking and unlocking * 71
planning ¢ 54
saving * 131
deletion
about ¢ 122
how instances are deleted * 125
how links are deleted * 126
instances and links * 123
procedures * 122, 123
deployment in Central Designer
target * 18
disabling and enabling a library * 84

E

editors, about * 28
Explorer bars in the Project Explorer » 25, 33
export in Central Designer
about * 144, 151
exporting study objects * 151
exporting text strings * 140
Export Translations dialog box ¢ 172
Export Wizard « 173
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F

field
arranging ¢ 34
filtering data in a grid * 36
grouping data in a grid * 37
showing and hiding * 37
sorting data in a grid * 37
form in Central Designer
deleting * 122
previewing ¢ 129
viewing parents of * 124
form-based study * 52

G

global condition
deleting * 123
locking and unlocking * 71
grid
filtering data in * 36
grouping data in * 37
sorting data in * 37

H

help, getting * 23
History Viewer dialog box ¢ 138, 139, 173
Home Page

about * 22

field descriptions ¢ 167

opening ® 22

opening a project from * 22

section descriptions * 171

import in Central Designer
about * 144
CSML imports * 146
importing study objects * 144
importing translated text ¢ 140, 141
ODM importts * 147
post-import modifications * 150
viewing import job results ¢ 145
Import Wizard * 174, 175
instance of a study object
about * 123
how instances are deleted * 125
item in Central Designer
about reusing on a form * 97
creating from a type ¢ 117
deleting * 122
marking as a type * 116
removing a type categorization ¢ 116

J
Japanese characters * 23

K

keyboard, setting up to use different locales ¢ 23

174

keywords
system * 88
user * 88

L

Libraries Browser
searches * 90
library in Central Designer
about * 76
about administration ¢ 78
creating * 78
disabling * 84
enabling ¢ 84
guidelines for developing (library) * 43
production * 44
protecting * 84
security * 83
staging * 43
workflow illustrations * 46, 47, 48, 49, 50, 51
workflows and study objects developed in a library ¢
86
library project
about * 76
closing ¢ 78
opening * 78
library scope * 18
library team
adding a user to * 80
removing a user from * 82
link to a study object
about ¢ 123
breaking ¢ 124
how links ate deleted * 126
viewing the parents of ¢ 124
Load Most Recent Project ¢ 35
locale
additional * 24
setting up a keyboard to use diffrent locales ¢ 23
locks
on a data-entry rule ¢ 71
on a global condition * 71
on a study object * 69
on a workflow rule * 70
revoking and trasferring * 71
logging on and off * 20

M

mappings in Central Designer
concepts * 108
planning ¢ 56
message boxes, resetting * 34
My Recent Tasks Since section * 167
My Tasks section ® 167

o

ODM imports * 147, 148, 150
online Help ¢ 23
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P

password
changing ¢ 21
pasting
about ¢ 104
copying and pasting a study object ¢ 105
cutting and pasting a study object * 107
planning
collaboration ¢ 40
rules ¢ 54
study objects ¢ 52
teams ¢ 40
workflow ¢ 55
production library ¢ 44
Project Explorer
adjusting Explorer bar view * 25
filtering study objects in * 27
finding a study object in * 26
navigating to an Explorer bar ¢ 33
sorting study objects in ¢ 26
publish, republish, and unpublish
about ¢ 85
guidelines * 86
procedure * 86, 87
workflows ¢ 86

R

Recent Projects list * 35
reference * 132
about * 132
attaching to a study or library ¢ 132
removing from a study or library ¢ 133
References tab * 176
RefNames
about * 120
title, viewing in the Project Explorer ¢ 27
reuse * 97
revision * 135, 136, 137
revision management * 137
role scope * 18

S

saving * 130
scope, role * 18
search
about reusing an item on a form * 97
clearing parameters ¢ 82
closing * 82
deleting * 82
finding a study object in the Project Explorer * 26
finding a user * 80
finding and adding a study object to a study or library
* 94
Libraries Browser ¢ 90
opening * 81
results of adding study objects to studies and libraries
* 98
results of adding templates to studies and libraries ¢
103
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copied to studies and libraries * 100
saving * 80
Users Browser ¢ 79
security, library ¢ 83
setting advanced options * 109, 111
Show Home Page * 35
Show Workspace * 35
sorting
sorting data in a grid * 37
sorting study objects in the Project Explorer * 26
staging library * 43
standard task
example of using * 42
task types ® 61
startup
choosing what appears * 35
logging on and off * 20
status bar
option descriptions ¢ 171
showing and hiding * 34
status, task ® 62
study design in Central Designer
reverting to a previous version or revision ¢ 135
viewing audit history ¢ 138
viewing the differences between two versions or
revisions ¢ 139
Study Editor
References tab * 176
study element in Central Designer
categorizing * 89
deleting * 122
publishing, unpublishing, and republishing * 86
study event in Central Designer
deleting * 122
study in Central Designer
about * 76
attaching a reference * 132
removing a reference * 133
study object in Central Designer
about publishing, unpublishing, and republishing ¢ 85
about saving * 130
breaking a link * 124
browsing and adding * 128, 129
copying and pasting * 105
creating from a template * 115
cutting and pasting * 107
deleting * 122, 123
determining whether it is locked * 69
exporting ¢ 151
finding in the Project Explorer ¢ 26
importing * 144
locking and unlocking * 69
marking as a template * 114
marking as a type * 116
planning how to manage * 52
removing a template categorization ® 115
renaming ¢ 121
sorting * 26
viewing RefNames or titles in the Project Explorer ®
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27 information you can define for a type ¢ 112

study project marking an item as a type * 116

about * 76 modifying * 116

closing ¢ 78 publishing * 87

opening * 78 removing a type categorization from an item * 116
study scope * 18 searching for ¢ 94
study team

removing a user ¢ 82 U
T user, Central Designer and Central Designer

Administrator

tab about ¢ 18

arranging tabs * 34 adding to a team ¢ 80

filtering data in a grid * 36 finding * 80

grouping data in a grid * 37 removing * 82

sorting data in a grid * 37 Users Browser

viewing more than one in the workspace * 36 finding a user * 80
target application ¢ 18, 35 searches * 79
Task Editor dialog box ¢ 170
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about * 60, 61, 62, 63 version * 134, 135

accepting * 73

examples ® 41, 42 w

viewing all assigned to you * 73
working with a ¢ 63, 64, 65, 66
task status ® 62
task type * 61
task workflow ¢ 63
Tasks Browser

window layout, resetting * 34
workflow diagram
study objects in * 121, 122
workflow grid in Central Designer
deleting a study object ¢ 122
workflow in Central Designer

about * 66 .
option descriptions ¢ 168 best practices * 55
deleting from ¢ 122
team

libraries and * 86

task * 63

working with study objects * 86, 121, 122
workflow rule

deleting * 123

locking and unlocking * 70
workspace

choosing what appears on startup ¢ 35

viewing more than one tab ¢ 36

adding a user to a library team * 80
planning ¢ 40
removing a user from a study or library team * 82
template
about * 109
about searching for ¢ 94
creating a study object from ¢ 115
difference between a type and ¢ 112
information you can define for a template * 112
marking a study object as a template * 114
modifying * 114
publishing * 87
removing template categorization from a study object
« 115
results of adding to studies and libraries * 103
text string * 141, 142, 143
toolbar ¢ 171
translation in Central Designer
checking for empty strings ¢ 143
exporting text for ¢ 140, 172
importing translated text * 140, 141
text string * 141, 142, 143
translation task
about ¢ 61
example of using ¢ 42
type
about * 111
creating an item from * 117
difference between a template and a type * 112
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